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This document is intended to provide a detailed description of installation, 

operation and maintenance of the Alaris SMS Platform product (later in this 
document referred to as “the System”). It gives information about the 

structure of the product, interaction of the modules it consists of, the way it 
integrates into a carrier‟s network and the protocols used to interact with 

third-party products. 
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1. Terms and Acronyms 
Client Carrier from which the System owner receives traffic 

System owner System owner – a specialized carrier record used to create 

parent products and user accounts with access to the 
System‟s admin interface 

Vendor Carrier to which the System owner sends traffic 

API Application Programming Interface 

ASR Answer Seizure Ratio, calculated as the percentage of 

messages successfully received by the carrier with respect to 
the total number of message sending attempts. For example, 

if the total number of sending attempts is 100 and 50 of them 
are received by the carrier, the ASR will be 50% 

DLR Delivery Receipt, a report sent by the carrier to the original 

sender containing the message delivery status.  

DLR(t) DLR(total), the percentage of SMS delivered to the end user 

with respect to the total number of message sending 
attempts. For example, if the total number of sending 

attempts is 100 and 25 messages are delivered to the end 

user, the DLR(t) will be 25% 

DLR(s) DLR(successful), the percentage of SMS successfully received 

by the end user with respect to the number of messages 
received by the carrier. For example, if the carrier received 50 

SMS and 25 of them are successfully received by the end 
user, the DLR(s) will be 50%  

DNIS Dialed Number Identification Service 

EDR Event Detail Record 

EMA Exponential Moving Average 

ESME External Short Message Entity (external sources and sinks of 

short messages) 

ERMES Enhanced Roaming Messaging System 

GUID Globally Unique Identifier 

ISDN Integrated Services Digital Network 

LOT Level of Trust 

MCC Mobile Country Code 

MNC Mobile Network Code 

MS Excel MS Excel or any other spreadsheet editor 

NANP North American Numbering Plan 

NPI Numbering Plan Indicator 

OLAP Online Analytical Processing 

POI Point of Interconnection 

SLA Service Level Agreement 

SMSC Short Message Service Center 

SMPP Short Message Peer-to-Peer Protocol 

SSU Soft Switch Unit 

TON Type of Number 

http://encyclopedia2.thefreedictionary.com/Dialed+Number+Identification+Service
http://encyclopedia2.thefreedictionary.com/Online+Analytical+Processing
http://encyclopedia.thefreedictionary.com/Short+Message+Service+Center


 
 

  

 

2. System overview 
Alaris SMS Platform (further on referred to as “the System”) is a complete 

solution intended for carriers working in the SMS interconnect industry. The 
general idea of the System is to provide a carrier with a single easy-to-use point 

of control of all tasks related to SMS traffic management:  
• Switching of SMS traffic over HTTP or SMPP 

• Real-time provision of routing instructions to the switch based on user-
defined static or dynamic rules 

• Authorizing events and user registration attempts. To provide for prepaid 

balance control, the SMS Platform authorizes every SMS in the network. As 
soon as the routing System detects that a user has exhausted the 

balance/credit, it starts to reject all new message attempts from that user 
• Clients‟ billing and invoice distribution. The System provides for client 

account charging and invoice generation. Invoices can be automatically 
delivered to customers by email. The System owner can also track client 

payments and match these payments with the issued invoices 
• Monitoring statistical parameters related to traffic behavior and System 

health. Detailed traffic statistics is calculated immediately after the EDR 
data gets into the System. Thus, all statistical layers (any combination of 

any customer, vendor, MCCMNC etc. split by any period) are preliminarily 
calculated in the background. This allows for instant view of any statistical 

layout – irrespective of the amount of requested data  
Along with the SMS Platform, the company offers Alaris inVoice, a BSS solution 

for voice traffic management. For more detail on Alaris inVoice, refer to 

www.alarislabs.com.  

3. Interface structure 
The System provides a carrier with a set of tools that help its employees in 

everyday operations. The user interface is web-based; no other software 
installation is required. The interface is confirmed to work with recent versions of 

Mozilla Firefox; other browsers may not provide access to all System functions 

correctly. 
The Start page provides a set of auto-refreshing charts offering an overview of 

the traffic, DB and hardware performance.  

http://www.alarislabs.com/


 
 

  

 

 
Fig. 1 Start page 

Each chart can be customized in terms of grouping the data by the time interval 

(minutes/hours/days, no grouping by default), by the number of recent values to 
display (100, 200, 300, 500) and by the refresh period (1, 2, 5, 10 or 30 

minutes). Use the  button in the upper right corner of a chart to configure the 
required parameters and the button  to refresh the chart.  

The list of parameters to track is configured in the Set of metrics window opened 
by the  button, located in the upper left corner of the Start page. 

Select the appropriate check boxes and click the  button. 



 
 

  

 

 

Fig. 2 Set of metrics 

The  button located in the bottom left corner of the page opens the main 

System menu and provides access to all System features. Some of the menu 
items may be unavailable to certain users depending on their access rights. The 

access rights are configured on the Carriers\Users page.  
The Start menu includes the following items: 

• Administration  
• Carriers  

• Finance  

• Reference books  
• Reports  

• SMS  
• SMS Retail 

 
Fig. 3 Start menu 

The  button opens the Password configuration menu. Enter the new 

password in the field or use the  button to generate the password 

automatically. Relative security of the password in percentage points is displayed 
in the field to the right. When the new password is ready, click the 

 button. 



 
 

  

 

 
Fig. 4 Password configuration 

NOTE: In order to keep this Manual concise and convenient for use, self-

explanatory interface items such as menu parameters and table columns are not 
detailed in text but are illustrated in screenshots.  

4. Administration 

4.1 Account manager history 

The Administration/Account manager history page serves to view and add 
information about account managers. It comes handy in calculating manager 

bonuses when an account is transferred to another manager. The Effective from 
field shows the date on which the account was assigned to the manager.  

 
Fig. 5 Account manager history 

To assign a new manager to an account, click .  

 
Fig. 6 Assign manager 

In the dialog that appears, select the appropriate account, manager and the date 

on which the changes take effect. Click  to save the changes or  to 

discard the settings. 

4.2 Email processing rules 

The Administration\Email processing rules page serves to configure rules for 

recognition of incoming emails that contain rate sheets. The System analyzes the 
email parameters (address, subject, text, attachment name etc.), identifies it as 

containing rate sheets and automatically imports the rate sheet file.  



 
 

  

 

The page has two panels. The left panel has two tab sheets: the Email rules table 

and the Files table. The right panel has the Add, Edit and Simulation menus. 

 
Fig. 7 Email rules 

The Add menu is illustrated below.  

 
Fig. 8 Add menu 

To create a rule, enter the appropriate parameters in the fields detailed below. 

Fields marked with an asterisk (*) are required. 
• Mail from mask, Mail to mask, Mail subject mask, Mail text mask, File name 

mask: define a mask (use an asterisk * as a wildcard) 
• Interface: select SMS rate import 

• Carrier 
• Product 

• Rule description: arbitrary comments 



 
 

  

 

• Owner notification, Carrier notification: select Yes if a copy of the message 

must be sent to the System owner (account manager)/carrier respectively 
• Report recipients: supply comma- or semicolon-separated email addresses 

to which rate sheet import reports will be sent 
• Rule enabled: select when the tests are complete to activate the rule 

• Test rule: select when testing the rule to prevent submitting it prematurely. 
The rule will only operate in the simulation mode. NOTE: Both Rule enabled 

and Test rule must be selected to enable simulation.  

Click  to save the changes. The entry will appear in the Email rules table.  

To test the rule, select it in the table and open the Simulation menu.  

 
Fig. 9 Simulation 

Enter the appropriate parameters and click . The rule details will appear on 
the Simulation panel (highlighted in bold in the figure above) and the rule will 
appear in the Email rules table. Once the tests are completed, go to the Edit 

menu and deselect the Test rule checkbox to activate the rule. 

The Files page shows all imported rate sheet files (for both automatic and manual 
import).  



 
 

  

 

 
Fig. 10 Files page 

Click on the link in the File name column to open the rate sheet file. NOTE: The 

User name column shows the name of the System owner's user who performed 
manual file import.  

4.3 Outgoing Email accounts 

The Administration\Outgoing Email accounts page serves to configure accounts 

on behalf of which the System owner sends emails to its partners. For example, it 
is possible to configure sending technical and commercial emails from separate 

accounts.  

The page has two panels. The left panel is a table of configured accounts; the 
right panel contains the Add and Edit menus.  

 
Fig. 11 Outgoing email accounts table 

The Add menu is illustrated below.  



 
 

  

 

 
Fig. 12 Add menu 

To create an email account, enter the appropriate parameters in the fields 

detailed below. Fields marked with an asterisk (*) are required. 

• Accounts: click  to add partners that will receive emails from this 

account 
• Server type: select the type of messages that will be sent from this 

address:  

- Default: all kinds of the e-mails  
- Billing: invoices, balance and credit alarms 

- Rates: rates updates 
- Technical: technical alerts (generated at Administration\Service 

notifications)  
- Reports: reports generated by the Report builder 

- Client portal: messages related to the Partner portal and Wholesale 
portal 

• Server IP, Port: mail server parameters 
• EHLO cmd: EHLO value (see SMTP standard description rfc 5321) 

• Use starttls: check the flag to enable encryption 
• Username, Password, Sender address, From name: specify the mail 

account details  
• Contact company 

Click  to save the changes. The entry will appear in the Outgoing email 

accounts table. To check if the account configurations are correct, click 

at the bottom of the page. The System will try to connect to the mail 

server. The result will appear in a dialog box.  



 
 

  

 

4.4 Service notifications 

The Administration\Service notifications page serves to generate and schedule 
emails to partners about maintenance operations. The emails are sent to the 

addresses specified in Carriers\Agreements (the Default technical emails 
parameter).  

The page has two panels. The left panel is a table of scheduled notifications; the 
right panel contains the Add and Edit menus.  

 
Fig. 13 Service notifications table 

The Add menu is illustrated below.  

 
Fig. 14 Add menu 

The Add menu contains the following parameters: 
• Type: type of communication 

• Date: the date and time of the email dispatch to partners 
• Subject, Text: the subject and text of the message 

4.5 System Jobs 

The Administration\Jobs page contains general information about standard 
processes running in the database. The page is intended for the Alaris support 

team. 

4.6 System Settings 

The System Settings menu allows administration of all the main System 
parameters. Most of them can only be configured by the Alaris support team and 

must not be edited by the user to prevent the System breakdown. The sections 
below describe the parameters that can be configured by the System owner.  



 
 

  

 

 
Fig. 15 System settings 

4.6.1 Common 

 
Fig. 16 Common settings 



 
 

  

 

• Allowed time-zone fraction types (times 15, 30 or 60 minutes): used in 

cases when partners have time zones with irregular time offsets. For 
example, to include the Iran timezone (UTC + 3.5) set this parameter to 

30, so that the statistics and invoicing are calculated correctly. NOTE: The 
parameter only impacts statistics used for invoice generation and the 

invoice timezone) 
• Enable overall email delivery in the System (1 - enable, 0 - disable): 

defines whether the System will send emails (such as invoices, 
notifications, alarms etc.) 

• First day of the week (0 - Sunday, 1 - Monday): defines the day on which 
the week starts (in calendars) 

• Font applied to excel files (0 - internal default, 1 - default file formatting): 
defines what font to use in MS Excel files generated by the System. Select 

0 to use the default System font or 1 to use the font of the MS Excel 
document (the System takes the font of the top first cell of the document)    

• Log store period, days: the period to store the change logs of Database 

objects (Carriers, Products and routing rules). NOTE: The logs contain 
details of every change in System tables as well as the author of the 

changes. This allows investigating any incident (System breakdown, errors, 
malicious attacks etc.). However, logs take disk space and impact the DB 

size. Therefore, prior to modifying this parameter consult the Alaris support 
team  

• Password expiry reminder (days): defines the time to warn a user to 
change password before expiration 

• Password valid period (days): defines the period after which the password 
expires 

• Rate change log, days: the period to store the rate change logs in the 
System 

• Support email: email address of the Alaris support team that System 
notification and alarms are sent to 

• Temporary password logins allowed: the number of allowed login attempts 

with a temporary password. NOTE: A temporary password is assigned to 
the user if the regular password was not changed in due time and expired. 

The user can log in the System with the temporary password and change it 
to a regular one. If the user fails to create a new regular password and 

uses up the number of logins specified in this parameter, the access to the 
System is blocked. The password can be changed at Start\User settings 

• Temporary password valid period (days): defines the period of the 
temporary password expiration 

• Zip report file when emailed (1 - zip, 0 - don't zip): defines whether the 
report files attached to the e-mails sent by the System must be archived 



 
 

  

 

4.6.2 Financial module 

 
Fig. 17 Financial module 

• Balance alarm threshold: defines the minimal amount of the partner 

account balance (in the System currency) to trigger an alarm (five 
thresholds are available) 

• Credit alarm default email (null - do not use it): the System owner's email 
address that receives balance alerts for all accounts that have the Send 

balance alerts flag checked  
• Credit alarm threshold, %: defines the minimal amount of the credit 

provided to a partner (configured in the In credit field on the 
Carriers\Agreements) to trigger an alarm (five thresholds are available) 

• Credit status reset threshold, %: defines the minimal amount of balance for 
credit alarms to be triggered again (it is done to prevent numerous alarms 

when the client balance is fluctuating around the limit because of bilateral 

traffic, increasing a bit above the disconnection point and then dropping 
below the limit again). Example: suppose the Credit alarm threshold is set 

to 70%, the Credit status reset threshold is 5%, and the credit usage 
fluctuates between 69 and 71%. For the alert to be sent again, the credit 

usage must first drop to at least 65 percent and then raise to 70 percent. 
• Credit status reset threshold, USD: same as above, but measured in the 

System currency instead of percentage 
• Cross-monthly invoice splitting (1 - split, 0 - do not split): defines whether 

invoices with the billing period covering the joint between two months are 
to be split in two separate invoices 

• Current invoice number: defines the index number of the next 
automatically generated invoice (increases automatically with every invoice 

generated by the System, i.e. does not count manually created 
documents). This parameter is used in generation of the invoice reference 

number. The parameter‟s value can be edited (e.g. to start invoice 

enumeration from the beginning, set the parameter to 1)  



 
 

  

 

• Default charge grouping mode: defines how invoices are grouped if the 

Autovalue flag is checked in the Carriers\Products Add or Edit menu. 
Possible values include:  

- 1 - separate invoices for client and vendor side: traffic details for all 
products are grouped in one invoice for each traffic direction (client or 

vendor)  
- 2 – separate invoices for each product: a separate charge and a 

separate invoice are issued for each product 
- 3 – separate charges within one invoice: a single invoice contains 

several traffic detail files, one for each charge 
• Email address to CC invoices distribution (null - do not send CC): defines 

the additional email addresses for invoice delivery; several comma 
separated addresses can be specified 

• Finance first (second, third) currency: text string that defines additional 
currencies in which invoices and charges can be calculated (normally they 

are displayed in the account currency). Examples: USD, EUR etc. The 

default value is null. NOTE: After you configure the currencies in Finance 
first (second, third) currency, perform EDR rerating (see SMS\EDR 

management\EDR Rerating) and invoice recalculation (see 
Finance\Invoices\Editing invoices) for the appropriate period, otherwise all 

amounts in the Charges table will be zero  
• Invoice auto-dispatch delay, hours (null - auto confirmation and dispatch is 

off): when the value is a positive integer, all invoices are confirmed and 
sent to partners automatically with the delay specified in the parameter. 

When the value is null, all created invoices have the draft status and must 
be confirmed and dispatched manually 

• Invoice correction type (1 - replace invoice, 2 - correct last invoice): 
defines the method of sending invoice corrections. When the value is 1, the 

invoice is replaced and the partner receives a new version of the invoice; 
when the value is 2, the partner receives an additional credit note or new 

invoice 

• Invoice delivery options (1 - attachment, 2 - link, 3 - separate emails, null - 
do not send): defines the way invoices and the traffic details summary are 

sent 
• Invoice details filename pattern: defines the file name format of the file 

with the traffic details summary (for example, 
[CompanyName]_[InvoiceDate]_[Details].pdf) 

• Invoice filename pattern: defines the format of the invoice file name (for 
example, [CompanyName]_[InvoiceDate].pdf) 

• Invoice generation delay, hours: time interval to delay invoice generation 
after the invoicing period ends – this is done to make sure that all the late 

EDRs for that period successfully hit the System before the invoice is 
generated 

• Invoice issue date option (1 - last day of current billing period, 2 – first day 
of next billing period): defines the date of invoice issue 

• Invoice presented amount includes tax (1 - yes, 0 - no): defines whether 

the amount due according to partner estimation includes tax  



 
 

  

 

• Invoice reference number format: defines the format of the invoice 

reference number. The parameter supports all alphabetical and numeric 
values. The following markers can also be used here: 

- [ХХХХХ] (the number of X's can vary) – placeholder for the value from 
the Current invoice number parameter. The number of X's stands for the 

amount of digits to display. For example, if the Current invoice number is 
set to 123 and the Invoice reference number format parameter is set to 

[XXXXX] (5 X's) - the reference number of the next generated invoice will 
be '00123' 

- [CAR_ID] – ID of the partner Carrier record 
- [AGR_CODE] – code of the partner's Agreement (taken from the 

mandatory field Agreement code of the Carriers\Agreements) 
- [YYYYMMDD] or [YYMMDD] – the invoice generation date (can be found 
in the Created column of the Invoices page) 

• Min absolute mismatch to invoke a dispute: the minimal absolute difference 

between the System owner's and partner's invoice amounts to start a 
dispute (Presented amount and Due amount) 

• Min percent mismatch to invoke a dispute: same as above, but checking 
the relative difference (in per cent). Both of these parameters should be 

surpassed simultaneously to trigger the invoice status change to Disputed 
• Notification period of deferred payments coming due, days: the number of 

days for notifying a partner about the expiry of a draft payment (see 
Payments table for more detail on draft payments). The email addresses 

are set in Carriers\Agreements (Default invoice emails field)  
• Payment registration alert: sending notification on received payment to the 

partner 
• Scoring (Credibility), Scoring (Payment stability), Scoring (Subjective 

estimation), Scoring (Traffic volume stability): defines the weight of 

partner‟s estimation index – a bigger value in the field means more weight 
of this parameter among others 

• Send balance alerts for accounts with non zero credit limit (0 - no, 1 - yes): 
defines whether balance alerts must be sent to accounts having a credit 

limit (the limit amount is set in Carriers\Accounts)   
• Send credit alarm to account manager (0 - no, 1 - yes): defines whether 

credit/balance alarms are to be sent to the client account manager on the 
System owner's side (to the address indicated in the Email field in the 

account manager‟s user record in the Carriers\Users) 

• Send credit alarm to customer (0 - no, 1 - yes): defines whether 

credit/balance alarms are to be sent to the partners (to the addresses 
indicated in the Account alert emails fields in the partners‟ Agreements in 

the Carriers\Agreements 
• Send notifications of deferred payments coming due to client (1 – yes, 0 - 

no): defines whether to notify partners about the expiry of draft payments 

(see Payments table for more detail on draft payments). The email 
addresses are set in Carriers\Agreements (Default invoice emails field) 



 
 

  

 

• Suggest making document mapping by default (1 – yes, 0 - no): when the 

parameter is set to 1, the Make auto mapping flag in the Edit invoice form 
is checked by default  

• Unconditional invoice dispute threshold: the minimal absolute difference 
between the System owner's and partner's invoice amounts to start a 

dispute, regardless of the parameter Min absolute mismatch to invoke a 
dispute 

• Zip traffic details when sent to e-mail (0 - no, 1 - yes): defines whether the 
traffic details files attached to the e-mails sent by the System are to be 

archived 

4.6.3 Partner portal 

 
Fig. 18 Partner portal settings 

• Allow new user registration (1 - yes, 0 - no): defines whether Partner portal 

users can create their accounts themselves or new user registration is only 

performed by the System Owner 
• Allow portal users to edit POI (1 - yes, 0 - no): defines whether Partner 

portal users can create and edit their POIs  
• Authorize.net API Login ID: authorization parameter for accounts belonging 

to the Authorize.net payment service 
• Authorize.net Salt: authorization parameter for accounts belonging to the 

Authorize.net payment service 
• Authorize.net Transaction Key: authorization parameter for accounts 

belonging to the Authorize.net payment service 
• Available currencies (null – All): comma-separated list of currency codes 

defined in the System, which will be available in the Partner portal for new 
partner account creation 

• Available product IDs (null – All): comma-separated list of client products 
belonging to the System owner that will be available as parent products in 

the Partner portal for new partner product creation 



 
 

  

 

• Customer portal URL: web address of the Partner portal 

• Customer portal URL (retail): URL of the retail portal (for SMS campaigns) 
• Default SMS channel NPI, Default SMS channel TON, Default SMS channel 

address range, Default SMS channel port, Default SMS channel system 
type: parameters for SMS channel creation using the Partner portal. Values 

entered in these fields will be default settings for the newly created 
channels 

• Default account manager user ID: ID of the user belonging to the System 
owner that will be appointed as the account manager for all new self-

subscribed clients at the customer portal 
• Infrastructure POI IPs (comma separated): IP addresses of the System 

owner‟s internal network 
• Mandatory users (comma separated): required user roles that must be 

configured at the Partner portal 
• Max client products per carrier (null - unlimited): maximum allowed 

number of products configured in the Partner portal 

• Maximum number of simultaneous connections to database: defines how 
many simultaneous requests can be sent to the database from the web 

interface of the Partner portal 
• PAYPAL Business: authorization parameter for the accounts belonging to 

the PAYPAL payment service (e-mail address) 
• PAYPAL payment confirmation URL: URL used for confirmation of Paypal 

payments 
• Poi IP mask to hide in Portal (null - show all): subnet of IP addresses that 

should not be displayed at the Partner portal 
• Portal access mode (1 - read/write, 2 - read only): defines access rights to 

the Partner portal 
• Send portal notifications to (null – don’t send): email address to send email 

notifications when a new user or partner POI is created, or a payment is 
made through the Partner portal 

• Show fully paid invoices (0 – no; 1 – yes): defines whether the invoices 

settled by a partner should be displayed in the Partner portal. Unsettled 
invoices are always displayed 

• Spare database connection waiting timeout: defines the keep alive time for 
the requests from the Partner portal GUI to the database if the Maximum 

number of simultaneous connections to database is exceeded 



 
 

  

 

4.6.4 SMS 

 
Fig. 19 SMS  

• Active EDR day count: period during which EDRs can be accessed for 
various operations (such as rerating, invoice generation etc.) After this 

EDRs are moved to an archive 
• Analytics first (second, third) currency: currencies used in SMS\Analytics 

(can be different from the System currency) 

• Apply postponed DLRs in, days: delay period for applying DLRs generated 
before the date specified in the parameter Postpone applying DLRs for SMS 

received before 
• Archive EDR day count: EDR storage period in an archive. After this EDRs 

are deleted  
• Auto threshold calculation (0 - no, 1 - yes): when the value is 1, the cube 

update thresholds are calculated automatically 
• Automatic EDR archiving limit: the number or EDRs archived within a single 

session  
• Blocked networks markers: a list of keywords (comma-separated) used as 

markers of blocked networks in import of rate sheet files. If the rate sheet 
file has the Network status column and one of the keywords is found in the 

file for any rate, the Rate note field for this rate will have the Blocked 
value.     

• Day cube partition count: number of daily cubes stored in the System; in 

other words, a period of time (in days) during which the System retains 
aggregated statistics arranged by daily cubes 

• Delivery waiting period, sec: the period during which DLRs are expected; 
after that, the DLR will not be recognized   

• EMA frame: number of data counts with the same weight within EMA 

(exponential moving average) 



 
 

  

 

• EMA stats delay, min: the statistics calculation delay in minutes. NOTE: In 

terms of routing statistics, the EMA tool serves to secure prevalence of 
recent EDRs over earlier ones; the System's routing module receives all 

SMS statistical data from the database, where EMA is calculated 
retrospectively with the specified delay, i.e. data on messages arriving 

within or after this delay period is not taken into account since it can 
seriously damage the overall analytical picture, for example, because of the 

absence of delivery reports that are most likely to arrive shortly afterwards 
• EMA stats last date: date and time of the latest update of statistics 

• EMA valid period, days: stats validity period in days for stats validity for 
items used in the routing rules (for example, client MCC MNC code). If on 

expiration of the specified period no traffic is processed for the item, the 
routing module will assume statistics for this item as null; if even one SMS 

arrives within this period the stats will be considered valid 
• HLR dip enabled: when the value is 1, the Dip HLR checkbox is selected by 

default in the Add menu of the Carriers\Products page for SMS products  

• Hour cube partition count: number of hourly cubes stored in the System; in 
other words, a period of time (in hours) during which the System retains 

aggregated statistics arranged by hourly cubes 
• List of MCCs with 3-digit MNCs: list of MCCs for countries that always use 

3-digit MNCs. The list is used to generate the MCCMC5 column during rate 
export. MCCs that are not in the list are translated into 5-digit codes if the 

MNC starts with 0.   
• List of SMS products which margin is set to 0 in analytics: SMS products 

that must be excluded from margin analysis (their margin is displayed as 0 
in SMS\Analytics). This parameter is used when the rates must be ignored 

in analytics – for example, when the System owner uses internal 
equipment for processing SMS messages, which makes rates and margin 

data irrelevant  
• Minute cube partition count: number of minute cubes stored in the System; 

in other words, a period of time (in minutes) during which the System 

retains aggregated statistics arranged by minute cubes 
• Month cube partition count: number of monthly cubes stored in the 

System; in other words, a period of time (in months) during which the 
System retains aggregated statistics arranged by monthly cubes 

• Multi-threaded analytics (0 - no, 1 - yes): enables multi-threaded analytics 
(MA). NOTE: It is reasonable to use this mode only on high performance 

Systems with monthly traffic of at least 5 mln SMS  
• Non-match DLR storage period, min: storage period of DLRs with no 

matching EDR submit_sm packets 
• Postpone applying DLRs for SMS received before: postpone applying DLRs 

for messages received before the specified date. The parameter serves to 
prevent backdate update of statistics during invoice generation. The 

postponed DLRs will be applied after the delay configured in the parameter 
Apply postponed DLRs in, days 

• Rate activation time adjustment, minutes: round-off value (in minutes) for 

applying new rates. For example, if the parameter is set to 60 (minutes), 



 
 

  

 

and the rate activation time in the rate sheet file is 1 January at 01:20, the 

rate will be applied on 1 January at 2:00. However, if the rate activation 
time is 1:00 sharp (or any other round hour), the rate will be active at 1:00 

(and not 2:00), even if the round-off value is 60.  
• Rate rounding precision (displaying): number of decimal places for 

displayed rates 
• Rate rounding precision (storing): number of decimal places for rates 

stored in the System 
• Recalculate current day stats at, hours (0-23, 1-fold): forced recalculation 

of day statistics at the specified hour (valid values are integers from 0 to 
23) 

• Recalculate current hour stats at, mins (0-50, 10-fold): forced recalculation 
of hour statistics at the specified minute of the hour (valid values are 0, 10, 

20, 30, 40 or 50) 
• Routes to send: maximum number of routes that the System can provide 

for terminating an SMS 

• Stats calculation delay, minutes (day/hour/min/month): the delays 
configured for each time increment (minute, hour, day, week, and month) 

to allow statistics calculation even if the thresholds configured in Stats 
calculation threshold (SMS/Hour, SA) and Stats calculation threshold 

(EDR/day, EDR/hour, EDR/min, EDR/month, EDR/week, MA) have not been 
reached. For example, the value 45 in the parameter Stats calculation 

delay, minutes (day) means that the statistics for a daily cube will be 
calculated on 00:45 on the following day in case amount of new records 

does not exceed the threshold defined in Stats calculation threshold 
(EDR/day) 

• Stats calculation threshold (SMS/Hour, SA): number of SMS attempts 
necessary to launch next cube recalculation (in single-threaded analytics); 

the initial value is set for hourly cubes, but can be calculated for minute, 
weekly, daily, or monthly cubes by respective multiplication, i.e. with 100 

SMS/hour value, daily cube recalculation will take place at 2400 SMSs level 

etc. 
• Stats calculation threshold (EDR/day, EDR/hour, EDR/min, EDR/month, 

EDR/week, MA): number of EDRs per day/hour/minute/month necessary to 
launch next cube recalculation (in multi-threaded analytics). See 

Reports\Analytical cube status (Administration) for more detail on single- 
and multi-threaded analytics  

• Switch URL template for SMS test send: URL of the switch used for test 
SMS generation; test messages may be generated directly from the switch 

or from the billing interface by creating a channel, linking it to POI and a 
certain product, and may be terminated if the System manages to find 

possible termination. The parameter is set by Alaris engineers and must not 
be changed by a user 

• Traffic details days count: number of days in financial cubes; indicates a 
period by the end of which the System will start to form a financial cube 



 
 

  

 

• Update rate notes for existing rates (0 - no, 1 - yes): defines whether the 

imported rates must be updated if the rate record has the same price but a 
new rate note  

• Week cube partition count: number of weekly cubes stored in the System; 
in other words a period (in weeks) during which the System retains 

aggregated statistics arranged by weekly cubes. 

4.7 Template manager 

The Administration\Template manager page allows creating templates for various 

document types generated by the System – invoices, rate export files, invoice 
letters etc. 

The page is divided in two panels. The left panel is a table of templates. The 
table contains the following information: 

 
Fig. 20 Template manager 

• Template: description of the template and link for downloading the 

document in XLS, PDF or HTML format 

• Contract company: the legal entity of the System owner on behalf of which 
it works with a partner 

• Account: carrier account(s) the selected template is used for (if Default – 
the template is used for all carriers except for those who have separate 

templates; Default templates cannot be deleted) 
• Last updated: the date of the template latest update 

• Button  in the rightmost column activates the Change template menu on 
the right. 

The Change template menu allows configuration of the following parameters: 
• Template type: type of the template (select from the drop-down list) 

• Contract company 
• Account filter: carrier account the template is used for (it is possible to 

select multiple accounts by moving the required accounts from the Other 
items list to the Selected items list. The Account filter shows only accounts 

belonging to the carrier selected from the drop-down list) 

• Product type: select SMS  
• Template file: select a file to upload 



 
 

  

 

 
Fig. 21 Change template 

When through with defining the parameters, click  to confirm or  to 
discard the settings. 

To add a new template to the System click  and open the Add new 

template menu. The configurable parameters are the same as in the Change 
template menu. 



 
 

  

 

 
Fig. 22 Add template menu 

Below is a list of available markers for the templates: 

4.7.1 Markers 

Markers are alphanumeric strings in square brackets that are used in document 
templates as placeholders of information. Below is a list of markers supported by 

the System.  

 
General parameters 

[InvoiceId] – invoice identifier 
[InvoicePeriod] – invoice period 

[InvoicePeriodLong] – invoice period with time indication 
[InvoiceSysPeriod] - – invoice period in the System owner‟s time zone 

[CompanyId] – partner carrier's identifier 
[CompanyName] - partner company name 

[CompanyRegisteredName] – name of the partner's company as specified in the 
parameter Company registered name in Carriers\Agreements 

[CompanyAddress] – partner‟s address 
[CompanyVAT] – partner‟s personal tax reference number  

[CurrencyCode] – currency 
[InvoiceDate] – invoice issue date 

[InvoiceRefNumber] – invoice reference number 

[InvoiceDueDate] - invoice due date 
[InvoiceTimezone] – name of the time zone according to which the invoice is 

generated 
[FileName] – PDF file name 

[DetailsFileName] – name of the PDF file with traffic details  
[AgrCode] – agreement code 

 



 
 

  

 

Invoice totals 

[EstimatedAmountNum] – invoice total including taxes, without currency 
indication 

[EstimatedAmount] – invoice total including taxes, with currency indication 
[EstimatedAmountWithoutTaxNum] – invoice amount excluding tax, without 

currency indication 
[EstimatedAmountWithoutTax] – invoice amount excluding tax with currency 

indication 
[TaxAmountNum] – tax amount without currency indication 

[TaxAmount] - tax amount with currency indication 
[TaxRate] – tax rate with the percent symbol (for example, 21%) 

[PreviousBalanceNum] – partner‟s account balance at the end of the invoice 
period, without currency indication; 

[PreviousBalance] partner‟s account balance at the end of the invoice period, 
without currency indication 

[TotalAmountNum] - total payable including balance (difference between 

PreviousBalance and EstimatedAmount, without currency indication) 
[TotalAmount] - total payable including balance (difference between 

PreviousBalance and EstimatedAmount, with currency indication) 
[PrepaymentAmountNum] – prepaying total (least ([EstimatedAmount], greatest 

([PreviousBalanceNum], 0)), without currency indication 
[PrepaymentAmount] – [PrepaymentAmountNum] with currency indication 

[AmountInWord] – invoice amount written in words 
[EstAmountInWord] - EstimatedAmount written in words 

[EstimatedAmountPlusTaxNum] – invoice amount including tax (the tax is added 
automatically), with no currency indication  

[EstimatedAmountPlusTax] - invoice amount including tax (the tax is added 
automatically), with currency indication  

 
Invoice totals in multiple currencies 

[<Currency code>InInvoiceCurrency] – value of one unit of <Currency code> in 

the invoice currency. Currencies from the Currency exchange rates reference 
book are used instead of <Currency code> (for example, for a USD invoice, 

[EURInInvoiceCurrency] is approximately 1.2) 
 

[InvoiceCurrencyIn<Currency code>] - value of one unit of the invoice currency 
in <Currency code>. A currency from the Currency exchange rates reference 

book can be inserted into <Currency code>] (for example, for a USD invoice, 
[InvoiceCurrencyInEUR] is approximately 0.8) 

 
[EstimatedAmountIn<Currency code>] – invoice amount in the currency 

<Currency code> 
 

[EstimatedAmountWithoutTaxIn<Currency code>] - invoice total without taxes in 
the currency <Currency code> 

 



 
 

  

 

[TaxAmountIn<Currency code>] – amount of tax in the currency <Currency 

code> 
Details of invoice charges  

[ChargeDetColumn1] –  MCC  
[ChargeDetColumn2] - MNC 

[ChargeDetAmount] – amount 
[ChargeDetEvent] – number of SMS 

[ChargeDetVolume] – volume 
[ChargeDetRate] – rate 
 
Parameters edited by urlencode function 

[CompanyNameUE] – company name encoded for use in URL 
[CurrencyCodeUE] – currency code (e.g. USD, EUR, etc.) encoded for use in URL 

[InvoiceDateUE] – invoice issue date encoded for use in URL 
[InvoiceRefNumberUE] – invoice reference number encoded for use in URL 

 
NOTE: Urlencode function transforms invoice parameters, replacing the 

corresponding markers listed in this section into a special format to be used 
within a URL-link. 
 
Markers for letter subject and body only 

[DocumentLink] – download link to the invoice cover letter  
[DetailsLink] – download link to the traffic summary details document  
 
Markers for attachments only 
[ChargeDescription] - charge description 

[ChargeAmount] – charge total 

[ChargeCurrencyCode] – charge currency 
[ChargeVolume] – charge volume 

 
Markers for amounts in multiple currencies 

[CurrencyCode1] – name of the currency set by the Finance first currency 
parameter (Administration\System settings\Financial module) 

[CurrencyCode2] – name of the currency set by the Finance second currency 
parameter (Administration\System settings\Financial module) 

[CurrencyCode3] - name of the currency set by the Finance third currency 
parameter (Administration\System settings\Financial module) currency 

 
[EstimatedAmountNumX], where X = 1,2,3 – invoice amount including tax, with 

currency indication for [CurrencyCodeX] 
[EstimatedAmountX], where X = 1,2,3 - invoice amount including tax with 

currency indication for [CurrencyCodeX] 

 
[EstimatedAmountWithoutTaxNumX], where X = 1,2,3 – invoice amount 

excluding tax, without currency indication for [CurrencyCodeX] 
[EstimatedAmountWithoutTaxX], where X = 1,2,3 – invoice amount excluding tax 

with currency indication for [CurrencyCodeX] 



 
 

  

 

[EstimatedAmountPlusTaxNumX], where X = 1,2,3 – invoice amount including 

tax (the tax is added automatically) without currency indication for 
[CurrencyCodeX] 

[EstimatedAmountPlusTaxX], where X = 1,2,3 – invoice amount including tax 
(the tax is added automatically) with currency indication for [CurrencyCodeX] 

[TaxAmountNumX], where X = 1,2,3 – tax amount without currency indication 
for [CurrencyCodeX] 

[TaxAmountX], where X = 1,2,3 - tax amount with currency indication for 
[CurrencyCodeX] 

 
[ChargeAmountX], where X = 1,2,3 – charge amount with currency indication for 

[CurrencyCodeX] 
 

Markers for SMS rate export (letter and rate file) 
[CompanyName] – partner name 

[CompanyRegisteredName] – name of the partner's company as specified in the 

parameter Company registered name in Carriers\Agreements 
[CompanyAddress] – partner address 

[ProductName] – product name 
[OwnerName] – System owner‟s company name as set in the parameter Contract 

company name in Carriers  
[IssueDate] – date of the rate file creation 

[TimeZone] – System owner‟s time zone 
 

Markers for email notifications on System owner account activation, 
registration and password reset   

[SystemOwnerName] – name of the System owner 
[Link] – activation link 

 
Markers for password reset notifications generated by the System owner 

(for users created in the Carriers\Users page) 

[SystemOwnerName] - name of the System owner  
[UserFirstLastName] – user's first and last names  

[UserLoginName] – user's login 
[UserNewPassword] – new password  

[PasswordExpireDate] – password expiry date  
[Link] – System access link  

 
Markers for password expiry notifications  

[SystemOwnerName] - name of the System owner  
[ExpireDate] - password expiry date 

[UserFirstLastName] – user's first and last names  
[Link] – System access link  

 
Markers for the invoice reference number 

[CAR_ID] – carrier identifier 

[AGR_CODE] – agreement code 



 
 

  

 

[YYYYMMDD] – invoice issue date 

[YYMMDD] – invoice issue date (another format) 
[X*] - invoice number (if, for example, the value is set to XXXX, then numbers 

are 0001, 0002, ... 9999) 

4.8 Trace analyzer 

The Administration\Trace analyzer page provides a convenient web interface for 
capturing network traces in the PCAP format. This comes instrumental in low-

level troubleshooting of partner channels.  

The System captures network traces on a non-stop basis. The Trace analyzer 
page allows filtering the required file. The user can download a PCAP file for a 

specific partner channel (IP address) for a predefined time period, as illustrated 
below.   

 
Fig. 23 Analysis parameters (filter) 

To download the file, click on the link in the Details column of the table of tasks.  

 
Fig. 24 Table of tasks 

NOTE: By default traces are stored in the System for three days. 

5. Carriers 
The Carriers section is one of the most essential components of the System. It 
allows managing information related to partners as it contains all the basic data 

about carriers the System owner works with.  
The Carriers section includes the following pages: Carriers, Users, Accounts, 

Agreements, Products, SMS channels, SMS POI. The pages are interconnected 

and do not allow inadvertent deletion of any parent item if it has at least one 
child component. In case you are sure to delete a carrier or some of its parent 

components, use the  Delete this <item name> and all child components 
button which permits deletion after confirmation.  

Each page stores a full list of items indicated in the page name, so they can all be 
viewed in one place. This is useful when you need to find out, for example, to 



 
 

  

 

which carrier belongs a particular IP address. Each page allows filtering items 

according to objects they belong to or by their key parameters using text masks 
or drop-down lists under the column headers. To clear the configured filter click 

the Clear filter  button located in the left upper corner of each page.  
Once you select a carrier by highlighting it in the first page, all other pages 

display only objects belonging to that carrier. The information on each page of 
the Carriers section can also be filtered irrespective of the carrier selected in the 

first page. 
Each page of the Carriers section is divided in two panels. The left panel contains 

the table with the items registered in the System. The right panel contains the 
Add and Edit menus that allow adding new records or editing existing ones. To 

activate the Edit menu, click on the record in the table. 

5.1 Carriers 

The Carriers page contains general information about carriers. The page is 

divided in two sections. The left section displays a table of carrier records 
registered in the System.  

 
Fig. 25 Carriers 

The table contains the following information: 

• ID: internal identification number 
• Region: region of the carrier (the regions are listed in the Reference 

books\Regions section) 

• Carrier name: full name of the carrier‟s company 
• Is trusted customer: type of the credit control approach (if the Is trusted 

customer parameter is Yes, the carrier will not be disconnected irrespective 
of the account balance). The value depends on the In credit parameter in 

the Carriers\Agreements page 
• Credibility: index of the partner‟s due diligence, automatically calculated 

based on the partner‟s payment stability, subjective estimation, credit limit 
and traffic volume stability 

• Inbound/Outbound traffic allowed 
The right section contains the Add and Edit menus. To add a new carrier, enter 

the appropriate parameters in the Add menu. Fields marked with an asterisk (*) 
are required. 

• Carrier name: full name of the carrier‟s company  
• Subjective estimation: personal estimation of a carrier for Credibility 

calculation 

• Inbound traffic allowed / Outbound traffic allowed  
• Address: the carrier‟s postal address 



 
 

  

 

• Region: geographical region  

• VAT identification number: VAT ID  
• Comments: any relevant notes 

• Contract company: the legal entity of the System owner on behalf of which 
it works with the carrier. The parameter comes handy when the System 

owner interacts with different partners on behalf of different legal entities. 
NOTE: Various contract companies can have different sets of access rights, 

which may impact the accessibility and visibility of certain functions in the 
System (configured at Reference books\Contract companies).  

NOTE: to make a carrier record operative, at least one account must be created 
(see Carriers\Accounts for more detail). 

 
Fig. 26 Add carrier menu 

When through with defining the parameters, click  to confirm or  to 
discard the settings. To delete a record, select it in the table and click 

 in the Edit panel. 

5.2 Users 

The Carriers\Users page contains information on user accounts that allow logging 
in to the System. The access to the main System interface is granted only to the 

System owner users, while other carriers‟ users can log in only over the Partner 
portal interface.  



 
 

  

 

 
Fig. 27 Users 

Use text masks or drop-down lists under the column headers to filter the records 

in the table. 
The right-hand panel contains the Add and Edit menus.  

 
Fig. 28 Add menu, General and User data 

The Add menu contains the following parameters: 
General:  

• Carrier: select the carrier from the drop-down list 
• Login: the user‟s login 

• Email: the user‟s email 
• Is active: defines whether the user will have access to the System interface 

(for users belonging to the System owner) or to the Partner portal (for 
users belonging to any other carrier) 

• Allowed IP addresses: IP addresses allowed for logging in to the System. 

Several comma separated IP addresses or a network mask can be entered 



 
 

  

 

User Data: 

• First name, Middle name and Last name of the user 
• Position: the user‟s position in the company 

• Birthday: the user‟s birth date 
• Language: web-interface language. English is the default language 

Preferences: 
• Send rate changes, Send invoices, Send alarms: define whether the 

System will send this information to the user‟s email address defined in the 
Email field 

Contacts: 
• Main contact phone number, Office phone, Mobile phone number, Skype, 

MSN, Other IMs: the user‟s contact information 

 
Fig. 29 Add menu, Roles 

Roles: permissions to access the interface components. User roles restrict the 

information within the System interface from being seen or edited by specific 
users - so, for example, a user from the technical department cannot see any 

financial details. Select the flag System owner. NO restrictions to grant all 
possible permissions to the user. 

The following permissions may prove handy:  
• View/edit permissions defines what kind of information can be viewed by 

the user:  
- Edit rates/routing for own accounts only: allows the user to edit the 

rates and routing data referring only to the accounts managed by the user  
- View and edit objects of own accounts: allows the user to view and edit 

data pertaining only to the accounts managed by the user 
- View and edit all data, View all data: allows the user to view and/or edit 

any data in the System  



 
 

  

 

 
Fig. 30 Add menu, SMS analytics 

• SMS –> SMS Analytics 

- View SMS financial details, View SMS technical details: allows limiting 
access to the technical or financial sections of the Analytics page.  

 
Fig. 31 Partner Portal 

• Partner portal: defines permissions for users having access only to the 

Partner portal interface. NOTE: Users having access to the Partner portal or 
Wholesale partner portal must be created on behalf of a user other than 

the System owner.  
- Authorize, Paypal: allows payments via the authorize.net and Paypal 

accordingly. NOTE: Prior to using this function, an account must be 
registered at authorize.net and Paypal respectively and configured in 

Administration\System settings\Partner portal  
- Show rates tab: displays information about SMS rates 

- SMS retail partner portal: grants access to the SMS marketing portal 
- Wholesale partner portal: grants access to the wholesale SMS exchange 

portal  

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to delete the selected record. 

The  button opens the password change menu.  



 
 

  

 

 
Fig. 32 User password change 

Enter the new password in the appropriate field or use the  button to 

generate the password automatically. Relative security of the password in 
percentage points is displayed in the field to the right. Configure the password 

expiry date or use the <+ * days> buttons to prolong it. When the new password 

is ready, click the  button. 

5.3 Accounts 

The Carriers\Accounts page contains data on financial accounts associated with 

the carriers. 

 
Fig. 33 Accounts 

Use text masks or drop-down lists under the column headers to filter the records 
in the table. The table contains the following information: 

• ID: internal identification number 
• Carrier: select the carrier from the drop-down list 

• Currency: currency of the account. The currencies and their exchange rates 
are configured in Reference books\Currency exchange rates. In order to 

integrate real-time update of exchange rates, contact the Alaris technical 
support team 

• Balance: current balance of this account  
• Balance updated: date and time of the latest balance update (is performed 

every minute). NOTE: As the balance is not updated in real time, the credit 
limit may be exceeded. However, due to frequent (every minute) update, 

the overlimit is normally insignificant 

• Manager: manager responsible for this account on the side of the System 
owner. The manager is assigned in the Administration\Account manager 

history once the account is created 
• Client credit: credit status on the client‟s side. The figure in brackets is the 

credit limit configured in the Carriers\Agreements page. The value 0 means 
no credit available (prepaid services); no figure in brackets means the 

credit is unlimited (postpaid services) 
• Vendor credit: credit status on the vendor‟s side. Similarly to Client credit, 

the figure in brackets is the credit limit 
• Description: arbitrary description of the account 



 
 

  

 

The right panel contains the Add and Edit menus.  

 
Fig. 34 Add menu 

The Add menu contains the following parameters: 
• Carrier 

• Currency 
• Description  

• Send balance alerts: select the flag to send the client automatic 

notifications on reaching the balance limit (with a CC to the account 
manager). A copy of the notification can also be sent to the System 

owner's email specified in the field Credit alarm default email 
(Administration\System settings\Financial module). The selected Send 

balance alerts checkbox activates the fields below  
• Account credit threshold (#1-#5): notify the client when a certain 

percentage of the credit limit is reached (the credit limit must be non-zero 
and not void); supply the value as a percentage of the credit limit. Up to 5 



 
 

  

 

notifications can be configured, for example, at 50 percent, 70 percent and 

100 percent limit reached 
Account balance threshold (#1-#5): notify the client when a certain account 

balance amount is reached (if the agreement is fully prepaid); supply the amount 
in respective currency. Up to 5 notifications can be configured When through with 

defining the parameters, click  to confirm or  to discard the settings. 
Click  to delete the selected record. 

5.4 Agreements  

The Carriers\Agreements page stores the most essential terms of the 

interconnect agreements with the carriers. Most parameters defined on this page 

are used by the System in its automatic operation, for example, in routing. At 
least one agreement must be entered in the System. Each agreement is linked to 

a specific account. NOTE: If both incoming and outgoing traffic directions are 
allowed in the agreement, some parameters will be included twice - separately 

for each traffic direction, those intended for client traffic starting with In, while 
those belonging to the vendor agreement section starting with Out. 

 
Fig. 35 Agreements 

Use text masks or drop-down lists under the column headers to filter the records 

in the table. 
The right panel contains the Add and Edit menus. 



 
 

  

 

 
Fig. 36 Add menu, General and Legal info  

The Add menu allows defining the following parameters (in the corresponding 
account currency): 

General:  
• Carrier: select a carrier from the drop-down list 

• Account: select an account from the drop-down list 

• Incoming/Outgoing: traffic direction (unilateral or bilateral). NOTE: only 
one agreement can be created for each direction. Two agreements with the 

same traffic direction can only be created if their validity periods do not 
overlap. Once the agreement is created, its original traffic direction cannot 

be removed; however, the other direction can be added  
• Start date: effective date of the agreement 

• End date: expiry date of the agreement 
Legal info: company details used for reference 

• Agreement code: arbitrary reference code of the agreementCompany 
registered name: legal name of the partner carrier‟s company 

• Bank info: bank details of the partner 
• Default bank account: a default bank account of the System owner used for 

partner settlements (configured in Reference books\Bank accounts)  



 
 

  

 

 
Fig. 37 Add menu, Incoming billing parameters 

• Incoming billing parameters, Outgoing billing parameters: identical sets of 

parameters for client traffic (start with In) and vendor traffic (start with 
Out):  

• In/Out time zones: time zones for the incoming and outgoing traffic. The In 
time zone value is used when creating an invoice for the client (invoicing is 

always done in the client time zone), while the Out time zone value is 

important when vendor rates are imported into the System, so that the 
System can adjust the effective date/time according to the difference 

between the System and the partner time zones. NOTE: It is good practice 
to use the GMT time zone for invoicing in order to eliminate possible time 

zone discrepancies  
• In/Out credit: credit limits for the client and vendor sides (e.g. if the field is 

set to 1000, the balance of the respective account will be allowed to go 
down to -1000 of the account currency units before the traffic is blocked). 

This field value is displayed in the Client credit column of the 
Carriers\Accounts table. NOTE: The default value of the In Credit 

parameter is zero, which means no credit offered to the client. If the field is 
empty, the Is trusted customer parameter is automatically set as Yes for 

that client and the automated credit control for it is disabled. The default 
value for the Out credit parameter is blank, which also turns off auto-

disconnection of the vendor by the System credit control 

• In/Out billing period: period of the client/vendor invoice generation. Select 
a period ranging from 1 day to 4 months from the drop-down list 

• In/Out rounding precision: relevant for voice traffic only  
• In/Out payment period, days: number of days for issued invoices to get 

paid. This parameter is used for monitoring invoices which are not paid in 
due time. Such invoices are marked as Overdue 

• In/Out maximum invoice billing periods: the number of billing periods after 
which the System issues an invoice irrespective of the Minimum invoice 

amount (detailed below) 



 
 

  

 

• In/Out default dispute emails: the client IP address for sending invoice 

disputes. Conditions invoking a dispute are configured in 
Administration\System Settings\Common 

 
Fig. 38 Add menu, Finance parameters 

Finance parameters:  

• In/Out minimum invoice amount: threshold of the total invoice amount 
below which the invoices are not created. Instead, the System will add the 

pending amount to the next invoice of the same customer (in this case the 
timeframe indicated in the new invoice will include the intervals of both 

invoices, and the traffic details will also be combined) 
• In/Out tax rate, %: if the invoice amount includes taxation, this parameter 

defines the percent of the tax 
• In/Out tax scheme:  

- Tax included: if the tax is included into the rate, the invoice is 
calculated as derivative of (Rate)*(Volume)  

- Add tax % to estimated amount: if the tax is not included in the rate, 

the invoice is calculated as a sum of (Rate)*(Volume) + 
(Rate)*(Volume)*(tax)  

- Document only tax inclusion: the tax is included in the invoice but is not 
actually charged  



 
 

  

 

 
Fig. 39 Add menu, Rate notification periods 

Rate notification periods: the minimum number of days for notifying a vendor or 

customer about any upcoming rate changes. Notifications sent at shorter notice 
may be rejected by the recipient 

• In/Out increase notification, days: number of days for an advance rate 
increase notice to be sent from vendor/to customer 

• In/Out decrease notification, days: number of days for an advance rate 
decrease notice to be sent from vendor/to customer 

• In/Out new rate notification, days: number of days for a notice about new 
rates  

• In/Out close rate notification, days: number of days for a notice about 
closing rates  



 
 

  

 

 
Fig. 40 Add menu, Notifications and Extra 

Notifications:  
• Invoice delivery option: specify how the invoices must be delivered: 

- System default: deliver as configured in the Invoice delivery options 
parameter in Administration\System settings\Financial module 

- Do not send: no invoice is delivered  
- Attachment: the invoice is sent in an email with two attachments, one 

containing a cover letter in PDF format and the other a MS Excel file with 
traffic summary details  

- Link: the email contains links to the two invoice files (PDF cover letter 
and MS Excel traffic summary details). The files are stored on the System 

server; once the client clicks on the links the message status is changed 
to delivered. NOTE: This is a reliable way to know that the invoice has 

been received by the partner   

- Separate emails: the PDF cover letter and MS Excel traffic summary 
details are sent in two separate messages 

• Payment alert: sending notification on received payment to the partner 
(System default, Enabled or Disabled). System default is defined by the 

Payment registration alert parameter in the Administration\System 
settings\Financial module 

• Default invoice emails: emails for sending invoices to. Several comma- or 
semicolon-separated addresses may be indicated. If the field is empty, 

invoices are sent to the carrier‟s user email addresses, defined:  
- on the Carriers\Users page (only users with the checked Send invoices 

flag are considered) and  
- in the Email address to CC invoices distribution parameter defined in the 

Administration\System settings\Financial module 



 
 

  

 

• Default rate change/technical/account alert emails: email addresses of the 

partners‟ financial, rate and technical departments, where rate 
increase/change, monitoring alerts, balance limit reached alerts and other 

notifications are sent: 
- If the Default rate change emails field is empty, rate change 

notifications are sent to the carrier‟s user email defined on the 
Carriers\Users page (only users with the checked Send rate updates flag 

are considered) 
- The Default technical emails field contains email addresses to send 

notifications configured in the Administration\Service notifications page. If 
the field is empty, partners will receive no notifications  

- If the Account alert emails field is empty, the alerts are sent to the 
email address of the primary System administrator and to the email 

indicated in the Credit alarm default email parameter in the 
Administration\System settings\Financial module 

Extra:  

• Comments: arbitrary comments 

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to delete the selected record. 

5.5 Products 

The Carriers\Products page contains information about products associated with 
carriers‟ accounts. A product is a rate plan, or, in other words, a type of service 

level agreement (SLA) offered to partners. Products allow grouping vendors and 
clients based on their SLA, and are then used for creation of routing rules for 

such groups.  

Each product is linked to an account, so its currency is always the same as that 
of the account. 

  
Fig. 41 Products 

Use text masks or drop-down lists under the column headers to filter the records 
in the table. 

The right panel contains the Add and Edit menus. 



 
 

  

 

 
Fig. 42 Add menu 

The Add menu allows defining of the following parameters: 
• Carrier: select the carrier from the drop-down list 

• Account: select the account from the drop-down list 
• Product: select the product name from the drop-down list. To create a new 

product name, type it in the edit box  and click 

the  button  

• Product type: select the traffic type (SMS) from the drop-down list 

• Direction: select the traffic direction (Client or Vendor) from the drop-down 
list 

• Parent product: select the parent product from the drop-down list. A parent 
product is a product created by the System owner that allows applying one 



 
 

  

 

and the same rate plan to several partners. In order to do this, create a 

product for each partner, and select the parent product for them.  
• Base product: select the base product from the drop-down list. A base 

product is a product of the same direction and associated with the same 
account that stores the basic rates (those not linked to A-number)  

• Dip HLR: check the flag for real-time HLR query on the network the 
subscriber is currently connected to. Contact the Alaris support team to 

activate this function. NOTE: An agreement with an HLR provider is 
required for the function to work 

• HLR prefixes: specify country codes (space separated) for which HLR 
dipping must be performed (this parameter helps minimize HLR dipping 

expenses by selecting only those countries where it is commercially 
reasonable). NOTE: By default if this field is empty, the routing engine uses 

the internal list defined in the routing module configuration file which can 
be updated by the Alaris technical support team 

• Invoice group index: define how you want your products to be invoiced. 

Products having the same index will be invoiced in a single file. To have 
each product invoiced separately, assign a unique index to each product. To 

include several products in a single invoice as separate charges, assign a 
common integer part for appropriate products and different fractional parts 

for each of them, for example, 0.1, 0.2, 0.3 etc.   
• Autovalue: when the flag is checked, the grouping is performed as set in 

the parameter Default charge grouping mode (for possible values refer to 
Administration\System settings\Financial module) 

• Check ANI tags (available only if Base product is not selected): the 
checkbox serves to look for A-numbers set as ANI tags in other products 

that have this product selected in the Base product list. It is relevant for 
EU/Non-EU billing. For example, SMS within EU are cheaper than those 

from EU to non-EU countries. The System can identify intra-EU SMS and 
route them accordingly. Suppose you have two vendor rate sheet files – 

one having no association with A-numbers and the other containing rates 

within EU. Both sets of rates are associated with the same POI. Create 
Product 1 for rates having no association with A-numbers. Select Check ANI 

tags and create a SMS POI for Product 1. Then create Product 2 for rates 
within the EU. In the Base product field select Product 1; in the ANI tag 

field select the tags containing EU dial codes (the ANI tags must be 
previously created in Reference books\Caller ID tags). No SMS POI must be 

created for Product 2.  
• ANI tag (available only if Check ANI tags is deselected): select ANI tags if 

the product stores rates linked to A-numbers (in this case, Base product 
must also be selected)  

• Add classifier: the table allows creating and assigning personalized tags to 

products, which may prove helpful for analytics. Click  to create 

a new product tag, and fill in the fields as appropriate using the edit box 

. To assign a tag, select it in the table  

• Billable: check the flag if the product must be charged for 



 
 

  

 

• SMS billing option: defines billable SMS based on their delivery status. 

Possible options include:  
- Sent: messages with the Sent status are billed 

- Delivered: messages with the Delivered status are billed  
- Attempts: all message sending attempts are billed  

- Any DLR received: messages with any DLR are billed, irrespective of the 
delivery status  

NOTE: Different SMS billing option values for the vendor/client may result in 
additional profit/loss. For example, suppose the System owner receives 100 SMS 

messages from a client with Sent as the SMS billing option, and forwards them a 
vendor with Delivered as the SMS billing option and gets only 50 DLR reports. In 

this case the System owner will receive payment for 100 SMS from the client and 
will only pay for 50 SMS sent to the vendor.    

 

  
Fig. 43 Edit menu 

The Edit menu additionally allows defining of the following parameters: 
• Edit message limits: opens the Message limits table for defining the 

maximum number of SMS that can be sent through the product. Select the 
appropriate record. To create a new limit, in the Add new limit field 



 
 

  

 

illustrated below enter the maximum number of SMS, select the SMS status 

(Successful – the DLR status is Sent, Attempts – any message sending 
attempts, Delivered – the DLR status is Delivered), select the time period 

and start date, and click .  

 
Fig. 44 Message limits 

• Open product rates in Rate editor: opens the SMS\Rates\Rate editor page.  

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to delete the selected 
record. 

5.6 SMS channels 

SMS channels represent physical connections between carriers used for SMS 
transmission and receipt (analogue to “Bind” in SMPP). All created channels are 

automatically mirrored to the switch if all the necessary parameters are specified 
in the System Settings\SMS module. 

The SMS channels page contains information on the channels registered in the 
System. 

 
Fig. 45 SMS channels 

Use text masks or drop-down lists under the column headers to filter the records 
in the table. 

The right panel contains the Add and Edit menus. The Add menu contains the 
following fields.  



 
 

  

 

 
Fig. 46 Add menu, General 

General:  

• Carrier: select a carrier to which a channel is associated from the drop-
down list 

• Direction: select a direction from the drop-down list (Client/Vendor, Client 
or Vendor) 

• Channel bind type: possible values: TX (transmit), RX (receive), TR 
(transmit/receive – recommended for interconnection with vendors), Auto 

(as specified by the party establishing connection, recommended for 

interconnection with clients) 
• Enabled: identifies channel activity. A channel can be temporarily disabled 

for a number of reasons, for example, for error correction purposes 
• Channel name: arbitrary name defined by the user (this name is displayed 

in Reports and Analytics) 
• Use optional field for receipt: check to use the optional fields Message ID 

and Message State in the delivery report (delivery to clients) 
• Log level: the log level for the channel. Valid values include: 0 – log 

disabled; 1 – log enabled. NOTE: The parameter is currently inactive  



 
 

  

 

  
Fig. 47 Add menu, Connection 

Connection:  

• Channel type: SMPP or HTTP 
• If SMPP is selected, the following fields are active:  

- Host name: DNS name (for vendor channels only) or IP address for 
sending bind requests. The use of multiple IP addresses in a single 

channel is not supported; however, a subnet mask can be used, e.g. 
1.2.3.4/24 (for client channels only) 

- Port: port for sending bind requests to (relevant for vendor SMPP 
channels only). For client channels, the port used on the client side is 

irrelevant. The default port the client must specify on their switch for 
interconnection with the System is 2875 for SMPP channels and 8001 for 

HTTP channels  

- System type: optional parameter used for authentication during 
binding. It categorizes the type of ESME that is binding to the SMSC; e.g. 

“VMS” (voice mail System) or “OTA” (over-the-air activation System) 
• If HTTP is selected, the following field is active:  

- URL template: specify the IP address and port instead of the 
<localhost:8000> in the template string (for vendor channels only). For 

client HTTP channels, no URL template is needed. The client must comply 
with the following URL format 

http://localhost:8000/api?ani=$ani$&dnis=$dnis$&username=$username
$&password=$password$&message=$text$&command=submit&serviceTy

pe=$serviceType$ (replace <localhost> with the System‟s switch IP 
address and <8000> with 8001) 

http://localhost:8000/api?ani=$ani$&dnis=$dnis$&username=$username$&password=$password$&message=$text$&command=submit&serviceType=$serviceType$
http://localhost:8000/api?ani=$ani$&dnis=$dnis$&username=$username$&password=$password$&message=$text$&command=submit&serviceType=$serviceType$
http://localhost:8000/api?ani=$ani$&dnis=$dnis$&username=$username$&password=$password$&message=$text$&command=submit&serviceType=$serviceType$


 
 

  

 

• Login and Password: user name and password to be indicated in each bind 

request for authentication purposes 
• SSL type: select the version of the SSL protocol (relevant for client 

channels only) 
• Timeout: submit_sm response timeout (for vendor channels). When the 

timout expires, the SMS is switched to the next route.    
• Local address: enter the local IP address of the System‟s switch that will be 

used to connect to the vendor (in case several network interfaces on the 
switch server are employed)  

• No. of connections: (relevant for the new beta version of the switch only) 
the number of binds established with vendors using the same credentials 

(login, password, IP address and port). This parameter comes instrumental 
when connecting to vendors that have limited throughput capacity per bind. 

The load is distributed between the binds in a round-robin pattern. For 
single-server versions of the System, the issue can be resolved only by 

creating several channels. NOTE: for client channels, the number of 

interconnections with the same credentials is unlimited both in the cluster 
and single-server versions 

  
Fig. 48 Add menu, HTTP API status request 

HTTP API status request: the section defines the status request parameters of 
HTTP SMS to the vendor. NOTE: translation of SMS statuses from the vendor‟s 

format to that of SMPP clients is done based on an intrinsic correlation table 
(configured by the Alaris support team).  

• Status template: URL used for getting the SMS status (for outgoing 

channels only; must be provided by the vendor). NOTE: for incoming 
connections leave the field blank and provide the client with the following 

status template string: 
http://1.2.3.4:8001/api?&username=$username$&password=$password$&

command=query&serviceType=$serviceType$&messageId=$messageId$ 
(the client must replace 1.2.3.4 with the System's IP address; the port is 

normally 8001 but if necessary check it with the Alaris support team)  
• SMS status request period: period (in seconds) for the initial request of the 

SMS status. The next status request will be sent in X to the power of N 
(seconds), where X is the SMS status request period, and N the attempt 

number. For example, if X is 3 seconds, the second attempt will be initiated 
in 32, (that is, 9) seconds, the third attempt in 33 (27) seconds etc.  

• No. of SMS status requests: maximum number of SMS status requests. 
NOTE: As the SMS status request period becomes longer with every 

subsequent request, it is recommended that the values of the parameters 

http://1.2.3.4:8001/api?&username=$username$&password=$password$&command=query&serviceType=$serviceType$&messageId=$messageId$
http://1.2.3.4:8001/api?&username=$username$&password=$password$&command=query&serviceType=$serviceType$&messageId=$messageId$


 
 

  

 

No. of SMS status requests and No. of SMS status requests are in 

correlation with each other. The maximum SMS status request period is 24 
hours; messages with a period longer than that will not be sent   

• Final SMS status: SMS status the receipt of which will stop further status 
requests. Several |-separated statuses can be indicated. NOTE: Standard 

SMPP 3.4 statuses (DELIVRD, REJECTD) must be used here. If the vendor 
sends custom statuses, the switch must be configured to translate them to 

the standard format  

 
Fig. 49 Add menu, Message parameters 

Message parameters (set the parameters of the bind): 

• addrTON: the type of sender ID. Select Alphanumeric (5) if planning to 
transfer messages from alpha senders; select Unknown (0) if only 

messages from numeric senders will be transmitted 
• addrNPI: defines the Numeric Plan Indicator (NPI) to be used in the SMS 

address parameters. Possible values: Unknown, ISDN (E163/E164), Data 
(X.121), Telex (F.69), Land Mobile (E.212), National, Private, ERMES, 

Internet (IP), WAP Client ID. The default value is Unknown and normally 

there is no need to change it 
• addrRange: optional parameter used to specify a set of SME addresses 

serviced by the ESME client. A single SME address may also be specified. 
UNIX Regular Expression notation should be used to specify a range of 

addresses. Messages addressed to any destination in this range shall be 
routed to the ESME 



 
 

  

 

 
Fig. 50 Add menu, Limitations 

Limitations:  
• Client capacity (sms/sec): allowed number of SMS per second for client. 

When exceeded, and if the value of the parameter Client overflow buffer 
size is not set, SMS messages are rejected 

• Client overflow buffer size: allowed number of SMS in the storage buffer. In 

case when the Client capacity is exceeded, all new incoming SMS are 
stored in a buffer. If the buffer is overflowed, all the following SMS are 

rejected 
• Vendor capacity (sms/sec): allowed number of SMS per second for vendor. 

When exceeded, and if the value of the parameter Vendor overflow buffer 
size is not set, SMS messages are rejected 

• Vendor overflow buffer size: allowed number of SMS in the storage buffer. 
In case the Vendor capacity is exceeded, all new outgoing SMS are stored 

in a buffer, to be sent when the load on the vendor channel is back to 
normal. If the buffer is overflowed, all the following SMS are routed to the 

next-in-line vendor  
• Vendor window size: allowed number of pending messages awaiting the 

vendor‟s response (submit_sm packets without submit_sm_resp received). 
If, for example, the value of Vendor window size is 10, the System will not 

send the eleventh message, pending receipt of at least one 

submit_sm_response message from vendor side. NOTE: if the vendor has a 
large number of pending messages awaiting response, sending traffic to the 

vendor is unreasonable. Once the Vendor window size is reached, the 
System stops sending traffic to the vendor until the number of pending 

messages decreases   
• Data coding translation: encoding of SMS texts. Possible values include:  



 
 

  

 

- Bypass specific data codings – the System will only send messages in 

encodings selected in the parameter Allowed data coding list as described 
below. Messages with deselected encodings are either directed to other 

vendors or rejected if no further vendor routes are available 
- Only for lossless translation to GSM 7-bit: messages are sent through 

the channel only if all symbols can be translated to ASCII. If the message 
has any Unicode symbols, it will be forwarded to the next-in-line channel  

- Force translation to GSM 7-bit: any Unicode symbols are replaced with ? 
• Allowed data coding list: SMS encodings used in the Bypass specific data 

codings parameter. Deselect the encodings that must not be sent through 
the channel 

 
Fig. 51 Add menu, Resends and Rerouting 

Resends: this group of parameters defines how to resend SMS if the vendor bind 
is down, or if the bind responds with a code suitable for rerouting. The codes are 

set in the internal configuration of the router and can be changed by the Alaris 
support team if necessary:     

• No. of resends: the number of resend attempts. Once the number of 
attempts is reached, the System will go to the next-in-line vendor  

• Resend interval: the interval between resend attempts in seconds 
Rerouting:  

• Reroute statuses: select delivery statuses for rerouting of SMS. If the 
vendor returns one of the selected statuses, the System will send the SMS 

through the next-in-line vendor  

Click the  button to create a duplicate of the configured channel. This is 
helpful in configuring another channel with similar parameters. When through 

with defining the parameters, click  to confirm or  to discard the 

settings. Click  to delete the selected record. 

5.7 SMS POI 

An SMS POI (point of interconnection) is a logical entity that links a channel to a 

product. It allows differentiation between service quality levels for billing 
purposes - for example, when a single channel is used to send traffic for two 

products with different SLA. One channel may be linked to a number of different 
POIs with varying Service type parameter, which is an alphanumeric value set by 



 
 

  

 

the user similar to the technical prefix used for the same purposes in voice 

billing.   
The SMS POI page holds all the information on the POIs registered in the 

System. 

 
Fig. 52 SMS POI 

Use text masks or drop-down lists under the column headers to filter the records 

in the table. 



 
 

  

 

 
Fig. 53 Add menu 

The right panel contains the Add and Edit menus that allow adding new records 
or editing existing ones. To activate the Edit menu, click on the record in the 

table. Enter the required parameters in the corresponding fields. Fields marked 
with an asterisk (*) are required. The Add menu contains the following 

parameters:  
• Carrier: carrier to which a POI is associated 

• Product: product to which a POI is associated 
• Active from / Active till: date and time of POI activation/deactivation 

• SMS channel: channel the POI is linked to 
• Service type: reference to the service quality level, which is an arbitrary 

parameter defined by the user (must contain less than 6 symbols to match 
the SMPP 3.4 requirements). Normally, this field is left blank 

• ANI translation mode: sender ID transformation mode. Possible values are:  

- No translation: no translation takes place 



 
 

  

 

- Load from list: A-numbers are taken from a file previously uploaded to 

the server. NOTE: The SMS router looks for such a file in the location 
specified in the randomAniFilename attribute of its configuration file. The 

file must be located on the same server where the SMS router is installed. 
The file must contain a list of numbers, which will be taken consequently 

as A-numbers in outgoing messages. To check which numbers are 
currently being used, go to the SMS router main log file and look for the 

following records: RRH;;run() MLs 1,2411 secs (181/4 rq, RP5; 
0,1/3,2/0,0, FAIL: 0/0(0,0%/0,0%)), rndAniCnt 0/5000000. The 

rndAniCnt 0/5000000 indicates how many A-numbers are used out of the 
total number of records in the file. When all records are used the file 

usage is started from the beginning of the file 
- Auto generate: outgoing A-numbers are generated according to a 

specified pattern. The expression in the pattern must meet the Python 
programming language syntax requirements. If the expression contains 

syntax errors, no A-number translation takes place. To check if the 

expression is correct and view the result of the expression translation, go 
to the SMS router shell and use shpoi id in the SMS router CLI interface. If 

the expression is syntactically correct, then the CLI output will indicate 
cmpld, if not, the output will diplay INVLD.  

• Buffer size: allowed number of messages in the storage buffer (for client 
products only). The buffer size is defined separately for each POI. When the 

buffer is full all new incoming messages are rejected. When defining buffer 
size values, keep in mind that each POI has its own separate buffer taking 

additional RAM memory; 1Gb of RAM can hold approximately 300,000 
messages in a buffer 

• Buffer drain speed limit (sms/sec): speed at which messages are passed 
over from the buffer to the routing module for delivery. NOTE: the actual 

speed of SMS passthrough is also limited by other factors and parameters: 
- the passthrough speed is not greater than half of the available capacity 

of the switch (available switch capacity = total estimated capacity, which 

is calculated by the switch every second MINUS current load of the 
switch). The estimated capacity limit is higher in priority than the limits 

defined at the POI level 
- limitation of the outgoing SMS speed defined for outgoing vendor 

channels that were chosen by the routing module for SMS delivery 
• Force buffering mode: all incoming messages are buffered for later delivery. 

When this flag is unchecked, the system operates according to the Buffer 
mode schedule. NOTE: If the buffer is full, all incoming messages are 

rejected 
• Buffer mode schedule: defines the logic of dealing with incoming SMS 

messages based on day of week and hour of day. Two variants are 
possible: 

- Buffering mode: incoming messages are not sent further, but stored in 
the internal buffer for later delivery 



 
 

  

 

- Passthrough mode: incoming messages are passed over to routing 

logics for delivery. Select the appropriate mode and click on the schedule 
to fill it  

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to delete the selected record. 

6. Finance 
All financial aspects associated with the carrier business are covered within the 
Finance section accessible from the Start menu. The System offers differentiated 

access to all financial data providing the System owner with a balanced coverage 
of financial status for each separate partner, account or product. The Finance 

section contains the following pages: Charges, Invoices, Payments and Recurring 

fees. 

6.1 Charges 

A charge is the amount charged by the System for a specific partner product for 
a single billing period. Charges serve as the basis for generating invoices. The 

Finance\Charges page contains information on charges generated by the System. 
It has three panels: the Charge filter, the Charges table and the Charge details.  

 
Fig. 54 Charges table 

The Charges table displays the following information: 

• ID: internal identification number 
• Charge type: generated automatically or manually 

• Contract company: the legal entity of the System owner on behalf of which 
it works with the carrier 

• Carrier 
• Account: account for which the charge is generated  

• Product type: here: SMS (as configured on the Reference books\Product 

types page) 
• Charge direction: Payable or Receivable 

• Confirmed: shows whether the charge is confirmed on the Finance\Invoices 
page (Yes or No) 

• Group index: the value of the Group index parameter in the 
Carriers\Products page (products having the same index will be invoiced in 

a single file)  



 
 

  

 

• Volume: volume of the provided services (here: in SMSs) 

• Units: measurement units (here: SMSs) 
• Service count: number of messages 

• Amount: the charge amount. Click on the link to open the Charge details 
table at the bottom of the page 

• System period: charged period, displayed in the System owner‟s time zone 
• Partner period: charged period, displayed in the partner‟s time zone  

• Correction ID: identifier of the charge, for which this one is correctional (if 
this charge corrects a previous one) 

• Version: version of the correction 
• Last update: date and time of the latest calculation 

The Amount currency drop-down list at the top of the table opens the list of 
currencies in which the charge can be displayed. By default the data is shown in 

the account currency. Other currencies are configured in the parameters Finance 
first (second, third) currency in Administration\System settings\Financial module. 

When all these parameters are empty, the Amount currency drop-down list is not 

displayed. NOTE: The invoice and charge data is stored in financial cubes (for 
more detail on cubes, see Reports\Analytical cube status (Administration)). After 

you configure the currencies in Finance first (second, third) currency, perform 
EDR rerating (see SMS\EDR management\EDR Rerating) and invoice 

recalculation (see Finance\Invoices\Editing invoices) for the appropriate period, 
otherwise all amounts in the Charges table will be zero.  

The amounts are calculated at the exchange rate as of the date of each charge. 
For example, the charge dated October, 12 will be calculated at the exchange 

rate as of October, 12. The exchange rates are taken from the Reference 
books\Currency exchange rates.     

The  button in the upper left corner of the page toggles the Charge filter menu. 

 
Fig. 55 Charge filter 

Enter the appropriate parameters and click  to filter the records in the 

Charges table. The  button opens the list of carriers that can be filtered by 
carrier name and region. 

Click the  button on the lower tool bar of the Charges table to refresh the table. 



 
 

  

 

Select a record in the Charges table and click the  button for 

recalculation of the selected charge. Click  if you wish to delete the 
selected charge. 

The  button opens the Create charge detail window for adding a 
new charge manually. This form comes instrumental in manual creation of a new 

credit note or additional invoice – for example, when settling a dispute. For more 
detail on credit notes, see Finance\Invoices\How it works.  

  
Fig. 56 Create charge detail  

If the charge for this account with the same direction, product type and group 

index already exists, a newly created charge is added to the existing one. The 
Create charge detail form contains the following parameters:  

• Charge direction: Payable or Receivable 
• Account: account for which the charge is generated  

• Product type  
• Group index: index of the charge grouping 

• Start date, End date: charged period. NOTE: The charged period is set in 

full days  
• МСС: Mobile Country Code 

• МNС: Mobile Network Code 
• Network: name of the network 

• Country: name of the country 



 
 

  

 

• SMS sent: number of sent SMS  

• Rate: price per SMS 
• Charged amount: total amount of the charge is calculated automatically as 

a derivative of (SMS sent) * (Rate). Click  to recalculate the amount if 
the values of the SMS sent or Rate parameters have been changed. The 

amount can also be entered manually 
• Create/update invoices: if this checkbox is selected, the System creates an 

invoice for the charge or updates the invoice if it already exists. If the 
checkbox is deselected, the invoice amount will remain the same even if 

the charge for it is updated  

Click  to confirm or  to discard the settings. 

NOTE: For easier handling of correctional charges – that is, charges created to 
correct the partner balance - it is recommended to use a dedicated value in the 

Product type field. Go to Reference books\Product types, create a product type 
Correction, and in the Unit field select Service. When adding a correctional 

charge in the Create charge detail form, select Service in the Product type field. 
In this case, the MCCMNC, Network and Country fields will be hidden.  

 
Fig. 57 Add menu in Reference books/Product type  

Clink on the link in the Amount column to open the Charge details table at the 

bottom of the page. 

 
Fig. 58 Charge details 

The table displays details of the selected charge: MCC and MNC codes, network 
name, country, number of sent messages, rate and charged amount. 



 
 

  

 

6.2 Invoices 

The Finance/Invoices page is a toolkit for reviewing and sending invoices to 
clients as well as generating vendor associated invoices for verification purposes.  

Invoice generation is fully automated. The System collects the billing data from 
incoming EDRs into a dedicated data pool continuously updated at the rate of 

EDR arrival, which is set at the time of System installation. This data pool 
constitutes the backbone of all further analytical processes carried out by the 

System and forms the basis for billing procedures. When the current billing 

period (defined by the partner agreement) is over, the System has access to all 
the processed statistics necessary for generating a new invoice. At this point it 

only needs a few seconds to create the invoice file, which then can be reviewed 
by the user before sending.  

6.2.1 How it works 

By default all invoices, created automatically or manually (in the Finance\Charges 

page), have the Draft status and are never auto-sent to clients. Each invoice can 
be reviewed and edited if needed and is dispatched only after confirmation 

(  button on the tool bar at the bottom of the Invoices table). It is 

possible to configure automatic dispatch of invoices – use the parameter Invoice 
auto-dispatch delay, hours in Administration\System settings\Financial module. 

All invoices automatically generated by the System are created a few hours after 
the end of each billing period (the billing period is defined in 

Carriers\Agreements). NOTE: The delay for invoice creation is configured by the 
parameter Invoice generation delay, hours in Administration\System 

settings\Financial module. The billing period and delays are configured in the 

partner time zone (defined in Carriers\Agreements). To avoid confusion, it is 
recommended to use GMT both as the System owner and partner time zones.  

Apart from invoices, a user can issue another type of financial document - a 
credit note. A credit note is a type of invoice that is used to correct the partner 

balance and can be instrumental in case of disputes. When amount correction in 
the client‟s favor is needed after the invoice has been received, a credit note can 

cover the required amount by increasing the client‟s balance. In a vendor-
associated case, a credit note stands for the amount to be compensated to the 

System owner by reducing the vendor‟s balance. To issue a credit note, create a 
charge with a negative amount, and the credit note will be generated 

automatically (if the Create/update invoice checkbox is selected in the Create 
charge detail dialog of the Finance\Charges page).    

Confirmed invoices are delivered to preset email addresses. The default address 
is set in Carriers\Agreements (optional parameter Default invoice emails). Invoice 

copies can also be sent to other recipients defined in Administration\System 
settings\Financial module (parameter Email address to CC invoices distribution) 

or to specified System users if the Send invoices flag is set in Carriers\Users (Edit 
menu). 

An invoice comprises two separate files: a PDF file containing general invoice 

information (cover letter) and a MS Excel file with traffic details. Both files can be 
sent out as attachments to a single email, or as two separate emails. The type of 

delivery is set in Carriers\Agreements (parameter Invoice delivery options). A 



 
 

  

 

convenient option is link: the client receives an email with a link to the invoice. 

The System owner will know exactly if the invoice has actually been received 
(opened) by the client. This is the only case when the invoice status is changed 

to Delivered. Please note that some other general billing parameters associated 
with invoice generation, dispatch and payment balances are set in 

Administration\System settings\Financial module and Carriers sections.  

6.2.2 Invoices table 

  
Fig. 59 Invoices table 

The Invoices table contains information on invoices registered in the System. 

Drop-down lists in the column headers allow ascending/descending sorting of the 
records. The Columns list allows hiding/unhiding columns. The table contains 

information on the following parameters: 
• Reference number: actual invoice number, automatically assigned to an 

invoice after its draft is confirmed and the invoice is sent out or configured 
manually; the initial number can be set in Administration\System 

settings\Financial module (parameter Current invoice number) 
• Document type: Invoice to/from partner; Credit note to/from partner 

• Contract company: the legal entity of the System owner on behalf of which 
it works with the carrier  

• Carrier: client/vendor name, as per data in the Carriers section 
• Account: account for which the invoice is generated 

• Status: 
- Draft - status assigned to all generated non-confirmed invoices 

- Sent - status assigned to an invoice after its confirmation and dispatch 

(by the  button) 



 
 

  

 

- Delivered - status assigned to an inbound traffic invoice after it is 

received by the client, in case of link-assisted delivery 
- Registered - status assigned to an invoice after it is confirmed (by the 

 button)  
- Insignificant - status assigned to an invoice with an estimated amount 

lower than defined in Carriers\Agreements (parameter Min invoice 
amount). Such invoices are not sent out for the current billing period, but 

are supplemented to the following period invoice, which in this case 
comprises two separate charges for two successive periods 

- Disputed - status assigned to an invoice challenged by the partner, 

provided that both of the following preset parameters are surpassed: Min 
absolute mismatch to invoke a dispute and Min percent mismatch to 

invoke a dispute defined in Administration\System settings\Financial 
module 

• State: 
- Actual - regular invoices generated according to currently valid billing 

data 
- Outdated - invoices are automatically marked as outdated if any 

relevant changes to underlying billing data are introduced into the System 
retrospectively, for example in case of EDR recalculation. Such outdated 

invoices are subject to recalculation  
• Due amount: actual amount owed against the invoice. The displayed sum is 

equal either to Estimated amount (plus Tax amount if any) or Presented 
amount, depending on the Amount source value (see Edit invoice 

description below) 

• Paid amount: a click on the value in this column opens the Invoice mapping 
page displaying correlation between issued invoices and made payments or 

counter invoices. The value in this column is displayed as a link only for 
registered invoices 

• Unpaid amount – the outstanding amount in the invoice  
• Currency: currency of the invoice 

• Payment status: Payment expected, Paid in full, Partially paid, Not sent, 
Overdue 

• Estimated amount: total amount due based on the System calculation; a 
click on the value opens charge details for each specific invoice; the same 

data constitutes a detailing XLS/XLSX file to be sent to a client; charge 
details can be exported to the XLS/XLSX format 

• Tax amount: tax amount of the invoice. Depends on the parameter Tax 
scheme in the Carriers\Agreements settings: 

- Tax included: the tax is already added to the invoice amount. In this 

case Due amount is equal to Estimated amount 
- Add tax % to estimated amount: tax is calculated according to the 

invoice amount. In this case Due amount = Estimated amount + Tax 
amount 

• Presented amount: total amount due according to partner estimation, if 
available; the value is introduced manually as Presented amount in the Edit 

invoice menu. A difference between Estimated and Presented amount, if 



 
 

  

 

any and if unfavorable for the System user, changes the invoice status to 

Disputed provided it is greater than the value of either parameter: Min 
absolute mismatch to invoke a dispute or Min percent mismatch to invoke a 

dispute, whichever is higher 
• Period from / Period to: start/end date of the invoiced period 

• Issue date: date of the invoice issue 
• Reg date: date on which the invoice was confirmed  

• Invoice last updated: date and time of the latest update of the invoice 
• File: a click on the download link opens the PDF file of the invoice (only the 

cover letter; the traffic details file can be downloaded by clicking  on 
the toolbar at the bottom of the table) 

• Invoice last updated: date and time of the latest update of the invoice 

6.2.3 Invoice mapping 

Invoice mapping is allocation of payments and invoices to one another (for 
example, payments to counter payments, payments to invoices, invoices to 

counter invoices etc.) It can be done automatically or manually. Automatic 
mapping is configured on the Finance/Payments page (the Make auto mapping 

checkbox in the Edit payment form). NOTE: When automapping is enabled, the 

System allocates the received payments to cover the oldest invoices first. For 
manual mapping, click on the link in the Paid amount column to open the Invoice 

mapping page. 

 
Fig. 60 Invoice mapping page 

The  button on the tool bar at the bottom of the Invoice mapping 
page allows adding unmapped documents to the profile by specifying the 

document and choosing between listed amount options. Fields marked with an 
asterisk (*) are required.  

 
Fig. 61 Map document 



 
 

  

 

• Non-mapped document: drop-down list of available invoices. The list is 

formed automatically and displays the amount available for distribution for 
every charge or invoice (in case unallocated financial documents from a 

partner are registered in the System) 
• Map full invoice amount: is active only if the invoice is totally covered by 

selected payment or by counter invoice 
• Map full document amount: if the payment amount is less than the amount 

of the invoice, the payment can be used to partially cover the invoice 
• Specify amount to map: manually specify the payment amount or counter 

invoice to cover the selected invoice 

Click  to apply the settings.  

6.2.4 Editing invoices 

Double-click on any value in the Invoices table (except the links) to open the Edit 

invoice menu. The same menu can be opened by the  button on the 
tool bar at the bottom of the table. 



 
 

  

 

 
Fig. 62 Edit invoice menu 

The menu contains the following parameters:  
• Reference number 

• Amount source: select Amount presented by partner or System owner 
estimated amount + tax to choose which amount is considered correct - 

Estimated (calculated by the System) or Presented (provided by the 
partner) 

• Disputed amount: difference between Due amount and Presented amount. 
If Amount source is set as Amount presented by partner, then Due amount 

becomes equal to Presented amount, and the Disputed amount is null  
• Begin date / End date: invoiced period 

• Due date: payment due date 



 
 

  

 

• Notes: arbitrary comments 

• Make auto mapping: enables automatic synchronization of a registered 
payment with the relevant carrier/account invoicing and payment profile. 

When the checkbox is selected, the System allocates the payments to cover 
the oldest invoices prior to recent ones 

Enter the appropriate parameters and click  to apply the settings. Click the 

 button to confirm the invoice draft. The invoice status will 

change from Draft to Registered. 

 
Fig. 63 Invoice filter 

The  button in the upper left corner of the Invoices page toggles the Invoice 

filter menu. 

Enter the appropriate parameters and click  to filter the records in the 

Invoices table. The  button in the Carrier field opens the list of carriers that can 
be filtered by ID, region or carrier name. 

The  button in the upper right corner of the Invoices page opens 
the Recalculate period menu, which allows recalculation of all invoices for the 

specified period, for example in case of billing period readjustments, outdated 
invoices etc. NOTE: Recalculation of invoices must be done after EDR rerating to 

bring the invoicing information up to date. Refer to SMS\EDR management\EDR 
Rerating for more detail.  



 
 

  

 

 
Fig. 64 Recalculate period 

Enter the appropriate parameters in the menu and click  to recalculate 

the selected invoice: 
• Direction: traffic direction (Client, Vendor or All) 

• Account: select the account from the drop-down list. The  button opens 
the list of accounts that can be filtered by account name or carrier region 

• Start date: first date of the revised period 

• End date: last date of the revised period 
• Keep confirmed invoices: deselect the checkbox to re-create confirmed 

invoices (all invoices will be deleted and created again with the Draft 
status) 

 
Fig. 65 Close billing period and generate invoice 

The button  in the upper right corner of the Invoices 

page serves to generate an invoice for a billing period that is still open. The date 

specified in the Issue date parameter will become the last day of the closed 
billing period. The next auto-generated invoice will cover the remaining days of 

the preset billing period, its end date becoming the last day of the period. NOTE: 
Do not use this button to generate invoices for a completed billing period, when 

such invoices have not yet been created automatically (this normally happens 
when rates are imported retrospectively)   

Enter the appropriate parameters in the menu: 
• Invoice direction: to/from partner 

• Carrier: select the carrier from the drop-down list. The  button opens the 

list of carriers that can be filtered by ID, region or carrier name 
• Account: select the account from the drop-down list 

• Issue date: date of the invoice generation 



 
 

  

 

Click  to generate the invoice. The invoice will appear in the table 

with the Draft status. Click  on the bottom tool bar if you wish to 

confirm the selected invoice draft and send it to the partner (the invoice will be 
automatically sent to the e-mail defined in the Carriers\Agreements settings). 

Click  to confirm the invoice without sending (for example, in 
case of backdate corrections).  

Click  to recalculate the selected invoice draft (for example, when a 
partner performed backdate changes in the billing data).  

Click  to resend the invoice to the partner.  

The button  opens the invoice download menu that allows downloading the 

cover letter, traffic details or both. 

 
Fig. 66 Invoice download details 

The download queue is displayed in the Invoice files downloading list that can 
also be opened by the  button in the bottom right corner of the page. 

 
Fig. 67 Invoice files downloading list 

Click  to export the Invoices table to a MS Excel file.  

6.3 Payments 

The Finance\Payments page serves to track incoming and outgoing payments. 

The Invoice/payment mapping feature allows automatic matching of registered 
payments against issued invoices. Payments are entered (registered) to the 

System manually.  

6.3.1 Payments table 

The Payments table displays information about all payments registered in the 
System. 

 
Fig. 68 Payments table 

Click on the column headers for ascending/descending sorting of the records. Use 
the Columns list to hide/unhide columns. The table contains information on the 

following parameters: 



 
 

  

 

• Contract company 

• Bank account: the System owner's bank account number as configured in 
Reference books\Bank accounts  

• Carrier: client/vendor name, as per data in the Carriers section 
• Account: the partner account name and currency  

• Payment date: the actual payment date 
• Expiry date: for payments in the Draft status. Upon registration of 

payments (including those in the Draft status) the balance is immediately 
updated. In case when a payment is not registered before the Expiry date, 

it becomes ignored. In other words, a Draft is considered a regular 
payment only until the Expiry date. NOTE: This can happen when a partner 

informed the System owner that a payment has been made, but the actual 
money has not arrived yet. The partner can be notified in advance about 

the expiry of a draft payment. The notifications are set in the parameter 
Send notifications of deferred payments coming due to client; the period is 

set in Notification period of deferred payments coming due, days 

(Administration\System settings\Financial module). The email addresses 
are set in Carriers\Agreements (Default invoice emails field)  

• Registration date: date of the payment registration in the System 
• Ref.#: internal System reference number of the payment record 

• Direction: Inbound or Outbound 
• Bank statement amount: payment amount against the bank statement (the 

amount actually paid by the partner, before bank charges) 
• Amount debited: the sum posted to the account (balance) after bank 

charges 
• Bank fee: bank activity charges, calculated as difference in absolute value 

between Bank statement and Amount debited 
• Covered amount: underlying invoice amount covered by the payment; may 

be partial or full. A click on the value opens payment mapping profile 
displaying correlation between payments made and invoices issued (see 

Finance\Payments\Payment mapping) 

• Status: (Draft, Registered): a payment record may be saved in the System 
as a draft, for example if the actual payment from the client has not been 

received but the customer claims it has already been executed – such a 
record acquires the registered status only after additional confirmation and 

submission to the System. Draft payments have temporary impact on 
partner balance (until the Expiry date). Registered payments have a 

permanent impact on the partner balance 
• Document: underlying document 

• Comment: arbitrary comments 
The  button in the upper left corner of the Payments page toggles the Payments 

filter menu. 



 
 

  

 

 
Fig. 69 Payments filter 

Enter the appropriate parameters in the menu and click  to filter the 
records in the Payments table. The  button in the Carrier field opens the list of 

carriers that can be filtered by ID, region or carrier name. 

6.3.2 Payment mapping 

A click on the Covered amount column values opens the payment mapping page 
displaying correlation between payments made and invoices issued. The page is 

similar to the Finance\Invoices\Invoice mapping page detailed above. Mapping 
can be done on either page.  

 
Fig. 70 Payment mapping page 

The  button at the bottom of the Payment mapping page allows 
adding unmapped documents to the profile by specifying the document and 

choosing between listed amount options: 

 
Fig. 71 Payment mapping 

6.3.3 Interface controls  

The Finance\Payments page has the following controls.  



 
 

  

 

The  button opens the same-name menu: 

 
Fig. 72 Synchronize balances 

The menu enables synchronization with external accounting systems through 
uploading data. It requires CSV files separated with semicolon (;) with the 

following fields:      
• Carrier name: string of 256 characters maximum (must coincide with the 

carrier name in the System) 
• Currency: string of 256 characters maximum, e.g. USD, EUR  

• Balance value: balance amount; decimal separator dot (.) can be used 
• Balance effective date: submitted in the format DD MM YYYY HH24 MI SS 

The  button launches automatic allocation of payments to invoices 

for selected accounts: 

 
Fig. 73 Make auto mapping 

The  button opens the same-name menu: 

 
Fig. 74 Import payments 

The menu allows import of external payment records; it requires CSV-format files 

separated with semicolon (;) with the following fields: 



 
 

  

 

• Carrier name: string of 256 characters maximum (must fully coincide with 

the carrier's name in the System) 
• Payment direction: „0‟ or „inbound‟ for payments from client; „1‟ or 

„outbound‟ for payments to vendor  
• Payment date: submitted in format DD MM YYYY HH24 MI SS 

• Payment reference number: string of 256 characters maximum 
• Payment amount: payment amount, decimal separator “.” (dot) can be 

used 
• Payment currency: currency code, e.g. USD or EUR 

• Payment comments: string of 4000 characters maximum 
• Account ID: the Account ID from the Carriers\Accounts table (the field is 

required for partners having more than one account in the same currency) 
A payment is associated to a carrier by the name and account currency. 

Therefore, carriers that have more than one account in the same currency should 
not use the Import payments feature.  

The  button opens the Payment registration menu:  

  
Fig. 75 Payment registration 

• The menu allows manual creation of payment records by configuring the 

following parameters:Reference number: payment ID from the payment 
service provider  

• Payment direction: incoming (From partner) or outgoing (To partner) 



 
 

  

 

• Carrier: relevant client/vendor, as per data in the Carriers  section. The  

button opens the list of carriers that can be filtered by ID, region or carrier 
name 

• Account: relevant account, as per data in Carriers\Accounts 
• Contract company  

• Bank account: the bank account number from Reference books\Bank 
accounts  

• Payment date: date of actual payment execution 
• Bank statement amount: payment amount against the bank statement (the 

amount actually paid by the partner, before bank charges). Select currency 
in the drop-down list next to the field 

• Amount debited: the sum posted to the account (balance) after bank 
charges 

• Expiry date: the expiration date of payments with the Draft status. If the 
payment status is not changed to Registered by the date (that is, the 

actual payment is not received and acknowledged), the amount will be 

written off the partner's balance. NOTE: This field only makes sense when 
the Registered checkbox is deselected  

• Comment: arbitrary comments to payment 
• Confirming document: underlying document 

• Registered payment: if the checkbox is selected, the payment gets 
registered immediately. The selected checkbox shows that this payment is 

not a Draft and has no Expiry date 
• Make auto mapping: enables automatic synchronization of a registered 

payment with the relevant carrier/account invoicing and payment profile. 
When the checkbox is selected, the System allocates the payments to cover 

the oldest invoices prior to recent ones 
NOTE: The currency exchange rate is taken as of the payment date.  

When through with defining the parameters, click  to confirm or  to 
discard the settings. 

The  button creates a duplicate of the configured payment. This is 
helpful when configuring another payment with similar parameters.  
Click  to refresh the page.  

The button  allows payment confirmation and 

registration in the System. 

The button  deletes the selected payment record. 

Any payment record can be exported either to an CSV or XLS-file using the 

buttons  and  respectively. 

6.4 Recurring fees 

The Finance\Recurring fees page serves to configure regular charges to partners 

for continuous services other than SMS exchange – for example, server or data 

channel rental. The page contains a table of recurring fees and the Add and Edit 
menus.  



 
 

  

 

 
Fig. 76 Recurring fees table 

NOTE: For easier handling of recurring payments it is recommended to create a 
dedicated product type. Go to Reference books\Product types, create a new 

product type (for example, Server rental), and in the Unit field select Service.  

 
Fig. 77 Add menu 

The Add menu of the Recurring fees page contains the following parameters.  

• Details: payment description 
• Confirm invoice: when the checkbox is selected, invoices are confirmed 

automatically 
• Direction: Vendor or Client 

• Product type: select a product type specifically created for this service  
• Invoice group index: specify a unique value if you want this charge to be 

invoiced separately. To invoice this charge together with another product, 
select the index of that product. If Autovalue is checked, the grouping is 

performed as set in the parameter Default charge grouping mode (for 
possible values refer to Administration\System settings\Financial module) 

• Rate: service price 
• Volume: volume of the services (in units configured in Reference 

books\Product types) 
• Account: partner account 

• Start date, End date: billing period. For example, if the billing period is 1 

month, the service will be charged for monthly. The next billing period is 
shown in the Recurring fees table in the Next start date and Next end date 

columns  



 
 

  

 

• Create charge at: end of the period or beginning of the period 

Click  to save the changes.  

7. Reference books 

7.1 Bank accounts 

The Reference Books\Bank accounts page contains information about the System 
owner's bank accounts that are used to create agreements with partners (see 

Carriers\Agreements) and payments (see Finance\Payments).  
To create a new bank account record, use the Add menu as illustrated below.  

 
Fig. 78 Add menu 

7.2 Caller ID tags  

Caller ID tags are marks assigned to a caller ID or it mask. They serve to 
configure routing by A-number (Sender ID). This can come handy in blocking 

undesirable traffic from a specific number, on-net routing etc.  

The Reference Books\Caller ID tags page contains a table of caller ID tags and 
the Add and Edit menus. 

 
Fig. 79 Caller ID tags table 

To create a new tag, use the Add menu as illustrated below.  



 
 

  

 

 
Fig. 80 Add menu 

The menu contains the following parameters:  
• Type: the tag type  

• Tag: the tag name. To create a new tag name, expand the drop-down list, 

type the name in the edit field and click the  button.  

• Dial code: the dial code (use % as a wildcard if necessary) 

• Description: arbitrary comments  

Click  to save the changes.  

7.3 Contract companies 

The Reference Books\Contract companies page serves to configure the legal 

entities of the System owner, on behalf of which it works with its partners. A 
contract company encompasses a set of templates and properties used for doing 

business with a partner.  
The page contains a table of contract companies and the Add and Edit menus. 

 
Fig. 81 Table of contract companies 

To create a new record, use the Add menu as illustrated below.  



 
 

  

 

 
Fig. 82 Add menu 

The menu contains the following parameters:  

• Contract company: the name of the legal entity 
• Invoice filename pattern: the filename pattern of the invoice cover sheet 

• Invoice details filename pattern: the filename pattern of the invoice traffic 
details file 

• Invoice reference number format 
• Current invoice number 

• Email address to CC invoices distribution 
• Alaris Selfcare URL: link to Alaris retail portal 

• Alaris Customer Portal URL 
• Paypal account 

• Paypal URL  

When necessary, use markers in the above parameters. Markers are 
alphanumeric strings in square brackets that serve as placeholders of information 

used in documents. For the list of markers supported by the System, see 
Administration\System settings\Template manager\Markers. NOTE: Prior to 

inserting markers in the Add menu fields, check that they are configured in  
System settings\Financial module (Invoice reference number format parameter) 

and Administration\System settings\Template manager. 

Click  to save the changes.  



 
 

  

 

7.4 Currency exchange rates 

The System supports multi-currency billing based on exchange rates to translate 
different currencies to the System currency. The Reference Books\Currency 

exchange rates page serves to manage the currencies used by the System 
owner's partners and keep their exchange rates up-to-date. 

 
Fig. 83 Currency exchange rates 

The page contains the following information: 
• System currency: the actual System currency 

• Existing currencies: other currencies configured in the System  
Click the link with the currency code to open the Editing currency menu: 

 
Fig. 84 Editing currency 

Enter the appropriate parameters in the corresponding fields. Click  to 

confirm or  to discard the settings. Click  to delete the currency. 

The  button opens the Adding new currency menu: 

 
Fig. 85 Adding new currency 

Enter the required parameters in the corresponding fields. Click  to 

confirm or  to discard the settings. 

The bottom of the page contains exchange rates, which can be filtered by the 

currency name or validity period. The  button filters the currencies 

according to values set in the fields Currency, Date from and Date to. 



 
 

  

 

Add or delete the exchange rates using the  and  buttons 

respectively. Recently updated but not saved records are marked in red 

reminding to click the  button before leaving the page. Exchange rates can 
be added, deleted and edited for the present, past and future periods. Exchange 
rate changes for past periods cause statistics recalculation, which is a time and 

resource consuming procedure, especially for huge traffic volumes. 
The exchange rate values are defined as the cost of 1 currency unit in the 

System currency. For example, if the System currency is USD and 1 EUR = 1.4 
USD, the exchange rate for EUR will be 1.4. This tip is opened by clicking the 

 button at the bottom of the page.  

Currency exchange rates can be downloaded automatically. Contact the Alaris 
technical support team for configuration.  

7.5 Product types 

The Reference Books\Product types page contains information on the type of 

products registered in the System. Records highlighted in red are non-editable. 
The page is divided in two sections. The left section is a table of product types. 

The table contains the following information: 

 
Fig. 86 Product types 

• ID: internal identification number 
• Type name: name of the product type 

• Charge description: description of the chargeable services 
• Unit: measurement unit 

The right panel contains the Add and Edit menus.  

 
 

Fig. 87 Add menus 

Enter the above listed parameters in the appropriate fields. When through with 

defining the parameters, click  to confirm or  to discard the 

settings. Click  to delete the selected record. 

7.6 Regions 

The Reference Books\Regions section serves to create lists of regional managers 

and region sets, which are used on the SMS\Analytics page as a statistical layer 



 
 

  

 

component (Client/Vendor Managers, Client/Vendor Region). The section consists 

of three pages – Company region, Country region and Country groups. 

7.6.1 Company region 

The Company region table contains the following information: 
• ID: internal identification number 

• Region name: name of the region 
• Manager: name of the manager responsible for the region 

 
Fig. 88 Company region 

The Add and Edit menus in the upper right corner of the page allow assigning 
managers to regions. To activate the Edit menu, click on the record in the table. 

Enter the parameters in the corresponding fields. Fields marked with an asterisk 
(*) are required. 

 
Fig. 89 Add and Edit menus 

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to delete the selected record. 

7.6.2 Country region 

The Country region table contains the following information: 
• ID: internal identification number 

• Country: name of the country 
• Region: name of the region 



 
 

  

 

 
Fig. 90 Country region 

The Edit menu in the upper right corner allows assigning countries to regions. 

 
Fig. 91 Edit menu 

Click  to confirm or  to discard the settings. 

7.7 Units  

The Reference books\Units page contains information on measurement units 
used in the System. 

The page is divided in two sections: the table of units and the Add/Edit menus. 
The table contains the following information: 

 
Fig. 92 Units 

• ID: internal identification number 

• Unit name: name of the unit 
The Add and Edit menus allow adding new records or editing existing ones. To 

activate the Edit menu, click on the record in the table. Enter the unit name in 

the corresponding field.  



 
 

  

 

 
Fig. 93 Add menu 

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to delete the selected record. 

8. Reports 

8.1 Reports page overview 

The Reports page enables creating custom reports based on any table in the 
System database.  

 
Fig. 94 Reports page 

The System is delivered with a pack of report templates covering most typical 
needs of wholesale carriers. The reports are named according to a pattern: the 

last word in the report name describes the functional area the report pertains to 
(e.g. Reference, Stats, Finance, Administration etc). 

The Reports page allows generating a report based on an existing template and 
contains the following parameters:  

• Categories: the report category  

• Recent runs: shows the reports generated for the past 24 hours, 3 days, 
week, 2 weeks or a month. Use this drop-down list for easy access to 

frequently used reports  
• Reports: select a report from the drop-down list. A submenu with the 

report parameters will open below. Fill in the appropriate parameters  
In the right hand panel check the flag Is recurrent if the report must be created 

regularly. Configure the time table as shown below; select the sender; in the 
Email for report field provide the email to which the reports will be sent and 

select the report file type in the appropriate field. NOTE: The System only sends 
the results of recurrent reports if they are not void.  

Click  to view the schedule of the next 10 runs of the report. Click 

 to save the settings.  



 
 

  

 

 
Fig. 95 Report schedule 

To generate a report, click  at the bottom of the left panel. Click  

or  to export the file to MS Excel or a .CSV file respectively.  

If access to specific data in the System DB is required for creating a report not 

available on the Reports page, contact the Alaris support team for a description 
of the necessary DB tables and/or views. The most frequently used reports are 

described below.  

8.2 SMS Analytical cube status (Administration)  

Analytical cubes are pre-calculated statistical tables based on the OLAP (online 

analytical processing) technology. The System aggregates multi-dimensional data 
for various objects and their combinations. This method allows fast and easy 

retrieval of any type of statistics – for example, for each client the System knows 
to which countries the traffic was sent, to which network in each country, to 

which MCCMNC in each network, to which vendors for each MCCMNC etc. This 
information is collected in minute, hour, day and month increments and is stored 

in analytical cubes. Cube updating is a time consuming process and is therefore 

performed either at the end of a time increment or when an EDR threshold is 
reached (whichever happens first).  

The cube updating parameters are configured in Administration\System 
settings\SMS module section illustrated below.  



 
 

  

 

 
Fig. 96 Cube update parameters 

The following parameters are available:  
• Auto threshold calculation (0 - no, 1 - yes): when the value is 1, the cube 

update thresholds are calculated automatically 
• Stats calculation delay, minutes (day/hour/min/month): the delays 

configured for each time increment (minute, hour, day, week, and month) 
to allow statistics calculation even if the thresholds configured in Stats 

calculation threshold (SMS/Hour, SA) and Stats calculation threshold 
(EDR/day, EDR/hour, EDR/min, EDR/month, EDR/week, MA) have not been 

reached. For example, the value 45 in the parameter Stats calculation 
delay, minutes (day) means that the statistics for a daily cube will be 

calculated on 00:45 on the following day in case the amount of new records 
does not exceed the threshold defined in Stats calculation threshold 

(EDR/day) 

• Stats calculation threshold: the threshold (in EDR/min, MA, EDR/hour, MA, 
EDR/week, MA, EDR/month, MA and SMS/hour, SA). When reached, the 

statistics will be recalculated even if the increment is not yet complete  
NOTE: MA stands for Multi-threaded Analytics and is normally used on high-

performance servers; SA is Single-threaded Analytics and is best for low- 
performance servers. Single-threaded analytics involves linear analysis of data in 

a specific time increment. For example, in a 5-minute period initially the first 
minute data is calculated, then the second minute data, then the third and so on. 

Multi-threaded analytics provides for simultaneous calculation of several days (in 
this example, the data for all the five days is analyzed simultaneously). This 

allows much quicker analysis. Thresholds for single-threaded analytics are only 
set for the hour increment (Stats calculation threshold, SMS/hour, SA 

parameter), and are calculated automatically for all other increments. The 
analytics type (single- or multi-threaded) is set during System installation in the 

Multi-threaded analytics (0 - no, 1 - yes) parameter in Administration\System 

settings\SMS. It is recommended to check the value of this parameter prior to 
configuring stats calculation thresholds.    



 
 

  

 

The thresholds must be configured based on the intensity of traffic, otherwise the 

analytics may be displayed with a noticeable delay. For example, during initial 
System tests when the SMS count is low it is advisable to set low thresholds for 

the minute/hour/day increments.  

 
Fig. 97 Recalculate stats parameters 

Additionally, it is possible to configure forced recalculation of the day and hour 

statistics at the specified hour and minute respectively. The following parameters 
are used for that purpose:  

• Recalculate current day stats at, hours (0-23, 1-fold): any integer value 

from 0 to 23. For example, the value 23 means that the statistics for the 
current day will be recalculated at 23:00 on the same day  

• Recalculate current hour stats at, mins (0-50, 10-fold): specify 0, 10, 20, 
30, 40 or 50. For example, the value 30 means that the statistics for the 

current hour will be recalculated at 30 minutes of the current hour  
The Analytical cube status report provides information about the general status of 

the cubes and the cube update schedule.  

 
Fig. 98 SMS Analytical cube status report parameters 

To generate the report, in the Categories section select Administration; in the 

Reports drop-down list select SMS Analytical cube status (Administration); in the 
Period drop-down list select the appropriate period (Minute, Hour, Day, Week, 

Month or Financial). Click . NOTE: Financial are specialized cubes calculated 

by billing period. Their calculation delay is configured by the parameter Invoice 
generation delay, hours at Administration\System settings\Financial module.  



 
 

  

 

 
Fig. 99 SMS Analytical cube status report 

The report table contains the following columns:  
• Partition period: the cube type (minute, hour, day, week, month or 

financial)  
• Partition date: the increment date and time  

• State: Ready or Must be recalculated 
• Last change: date and time of the last update  

• Row count: the number of rows 

• New EDR count: the number of new EDRs after update  
• Recalculation status: date and time of the update  

8.3 ASR alert (SMS) 

ASR alert (SMS) is a report that gathers information at regular intervals and 

sends notifications if preset ASR threshold values are exceeded.  
To generate the report, in the Categories section select SMS; in the Reports drop-

down list select ASR alert (SMS).  

 
Fig. 100 ASR alert (SMS) report parameters 

In the Params of report section defines the report parameters:  
• Period (minutes): the period for which the data is calculated. NOTE: the 

report will only be sent if the ASR exceeded the threshold values. It is 
recommended to set the period to 5 minutes  

• ASR threshold (abs): ignore routes with ASR below this value  
• ASR threshold (%): send alert when ASR drops by this percentage as 

compared to the previous period 



 
 

  

 

In the right hand panel in the Email for report field specify the email address for 

sending the report. Set the schedule (for example, configure the report to run 

every 5 minutes) and click . Click . 
According to the settings illustrated above, and the 5-minute schedule, the 

System will check all routes every 5 minutes, compare the ASR values to those in 
the previous 5 minutes and notify the System owner of any events when the ASR 

value drops by 10 percent. An example of the report is illustrated below.  

 
Fig. 101 ASR alert (SMS) report 

NOTE. This report can be used as an example for creating other alerting reports 
that are sent to the user only when a preset threshold is exceeded.  

8.4 Channel status (SMS) 

The Channel status (SMS) report shows the current state of client and vendor 
SMPP binds, and is updated every minute. This report is highly instrumental 

when establishing connection with a new partner carrier.  
To generate the report, in the Categories section select SMS; in the Reports drop-

down list select Channel status (SMS). Select Show disabled checkbox to include 

SMS channels disabled by the System owner. Click . 

An example of the report is shown in the figure below.  

 
Fig. 102 Channel status (SMS) report 

8.5 EDR Export (SMS) 

The EDR Export (SMS) report serves to export EDR records as XSL files.  

To generate the report, in the Categories section select SMS; in the Reports drop-

down list select EDR Export (SMS). In the Params of report section select 
appropriate parameters as shown in the figure below. Set the schedule if 

necessary and click . 



 
 

  

 

 
Fig. 103 EDR Export (SMS) report parameters 

An example of the report is shown in the figure below.  

 
Fig. 104 EDR Export report 

NOTE: Alternatively, EDR records can be exported in the SMS\Analytics page 

using the  button.  



 
 

  

 

8.6 LCR Analysis (SMS) 

LCR analysis (SMS) is a report that allows comparing a product with least cost 
rates that exist in the System. The report shows five least cost vendors per 

MCCMNC.  
To access the report, in the Categories section check SMS; in the Reports drop-

down list select LCR Analysis (SMS).  
 

 
Fig. 105 LCR Analysis settings 

In the Params of report section select the appropriate parameters as detailed 

below:  
• Master product: the product to which least cost rates will be compared  

• test single MCCMNC: check the flag and supply the MCCMNC code in the 
field below for least cost rates for the MCCMNC. The Master product field 

becomes inactive  
• Dial code, Rate, Rate currency (optional): supply the parameters if 

necessary 
• test single country: check the flag to generate a report for a single country; 

select the country in the drop-down list below 
• Vendor product types: select the appropriate product types  



 
 

  

 

• Vendor products: click  to open the product multi-picker and choose the 

products  

• Traffic stats for past, days: indicate the period (in days) for which the 
report will be generated 

• Currency exchange rate date: select the date of the currency exchange rate 
• Min. volume: indicate the minimum amount of SMS  

• Min. ASR, %: specify the minimum ASR value 
• Min. DLR(s), %: provide the minimum DLR(s) value (the percentage of 

SMS successfully received by the end user with respect to the number of 
messages received by the carrier) 

• Min. DLR(t), %: provide the minimum DLR(t) value (the percentage of SMS 
delivered to the end user with respect to the total number of message 

sending attempts) 

To generate the report, click  at the bottom of the left panel. The report is 

illustrated below.  

 
Fig. 106 LCR Analysis report 

The report contains the following fields for each vendor:  

• LCR# Vendor: vendor product name 
• LCR# MCCMNC: MCCMNC of the rate 

• LCR# Rate: rate in account currency and in System currency 
• LCR# Margin: rate margin 

• LCR# Margin%: margin percentage relative to cost 
• LCR# Volume: volume in the past N days. N is configured in the report 

settings (Traffic stats for last, days parameter) 
• LCR# ASR: number of successfully sent SMS to total attempts for the past 

N days 

• LCR# DLRs: number of delivered messages to successful attempts for the 
past N days 

• LCR# DLRt: number of delivered messages to total attempts for the past N 
days  



 
 

  

 

8.7 Rate generator (SMS) 

Rate generator (SMS) is a report that allows creating rates based on 
preconfigured base cost and markup calculation rules. This tool serves to update 

client rates in accordance with vendor rates and desired markup. To access the 
report, in the Categories section check SMS; in the Reports drop-down list select 

Rate generator (SMS).  

 
Fig. 107 Rate generator 

Configure the following parameters:  

• Client product list: select a product for which MCCMNC rates will be 
calculated. NOTE: Check that MCCMNC rates are uploaded in the product in 

order for the report to be generated   



 
 

  

 

• e.212 mask: select the mask of MCCMNC 

• Country list: specify the countries 
• X price in the LCR list: define which rate from the cheapest will be taken for 

the calculation of rates. 1 means the cheapest rate for each MCCMNC is 
taken into account. 5 means the fifth cheapest rate will be considered; the 

previous four cheapest vendor rates will not be taken into account for base 
rate calculation 

• Period from, Period to: select the period for which statistics will be selected  
• Volume greater than: define the traffic volume that should be sent to the 

vendor MCCMNC rate for it to be considered active. Inactive rates are not 
taken into account. Leave the field blank to consider all rates irrespective of 

the amount of traffic 
• ASR higher than, DLR(T) higher than, DLR(S) higher than: the minimum 

values of ASR, DLR(T) and DLR(S) respectively of vendor MCCMNC rate to 
be considered for rate calculation. Similar to the parameter Volume greater 

than. NOTE: The DLR(T) and DLR(S) are explained in Terms and Acronyms. 

• Cost base calculation type: defines the calculation principle of termination 
base cost. Values include:  

- Average rate: the System takes all qualifying vendor's traffic for the 
period chosen above and defines average weighed cost of one SMS as the 

base cost of termination 
- LCR: the System takes the cheapest vendor rate for the MCCMNC 

among the vendors that qualify based on the specified parameters and 
have rates for the period  

• Markup type: defines how markup is added. Values include: 
- Relative: adds a percentage of base cost as markup 

- Absolute: adds a fixed amount in System currency to the base cost 
• Markup: the amount added if Markup type is Absolute or percentage of the 

base cost if Markup type is Relative  
• Use longer matches for client MCC: check the flag if the client offers a flat 

rate for an MCC and the vendor offers multiple rates for the MCC. For 

example, the client offers 202 for Greece and the vendor has rates for 
202001, 202002 etc. NOTE: In case of multiple matches for client MCC (for 

example, 202001, 202002 etc., the System will use the match with the 
highest vendor rate  

• Vendor list type: Inclusive or Exclusive list of vendors to narrow down the 
field of searching to define the base cost of termination 

• Vendor list: the list of vendors among which the base cost will be defined 
(if the Vendor list type is Inclusive) or list of vendors excluded from base 

cost calculation (if the Vendor list type is Exclusive) 
• Vendor product type list: defines whether the Vendor product list is 

Inclusive or Exclusive (similar to Vendor list type) 
• Vendor product types: defines the product types for which the base cost 

will be calculated 

To generate the report, click  at the bottom of the left panel. An example of 

the report is shown below. 



 
 

  

 

 
Fig. 108 Rate generator (SMS) report 

8.8 Change logs (Administration) 

Change logs keep track of all the changes made by the System owner to System 
objects for the past 30 days (the period is configured by the parameter Log store 

period, days at Administration\System settings\Common). These logs allow 
identifying the user who made the changes (when fixing something that went 

wrong, for example).  
To view the log, in the Categories section select Administration; in the Reports 

drop-down list select the appropriate log. In the Params of report section select 

appropriate parameters. Click . 

The following change logs exist in the System (available in the Administration 

section):  
• Agreement change log 

• Balance change log 
• Carrier change log 

• Past rate change log 
• Permission change log 

• POI change log 

• Product change log 
• Rate change log 

• SMS channel change log 
• SMS POI change log 

• SMS routing rule change log 
• SMSC change log 

• System settings change log 
An example of the SMS channel change log (Administration) is shown below.  

 
Fig. 109 SMS channel change log (Administration) 



 
 

  

 

8.9 System log (Administration) 

The System log (Administration) stores information about all operations and 
processes in the database. It serves to monitor the database operability, check 

that the statistics is calculated correctly, detect critical database errors etc.  

 
Fig. 110 Parameters of System log (Administration) 

To view the log, in the Categories section select Administration; in the Reports 

drop-down list select System log (Administration). In the Params of report 
section in the Operation field specify the database operation (use the * mask 

symbol if necessary). Click . 

9. SMS 

9.1 Analytics 

The SMS\Analytics page provides an easy-to-read and quick-to-draw picture of 
the most important statistical parameters. This tool feeds on pre-calculated 

statistical tables (OLAP cubes) instead of raw EDR data. This approach decreases 
the System response time when a user selects a new aspect to display. The side 

effect is that the amount of available aspects is limited (mostly by server 

performance and free disk space). However, the limit is adjustable and all 
important aspects are included into the scope by default. 

The page consists of two interconnected parts. The top part displays a table of 
performance indicators pertaining to the specified statistical aspects (a user-

defined combination of business items, e.g. Client >> Country >> Vendor) for 
the time interval selected in the bottom part. The Total line shows data for all the 

clients or vendors of the System owner, whichever is selected.  



 
 

  

 

 
Fig. 111 Selecting the level of detail in the context menu 

Each item with available underlying layers has the “+” sign on the left of its 
name. Click on the “+” sign to open the context menu and add more items to the 

displayed combination. To close a layer click on the “-” sign on the left of its 
parent object.  

For example, to drill down on the client level, select a specific client, then choose 

to view its stats by country, then select a specific country and further detail it by 
vendor and so on as shown in the figure above.  

 
Fig. 112 Items filter 

Items can be filtered by filling in the edit box at the top of the first column. The 

filter always applies to the child items (if any) of the currently selected item. For 
example, to display the Congo stats for Krakozhia Telecom, select Krakozhia 

Telecom in the list, in the context menu select Country, and enter the first few 
characters of the search word, for example, Con. To locate the item by the 

characters in the middle/end of the word, use the wildcards * or %, in this 
example Congo can be filtered by entering *go or %go.  



 
 

  

 

When a user adds a new detail level to the selected aspect, the System includes 

the items that have stats for the combination of previously selected objects. 
Example: select Client and Country in the context menu. The System will display 

countries to which the selected client was forwarding traffic over the time interval 
selected in the bottom table. 

 
Fig. 113 Analytics (top table) 

The top table contains information on the following parameters: 

• Attempts: total number of attempted SMS transfers from the client side 

• Successful: number of SMS transfers confirmed by vendors as received 
• Billable (C), Billable (V): number of billable SMS for clients (C) and vendors 

(V) as configured by the parameter SMS billing options on the 
Carriers\Products page. 

• Sent: number of SMS messages with the Sent status   
• ASR,%: successful to total attempts ratio. An attempt is considered 

successful if a vendor accepted it for delivery (i.e. submit_sm_resp with the 
field “cause=0” is received in response to the client‟s request submit_sm) 

• DLR (S): delivered messages to successful attempts ratio 
• DLR (T): delivered messages to total attempts ratio 

• Delivered: messages delivered to the end user (successful delivery report is 
received) 

• Aver. delivery delay: average delivery delay in minutes  
• Segments: the number of SMS segments that long messages are broken 

into 

• Margin, USD: total margin 
• Cost (C), USD: total charge for SMS traffic associated with the selected 

item chain that the System owner can bill to theclients 
• Cost (V), USD: total cost of SMS traffic associated with the selected item 

chain that the System owner must pay to the vendors 
• Margin per attempt: ratio of margin divided by the number of attempts  

• Margin %: ratio of margin divided by Cost (C) 
• Aver. rate (C), Aver. Rate (V): average client (C) and vendor (V) rates for 

the selected destination(s) during the selected time interval  
• Rate (C), RATE (V): client (C) and vendor (V) rates that were in effect for 

selected destination(s) during the selected time interval. If the number of 



 
 

  

 

different rates involved does not exceed 3, all of them are displayed; 

otherwise the System will show the “…” symbols 

 
Fig. 114 Analytics (bottom table) 

The bottom area presents the same performance indicators arranged by periods 

for the aspect selected in the top table. The top line always shows total values for 
each parameter of the selected statistical layer within the defined timeframe – 

e.g. if the user specifies 5 days in the Timeframe selector (see below), the Total 
line in the bottom table will show the summary for the selected 5 days. It is 

convenient when you need to see the totals for a custom period (not equal to the 

System defaults – hours, days etc.).  
Total value can also be useful when the System is recalculating the stats for the 

current period (e.g. the current hour) and cannot show the stats for it. The user 
can select a range of lower-level time steps by clicking on the link in the table 

rows (in Fig. 114 – by hours or by minutes). These smaller time steps cover the 
entire period between now and the beginning of the bigger timeframe (which is 

being recalculated) – the System will show the actual stats for that bigger 
timeframe in the Total line based on the summary of all underlying smaller 

intervals. NOTE: To view the stats recalculation progress, see the Analytical cube 
status (Administration) report.  

 
Fig. 115 Chart view (bottom table) 

Data in the bottom table can be displayed either in a table format or as a chart 
by switching the  Chart/Table switch button in the mid-page tool bar. The chart 

view allows creating three different profiles in separate tabs sheets. Select 

appropriate parameter boxes in the left panel that will appear as charts in the 
right panel.  



 
 

  

 

Other controls on the mid-page tool bar include: 

• Page navigation : statistics in the top table will be 
arranged in two or more pages if the specified layer contains more than 25 

items. NOTE: Only items with non-zero data are displayed in the table 

• Refresh button  

• Period: timeframe breakdown defined by selecting a period from the drop-
down list (Minute, Hour, Day, Week, or Month): 

 
Fig. 116 Period 

• Offsets: this control allows comparison of current data for some period to 
the same period in the past, registered a preset number of periods ago. For 

example, to compare the current month stats with the data of 2 months 
ago, select month in the Period control, enter 2 in the edit box as shown 

below, and click . Click  to open the chart view for more 
convenient data representation. NOTE: The past data appears dimmed both 
in the table and chart views.  

 
Fig. 117 Offsets 

• Timeframe selector: a tool for defining the time interval for which statistics 

is generated. The interval can be set either by dragging the left or right 
margin of the scale, or by selecting the period in the pop-up window  

(  pencil button). Click  to apply the timeframe:  

 
Fig. 118 Timeframe selector 

 
Fig. 119 Interval 

• Table/chart switch : a switch between table and chart display formats  

• View options  contains the following parameters:  



 
 

  

 

 
Fig. 120 View options 

- Colors: selection of colors for performance indicators. For the indicators 
Margin, %, ASR, DLR(T) and DLR(S) the control allows setting threshold 

values and assigning different colors to them: 

 
Fig. 121 Assigning thresholds and colors 

- Columns: selection of columns for display 

- Reset view: reset all colors and displayed columns 
- Autoselect last period: the flag fixes the last interval set in the 

timeframe selector. When the flag is checked, the interval shifts forward 

as time goes on. For example, if the current date is October 20, the 

interval is 1 - 10 October and the period set by the button  is 

Day, on October 21 the interval will shift to 2 - 11 October, on October 22 
it will shift to 2-12 October and so on 

• Export tools button  allows data export from the upper or lower table to 
an XLS file 

 
Fig. 122 Export tools button 

• EDR export button  serves for EDR export. The EDR export tasks menu 
allows viewing export tasks and their progress. NOTE: The columns of the 

exported EDR file contain only the most relevant parameters; for a more 

detailed file use the EDR Export (SMS) report  

 
Fig. 123 EDR export button 



 
 

  

 

• Save current state button  saves the current view (the timeframe 

selector value, the period (day, month etc.) and the first selected layer of 

performance indicators). These settings are saved in the browser cash and 
are displayed when the user accesses the SMS\Analytics page the next 

time   
For better visualization the length of the colored bar correlates with the 

parameter value. Colors for ASR and Margin parameters can be set to 
differentiate between poor, fair or good performance. Selection of columns with 

performance indicators (technical and commercial) can be defined individually for 
each user by checking View financial details and/or View technical details boxes in 

Carriers\Users (Analytics section). 

9.2  EDR management  

9.2.1 EDR Reconciliation 

The SMS\EDR Management\EDR Reconciliation page is used to compare the EDRs 
(event detail records) of the System owner and its partner to resolve an invoice 

dispute. The System owner can upload a partner EDR file to compare it to the 
System EDR data.  

The page consists of three sections: Recent task list showing the table of tasks, 
Task details containing the parameters of a selected task and Reconciliation 

summary displaying the result of the comparison. 

 
Fig. 124 Recent task list 

The Task details panel shows the parameters set during EDR file import 

configuration (detailed below).  



 
 

  

 

 
Fig. 125 Task details 

The Reconciliation summary panel shows the discrepancies found in the System 
and partner files. NOTE: The most frequent discrepancies are different MCCMNC 

and cost.  

 
Fig. 126 Reconciliation summary 

The panel contains the following columns:  

• Matching type: the EDR records grouped by type of discrepancy. Click on 
the links to view the records. Possible values include:  

- Partner EDR found only: records found only in the partner EDR file  
- Owner EDR found only: records found only in the System's EDR file 

- MCCMNC mismatch  
- Message ID mismatch 

- Rate mismatch 
- Submit time mismatch: the submit (message receipt) time by the 

System owner is not the same in the two files 
- Same: identical records in both files 

- Total: the total number of records 
• EDR count: the number of EDRs of each type 

• Owner cost: cost for the System owner 

• Partner cost: cost for the partner 
Below is an example of EDR records of the type Partner EDR found only.  



 
 

  

 

 
Fig. 127 EDRs of the type Partner EDR found only 

Click at the bottom of the page to save the file for further analysis 

or for sending it back to the partner. Click  to return to the EDR 

Reconciliation page. 

To start a new analysis of the EDR files, click on the EDR 

Reconciliation page.  

 
Fig. 128 File upload dialog 

In the file upload dialog select the CSV file separator and CSV file. NOTE: The 
accepted file formats are .csv and .zip (the archive must contain a single file). 

Click  to open the file parsing page. The page contains two panels - the 

file preview and the Settings panel.  

 
Fig. 129 EDR file preview 

In the file preview define the column types by clicking on the headers of the 

table, so that the System knows where to take MCCMNC codes, A- and B-
numbers etc. The following column types are available:  

• A-number 
• B-number 



 
 

  

 

• MCCMNC 

• Message ID 
• Rate (optional) 

• Submit time 

 
Fig. 130 Settings panel 

Once the column headers are defined, configure the parameters in the Settings 

panel.  

• Start row: define the first row with the EDR data, so that the System 
ignores everything that is above the EDR table in the file. Check fix row to 

prevent the Start row value from changing when you navigate between 
rows in the preview  

• Direction 
• Product list 

• Country 
• Net: network name  

• MCCMNC 
• Period from/Period to: set the billing period  

• compare only successful EDRs: check the flag to include only EDR for 
successfully transmitted SMS  

• Date format: format of the dates in the EDR file. If required, set up a 
custom format in the bottom field of the drop-down list of available formats   



 
 

  

 

 
Fig. 131 Date format 

• Connect/disconnect time delta (seconds): allowed time slot for better 
identification of the EDR pair (in case the time on the System and partner 

servers is not fully synchronized)  
• Time offset: specify the time difference between the partner EDR file and 

the System file  

Click  to launch reconciliation. Click  to discard the settings 

and return to the previous page.  

The EDR reconciliation settings can be saved as a template. Templates allow 

quick access to preconfigured settings. Type the new template name in the 
Template field at the top of the panel or select an existing one from the drop-

down list and click . To open a template, select it in the drop-down list and 

click .  

 
Fig. 132 Template 

9.2.2 EDR Rerating 

The SMS\EDR Management\EDR Rerating page serves for revaluation of 

previously generated SMS event charges in cases when certain data (rates, 
MCCs, carrier interconnect information etc.) affecting such valuations in the past 

is altered or added. This mechanism allows keeping statistics and billing data up-

to-date. The page is divided into three parts: Recalculation settings, Tasks and 
Task details. 

The System performs automatic EDR recalculation every night for a period up to 
30 days, in case any backward changes were made in the rate data. The 

Recalculation settings panel contains parameters for manual recalculation.  
9.2.2.1 Recalculation settings 

The Recalculation settings menu enables selecting items that need to be adjusted 
by applying the following filters: 



 
 

  

 

 
Fig. 133 Recalculation settings 

• Period: time interval within which charges are recalculated 
• Products: name of the product to be revalued, selected from clients‟ (Client 

leg) or vendors‟ (Vendor leg) products in the Products multi picker menu 
opened by the  button: 

 
Fig. 134 Product multi picker 

• Select the Include undefined check box to recalculate undefined messages 

that may appear in the System due to mal-configuration, junk traffic etc. 
NOTE: If rerating is performed after an SMS channel was accidentally 

removed, the messages within the product will be marked as undefined. To 
fix this, restore the SMS channel and perform rerating with the Include 

undefined checkbox selected. IP addresses: IP-address(s) for the selected 
Product. Open the SMS IP addresses multi picker menu by the  button. 

Select IP addresses from the list in the left section of the menu, or add 



 
 

  

 

them manually in the edit field at the bottom of the right section and click 

the  button.  

 
Fig. 135 SMS IP addresses multi picker 

• MCC: target Mobile Country Codes. Open the Mobile Country Code multi 

picker menu by the  button. Select code(s) from the list in the left 

section of the menu. Search them by specifying either MCC or Country 

 
Fig. 136 Mobile Country Code multi picker 

• SMS net: operator mobile network(s). Open the SMS net multi picker menu 
by the  button. Select the SMS net name from the list in the left section 

of the menu. Search them by specifying the network name in the line 



 
 

  

 

 
Fig. 137 SMS net multi picker 

• MCCMNC: use the MCCMNC multi picker to select appropriate values 
• Task start time: this option allows scheduling the recalculation task for any 

convenient time, for example postponing it till the next System off-peak 
interval to avoid excessive load on the System 

When through with defining the parameters, click  to start recalculation or 

 to discard the settings.  
NOTE: After recalculation, all statistics and analytics will become outdated, and 

the affected data may be displayed as zero values in tables and charts. The 
rerating triggers automatic recalculation of OLAP cubes after some time, 

depending on the current System load. To see when recalculation will be 

performed, go to Reports\Analytical cube status (Administration) and check the 
Recalculation status column.  

 

Fig. 138 Recalculation status report 

NOTE: After EDR rerating, perform recalculation of invoices for the same period 

to bring the invoicing information up to date. Refer to Finance\Invoices for 
instructions.  



 
 

  

 

9.2.3 Tasks 

The Tasks table displays a list of recent EDR recalculation tasks (both automatic 
and manual) with the following information: 

  
Fig. 139 Tasks 

• Job created: date and time of task creation; 

• Status: status of the task. Possible values include: 
- in progress (with the progress percentage specified) 

- scheduled: scheduled task waiting to be run 
- pending: automatic task waiting to be run. Every hour the System 

checks for rate changes and if any are found, it creates a recalculation 
task scheduled for 1 a.m. All such tasks have the pending status. If you 

need to update the information sooner, start the task manually by the 

 button  

- aborted (if terminated manually by the operator) 
- ready 

- error 

• Details: shows that the task is ready or contains the Abort task  button if 

the task is in progress 
Any task can be recalculated with the previously selected settings reentered 

automatically. Select the required task and click the  button 
located under the Tasks table. 

9.2.4 Task details 

The Task details table provides a quick overview of major parameters for the task 

selected in the Tasks table: 
• Period: period for EDR recalculation 

• Product (client leg/vendor leg): product for EDR recalculation 
• IP addresses (client leg/vendor leg): IP addresses for EDR recalculation 

• MCC 

• SMS net 
• MCCMNC 



 
 

  

 

 
Fig. 140 Task details 

9.3  Rates 

9.3.1 Rate import  

The SMS\Rates\Rate import page enables uploading partner rate sheets to the 

System as .csv, .xls and .xlsx files. Rate import can be performed in two ways:  
• Manually – the System owner manually configures the rate sheet format 

and launches import (further detailed in this section)  
• Automatically – all incoming rate sheets are imported automatically based 

on a preconfigured import template (see SMS\Rates\Auto rate import) 
The procedure for rate import is as follows:  

1. The System owner creates a mailbox for receipt of partner rate sheets and 
communicates the email address to the Alaris support team to register it 

with the System 

2. Vendors send their rate sheets to this email address; client rate sheets are 

uploaded to the System manually using the  button. The rate sheet 

files are displayed at the SMS\Rates\Rate import page  
3. In case of auto rate import, the files are imported in the System 

automatically 
4. In case of manual rate import, the System owner performs rate sheet 

parsing in order to translate the file in the format that can be processed by 
the System (see SMS\Rates\Rate import\Rate sheet parsing for more 

detail) 
5. The System owner analyzes the import results, makes corrections if 

necessary and applies the new rates to the System (or cancels the import)  
To start rate import: 

1. Go to SMS\Rates\Rate import 

2. Select a file in the Select file table 
3. Supply appropriate values in the Import settings panel 



 
 

  

 

4. Click  to proceed to rate sheet parsing  
Below is a detailed overview of the SMS\Rates\Rate import page.  

9.3.1.1 Rate import page overview  

The SMS\Rates\Rate import page contains three sections. The top left section is a 

file import queue that displays files both received to the email address and 
uploaded by the System owner. 

 
Fig. 141 File import queue 

The table contains the following columns (self-explanatory columns are not 
described below):  

• Status: displays one of the following values: Not imported (has not been 
parsed), Imported, Confirmed (is set by the user to mark successfully 

imported files), Ignored (is set by the user to mark files not intended for 
import), and Canceled (the import is canceled by the user – for example, 

after preview). Click  below the table to change the status of 

selected records  

• File name: click on the file name to open the rate sheet file  
• Mail parameters: Mail from, Mail to and Mail subject  

Click a record to edit the rate sheet file properties as illustrated below: Carrier, 
Product and mail parameters: From, To and Subject.  

 
Fig. 142 Edit file properties 



 
 

  

 

The panel below the table contains the following buttons:  - delete the 

selected record;  - upload a file for import;  - change the 

file status;  - perform automatic import of the file.  

The bottom section of the page is the Tasks table containing import tasks (for 
both manual and auto import). 

 
Fig. 143 Tasks 

The table contains the following columns:  
• Import mode: possible values are: 

- auto: import without preview, using the Error type level settings of the 
Auto rate import (see SMS\Rates\Rate import\Auto rate import for more 

detail) 
- import: import without a preview of results 

- choice: manual import with a preview of results  
- analysis: preview of import results without the actual import  

• Status: possible values are: 
- ready: the task is complete 

- new: the task has just been created  

- error: the task resulted in error 
- aborted: the task has been canceled by the user or the System 

- pending: the status is currently out of use  
- scheduled: the task is scheduled for a specific time  

- waiting: the task is not yet completed by the user (e.g., the user has 
previewed rate results but has not applied them)  

• Summary: the task result. Click on the tasks that resulted in import to view 
the summary, in the format: Valid rates found in file: 1; New rates added: 

10; Existing rates expanded/closed: 0; Rates deleted: 0 
• Details: contains the view hyperlink that opens a preview of rates 

illustrated below (for the choice and analysis import modes). Click  to 

return to the previous page; click  to view the table in MS Excel  



 
 

  

 

 
Fig. 144 Preview of rates 

The right panel is the Import settings that serves to configure import parameters.  

 
Fig. 145 Import settings 

It contains the following details: 
• Parser: library used for file parsing. Normally, use the default value Internal 

library; try other values only if the output file is illegible 

• Carriers: select the carrier to which the rate sheet refers. Click  to open 

the reference book for more convenient navigation 

Click  to proceed to rate sheet parsing.  
9.3.1.2 Rate sheet parsing 

Once the selected rate sheet file is opened for parsing, the System shows a 
preview of its contents the way it looks in MS Excel.  



 
 

  

 

 
Fig. 146 Rate sheet file preview 

The user can view the column headers and the data that may be above the rates 
(some important comments are often placed there by vendors). NOTE: Images 

are not displayed.  
To make the System able to parse the file, define the column types by clicking on 

the headers of the table, so that the System knows where to take MCC/MNC 
codes, pricing etc. You do not have to define all columns in the original file – 

many of them contain auxiliary data that is not required by the rate import 
process. The following column types are available:  

• MCC: MCC code column, in case E212 codes are split in two columns in the 
file (if the MCC column is selected, the E212 column becomes unavailable 

and the MNC column shows up on the menu) 

• MNC: MNC code, in case E212 codes are split in two columns in the file 
(only available if the MCC column is selected) 

• Rate: termination price for the E212 code (the rate currency is defined by 
the currency of the partner account the product belongs to) 

• Start date: effective date/time for the imported rates (if provided as a 
column in the file) 

• End date: expiration date/time of imported rates (if provided as a column in 
the file) 

• Net name: name of the mobile network the E212 code belongs to 
• Net status: network availability 

• Country name  
• Country dial code  

• Rate note: arbitrary comments 
• E212: for cases when full E212 codes are given in one column rather than 

with the MCC and MNC split to two columns (if the E212 column is selected, 

the MCC column becomes unavailable)  
NOTE: the only required columns are MCC/MNC (or E212) and Rate.   



 
 

  

 

 
Fig. 147 SMS rate file import settings 

Once the column headers are defined, configure the parameters in the SMS rate 

file import settings panel (the parameters are disabled if the data is already 
contained in the preview table).  

• Active sheet: select the spreadsheet that will be parsed (in case the original 
MS Excel file contains several spreadsheets) 

• Start row: define the first row with the rate data, so that the System 

ignores everything that is above the rate table in the file. Check fix row to 
prevent the Start row value from changing when you navigate between 

rows in the preview  
• Effective from: select the date or indicate the number of days in Rates 

come into effect days after today  
• Effective till: use the default value 

• Close type: select the appropriate value:  
- Update only rates for fully matching breakouts: matching rates will be 

updated, and all other rates will remain unchanged 
- Close non-matching breakouts: all non-matching rates will be closed   

• Close date: select the date or indicate the number of days in Close rates 
days after today 

• Timezone: define the partner time zone. NOTE: It is good practice to use 
the GMT time zone in order to eliminate possible time zone discrepancies  

• Date format: format of the effective dates if they are provided in the file - 

i.e. if the Start date and End date columns are defined. If required, set up a 



 
 

  

 

custom format in the bottom field of the drop-down list of available 

formats.   

 
Fig. 148 Date format 

Click  to check the file before the actual import. To clear the parser 
settings click . To cancel and return to the previous page, click 

. 

The file import settings can be saved as a template. Templates allow quick access 
to preconfigured settings and are also used in automatic import of rate sheets 

(see SMS\Rates\Rate import\Auto rate import for more detail). Type the new 
template name in the Template field at the top of the panel or select an existing 

one from the drop-down list and click . To open a template, select it in the 

drop-down list and click .  

 
Fig. 149 Template 

9.3.1.3 Preview of rates 

Once the System has processed the rate file (and before the new rates are 

applied), it shows a preview of the parsed rates and a list of errors that must be 

shown to the user before committing the new data to the database. The Preview 
of rates is illustrated below.  

 
Fig. 150 Preview of rates 



 
 

  

 

 
Fig. 151 Errors 

The Errors panel contains the following columns: 

• Row number: the row in the original MS Excel rate sheet where the error is 
found 

• Error name: error message type. Possible values are:  
- e212 code not numeric 

- e212 code has invalid length 
- e212 uniqueness violated: one and the same E212 code is present in the 

file more than once. One of the possible reasons is that some vendors 

send E212 codes where the MCC code consists of 3 digits as expected, but 
the MNC code may be either empty or contain 1 or 2 digits (but not 3). 

Otherwise, there may be an E212 code having 3, 4 or 5 digits in it. In case 
of empty MNC or a 3-digit E212 code, the System leaves it the way it has 

arrived, as this may be a case when an entire country is sold flat-rate. In 
case of a 1- or 2-digit MNC it adds extra zeros (2 or 1 respectively) at the 

beginning of the MNC, so that it has 3 digits in it. For example, the E212 
codes 2501 and 25001 will be converted to 250 001 (while 250 will remain 

250). In case the regular 6-digit MCCMNC code is also present in the file 
besides its “shortened” cognates (e.g. 250001 vs. 25001), the outcome of 

such code conversion will be two identical E212 codes – and that will 
result in error 

- Rate parsing error 

- Rate for network without dial codes: the MCC/MNC code does not exist 
in the E212 reference book; alternatively, the MCC/MNC code exists but is 

not linked to any dial code 
• Error info: message details  

Send the error descriptions to the partner for corrections. In case of reference 
book-related errors, make the necessary amendments in the original MS Excel 

file and upload it back to the System.  
After the import messages are reviewed, the user can either cancel the import or 

apply the new rates. Click  and select one of the following options:  
• Auto: import without preview, using the Error type level settings of the 

Auto rate import 
• Analysis: preview of import results without the actual import  



 
 

  

 

• Choice: manual import with a preview of results  

• Import: import without a preview of results  
NOTE: All errors and warnings will be ignored in the preview and imported file.  

The user is then returned to the SMS\Rates\Rate import page; the task appears 
in the Tasks panel (see Fig. 143 above). To see the preview of import results 

(Choice and Analysis options only) click view in the Details column. To see the 
summary of import results, click on the appropriate cell in the Summary column.  

 
Fig. 152 Summary of import results 

9.3.2 Auto rate import 

Auto rate import allows creating rules that are used for automatic import of rate 
sheets sent to a predefined email address or uploaded in the System using the 

 button on the SMS\Rates\Rate import page. To configure automatic 

rate sheet import:  
1. Indicate error types that will prevent auto import  

2. Create an auto import rule  
3. Test the rule 

4. Activate the rule  
Open SMS\Rates\Auto Rate import. The page contains two panels: the left panel 

displays the Auto import rules and Error type levels tab sheets; the right panel 
contains the Add, Edit and Simulation tab sheets.  

 
Fig. 153 Auto import rules 

Open the Error type levels tab sheet to define errors critical for import.  



 
 

  

 

 
Fig. 154 Error type levels 

Rate sheet files containing critical errors will not be imported. Select a record in 
the table and check the Critical for auto import flag when necessary.  

Open the Auto import rules tab sheet. It contains the list of rules for automatic 

import. Test rules are highlighted in bold italic font, while inactive rules are 
greyed out. The table columns contain the parameters that are configured in the 

right-hand panel.  



 
 

  

 

 
Fig. 155 Add menu 

To create a rule, open the Add menu and enter the appropriate parameters in the 

fields detailed below. Fields marked with an asterisk (*) are required. 
• Carrier 

• Product 
• File name mask, Mail from mask, Mail to mask, Mail subject mask: use an 

asterisk * to define a mask 
• Parser: library used for file parsing. Normally, the default value Internal 

library is used; try other values only if the output file is illegible 
• Template: select the rate file import settings that will be used to parse the 

imported rate sheet. Templates are created in the SMS rate file import 
settings panel at SMS\Rates\Rate import.  

• Owner notification, carrier notification: configure the format for notifying 

the System owner and partner respectively about the file import. Possible 
values are:  

- Not sent: no notification is sent 
- Short report: a summary of import results is sent  

- Full report: a full analysis with price changes is sent (similar to the 
Preview of rates illustrated in Fig. 144) 

• Short report recipients, Full report recipients: supply comma- or semicolon-
separated email addresses for sending short and full reports respectively 



 
 

  

 

• Do not send reports to external recipients: send reports only to managers 

of the accounts pertaining to the selected carrier 
• Rule enabled: select when the tests are complete to activate the rule 

• Test rule: select when testing the rule. Rules with the selected checkbox 
will not be imported  

Click  to save the changes. The entry will appear in the Auto import rules 

table.   
To test the rule, open the Simulation menu.  

 
Fig. 156 Simulation 

Enter the appropriate parameters and click . The test results will appear on 

the Simulation panel. Once the tests are completed, return to the Edit menu and 
check the Rule enabled flag to activate the rule. 

9.3.3 Rate editor 

The SMS\Rates\Rate editor page offers a tool for viewing and modifying rates 

registered in the System, as well as manual creation of new rates.  
The page is divided in two panels: the left one is the Rate filter that allows 

locating rates that meet filtering parameters; the right panel contains two tab 
sheets: Rate groups and Rates.  



 
 

  

 

 
Fig. 157 Rate filter 

In the Rate filter panel, specify filtering parameters:  

• Group by: allows grouping rates in the Rate group tab sheet based on one 
or several parameters: 

- Country 
- MCC 

- Effective interval: the period during which the rate is valid 

- Rate note: comments in the Rate note field  
- Net: network name 

- MCCMNC 
- Product 

• Carrier region 



 
 

  

 

• Carrier 

• Client/Vendor: traffic direction 
• Product name: type of SLA (for example, premium, wholesale etc.) 

• Product: specific carrier product. Select several products to compare rates 

between them. Click  on the  buttton for multiple selection 

• Country 

• Net: network name 
• MCCMNC: masks with % and * symbols are supported 

• Dial code: is used when a single MCCMNC includes several dial codes with 
different rates. For example, two dial codes +1212 и +1718 with different 

rates can exist for the MCCMNC 310779. Enter the appropriate dial code to 
view its rates  

• Rates valid at: date on which the rates are valid 
• Effective interval start (end) date between: the period during which the 

rate is valid 
• Rate currency 

• Rate value from… to 

• Rate notes: the table containing comments available in the Rate note field. 
Select rate notes by setting appropriate flags or remove a note from all 

rates by clicking . NOTE: System notes such as BLOCKED and Volume-

based deal do not contain the  button an cannot be removed.  

Click  to display the rates complying to the filter parameters. Click 

 to reset the form.  
The rate filter parameters can be saved as a template for quick access to 
preconfigured settings. Type the new template name in the Template field at the 

top of the panel or select an existing one from the drop-down list and click . 

To open a template, select it in the drop-down list and click .  

 
Fig. 158 Template 

The filtered rates will appear in the Rate groups tab sheet, grouped by the 

parameters specified in the Rate filter panel. Rates in the figure below are 
grouped by Country, Net, and MCCMNC.  

 
Fig. 159 Rate groups 



 
 

  

 

Click  at the bottom of the page to export the table to a MS Excel 
file.  

To view a rate, select a record in the table and open the Rates tab sheet.  

 
Fig. 160 Rates 

Double-click on a rate to modify it. Enter the appropriate parameters in the 
Modify rate dialog that appears and click  to save the changes. Click 

 to discard the settings.  

 
Fig. 161 Modify rate dialog 

The bottom of the Rates tab sheet contains the Rate history panel that shows 

history of changes for the selected rate. Double click a record to edit it. NOTE: 

For example, editing the rate history may come useful when correcting an 
erroneous price etc.   

 
Fig. 162 Rate history 

The bottom of the page also contains buttons that allow editing rates and rate 
groups:  

• : create a copy of the rate (recommended for use when creating a 
new rate with similar parameters) 

• : modify the rate Active from and/or Active till dates; the rates 
whose dates do not overlap with the new period are removed from routing. 



 
 

  

 

For example, the original rate period is June 10 – June 20; the corrected 

period is June 10 – June 15. NOTE: rates for the period between June 16 
and June 20 will be removed from routing. This control is recommended for 

correcting erroneous new rates  

• : modify the rate Active from and/or Active till dates; the old rate 

will be active for the dates that do not overlap with the new period. For 
example, suppose there is a rate valid from 2016.01.01 till 2100.01.01 and 

you need to increase it. Click , set the Active from date to 
2017.02.01 and the Active till date to 2100.01.01. In this way, you will 

have two rates: the old one from 2016.01.01 till 2017.02.01 and the new 
one from 2017.02.01 till 2100.01.01. NOTE: It is recommended to use 

 rather than   

• : close the selected rates (stop offering them) 

• : export the table to a MS Excel file  

• : cancel all changes made for a selected product before the 

date specified in the Target date/time field  

 
Fig. 163 Product rollback 

• : add a new rate  

• : select the appropriate group parameters and specify the 

rate to be added to the group. NOTE: If a Group by country filter is on and 

the group has several MCCMNC codes, the MCCMNC field will show the MCC 
code  

 
Fig. 164 Add rate to group 



 
 

  

 

• : similar to  detailed above 

• : similar to  detailed above 

• : similar to  detailed above 

9.3.4 Rate export 

The SMS\Rates\Rate\Rate export page allows downloading rate data from the 
System database to a file (for analysis) or sending it to the specified e-mails (to 

clients). The page is divided in three panels: Export/Column settings, Tasks and 
Task details. 

9.3.4.1 Export  

The Export tab sheet is used to select rates to be exported, by applying the 

following filters: 

 
Fig. 165 Export options 

• Export type: includes the following radio buttons:  

- Changes pending at: export scheduled rate changes starting with the 
date indicated in the Start date parameter. In the exported file, rates are 

marked in compliance with pending changes: increase, decrease, new, 

close, same 
- Rates effective at: export rates as of the date indicated in the Start date 

parameter 
- Raw rates chronology analysis: export rates available on Start date and 

End date, and analyze if any changes were made between the dates. For 
example, select the Start date 1 October and the End date 10 October. 

Suppose somewhere between these dates the rate for the whole period 
was changed from 0.05 to 0.06. The exported file will show the change. 

NOTE: The latest rate change overwrites all the previous changes. For 
example, if the rate was changed from 0.05 to 0.06 on October 2, and to 

0.07 on October 9, the System will only show the increase from 0.05 to 
0.07. It is recommended to use this parameter when the whole rate was 



 
 

  

 

changed retrospectively  Rate history between: export history of rate 

changes for the period between the Start date and End date and analyze if 
any planned changes were made within the period. Unlike the previous 

parameter, the System will not show changes for the whole period but 
display all changes planned (or effected) between the Start date and End 

date for part of the period (future dates can be included). For example, 
select the Start date 1 October and the End date 10 October. Suppose the 

rate was 0.05 between October 1 and October 6 and was changed to 0.06 
starting October 7. This change will be reflected in the exported file. It is 

recommended to use this parameter in most cases involving rate history 
analysis 

• Include same: check the flag to include the rates that were unchanged  
• Use agreement timezone: use the partner‟s time zone in the exported rates 

• All products: export rates for all products registered in the System  

 
Fig. 166 Export, continued 

• Carriers 

• Direction 
• SMS products: carrier SMS product(s) associated with the exported rates. 

Check include parent rates to include rates of parent products (if 
applicable)  

• Product preset: a set of columns in the exported file defined in the Column 
settings tab sheet 

• Mobile country code 
• SMS net: network name 

• MCCMNC/Dial code list: unfold the form by clicking  and enter MCCMNC 
and/or dial codes if necessary 



 
 

  

 

 
Fig. 167 MCCMNC/Dial code list 

• Export target: indicate how the file should be exported. Options include:  
- Export to file 

- Send via email 
• Send exported file to: specify the email address for file delivery. Check the 

send to partner emails flag to deliver the file to the carrier emails 
configured in Carriers\Agreements (Default rate change emails parameter). 

NOTE: Each partner receives only rates pertaining to their accounts  

• Comments: arbitrary comments. NOTE: The field appears in the exported 
file only if the Comments field is configured in the MS Excel template file 

(Administration\Template manager) 
When through with defining the parameters, click  to start export or 

 to discard the settings. The configured export settings can be saved as 
a template to use for similar rate export tasks in the future. Type the new 
template name in the Template field at the top of the panel or select an existing 

one from the drop-down list and click . To open a template, select it in the 

drop-down list and click .  

 
Fig. 168 Export template 

9.3.4.2 Column settings 

The Column settings tab sheet serves to configure columns of the output MS 
Excel file. Such set of columns and their parameters is called a product preset. 

The Column settings tab sheet contains four panels: the upper left panel is a 
table of product presets (Fig. 169), the bottom left panel shows details of the 

selected record (Fig. 171); the top right panel contains the Add and Edit menus 
for creating and editing a product preset (Fig. 170); the bottom right panel 

contains the Add and Edit menus for configuring columns within the preset.  

 
Fig. 169 Table of product presets 

To create a new product preset, open the Add menu in the top right panel and 

enter the appropriate parameters in the fields detailed below. Fields marked with 
an asterisk (*) are required. 

 



 
 

  

 

 
Fig. 170 Add menu 

• Description: name of the product preset 
• Contract company: the legal entity of the System owner on behalf of which 

it works with the carrier 
• Direction 

• Carrier 
• Product 

• Export type: the parameter configured in the Export tab sheet (options 
include: changes pending at, rates effective at or rate history between)  

Click  to save the changes. Click  to clear the form. Click  to 
create a copy of a record selected in the table (the button opens the Add menu 

with the parameters of the record. Edit them as appropriate and click ).  
A new product preset contains the following default columns:  

• MCC 
• MNC 

• DIALCODE: dial code in E164 format 
• COUNTRY 

• NETWORK: network name 
• RATE START DATE 

• RATE 
• CHANGE TYPE: describes the rate change (increase, decrease, new, close, 

same) 

 
Fig. 171 Details of a selected preset 

The user can edit the parameters of the default columns (use the Edit menu at 

the bottom right panel) or add new columns (use the Add menu at the bottom 



 
 

  

 

right panel). When adding a new column, configure the following settings (fields 

marked with an asterisk (*) are required): 
• System column: select the data type in the drop-down list. Values include:  

- RATE_NOTE: comments configured in the Rate note field 
- MCCMNC5: MCCMNC code in a 5-digit format, with the first digit of the 

MNC code removed (for example, if the 6-digit MCCMNC code is 202002, 
the 5-digit code is 20202) 

- RATE_END_DATE 
- PREV_RATE: the value of the previous rate  

• User column name: the name of the column  
• Width 

• Alignment 
• Rounding precision 

• Sort order: specify sorting priority for the columns, with 1 being the highest 
priority. Possible values are 1, 2, 3. For example, in Fig. 171 above columns 

will be first sorted by MCC (value 1 in the Sort order field and then by MNC 

(value 2 in the Sort order field) 
• Sort direction: select asc for ascending and desc for descending 

Click  to save the changes. Click  to clear the form. Click  to 

delete the column.  
9.3.4.3 Tasks 

The Tasks panel displays a list of recent rate export tasks with the following 
information: 

 
Fig. 172 Tasks 

• Job created: date and time of task creation 

• Product: relevant product 
• Status: status of the task. Possible values: 

- ready: the task is complete 
- new: the task has just been created  

- error: the task resulted in error 
- aborted: the task has been canceled by the user or the System 

- pending: currently out of use  
- scheduled: the task is scheduled for a specific time  

• Details: may contain: 
- error description if error occurs 

- marked as sent if the Send via email option is selected 
- a link to the generated file 

- Abort task  button if the task is in progress 
• User name: reference to the user that created the task 

Any task can be restarted with the previously selected settings reentered 

automatically. Select the required task and click the  button located 
under the Tasks table. 



 
 

  

 

By default, created tasks remain in the System for the period of 30 days, and the 

list of tasks has no length restrictions.  
9.3.4.4 Task details 

The Task details table provides a quick overview of major parameters for the task 
selected on the Tasks page: 

 
Fig. 173 Task details 

Export can be configured for several grouped products. For every product in a 

group a separate task is created. The Task details table shows all products within 
one task. 

9.3.5 Rate management tools  

Two important rate management tools - LCR Analysis and Rate generator - are  

implemented in the Reports section. Refer to Reports\LCR Analysis (SMS) and 
Reports\Rate generator (SMS) for more detail.  

9.4 Reference books 

In the SMS industry charges are typically based not on “standard” E164 dial 
codes, but on a special type of codes intended to address mobile networks rather 

than geographic areas. That special standard is called E212. On a large scale it 
brings forward two major items extensively used in the mobile communications 

industry: 
• MCC: mobile country code, a 3-digit code of the country the target mobile 

network is located in. There may be more than one MCC per country 
• MNC: mobile network code, a 2- or 3-digit code of the target mobile 

network  

MCC and MNC codes are used together as E212 codes. In the inter-carrier 
settlements there may be cases when a particular E212 breakout traded by a 

particular carrier has no MNC – meaning that an entire country is bought or sold 
flat-rate. 

While interconnect rates are usually based on E212 codes, SMS messages contain 
only E164 numbers of addressed mobile subscribers. Therefore, the ability to 

match E164 numbers with the respective E212 codes is required to correctly 
estimate the SMS cost for the customer and vendor. For that purpose the System 
has a reference book that stores E212 ↔ E164 code combinations, as well as 

mobile network names and country names for E212 codes. All rating- and 
routing-related procedures are dependent on this reference book, so it should 

always contain complete and accurate data to avoid billing mismatches. NOTE: 



 
 

  

 

The System comes with a basic version of the reference book. It is recommended 

to keep it regularly updated.  
The SMS/Reference books section consists of three pages – Short Code 

Reference Book Editor, E212/E164 Reference Book Editor and E212/E164 
Reference Book Import.  

9.4.1 Short Code Reference Book Editor 

The short code reference book editor allows configuring short code/carrier 

matches to enable two-way messaging. When a mobile originated SMS is 
received from a subscriber, the System uses the reference book to look up which 

carrier the short code belongs to, and directs the SMS to this carrier.  
The Short Code Reference Book Editor page consists of two panels. The left panel 

contains the reference book table; the right panel shows the Add and Edit menus.  

 
Fig. 174 Reference book table  

 
Fig. 175 Add menu 

The Add menu contains the following parameters:  

• Product: select the appropriate product in the drop-down list 

• MCC 
• DNIS: the carrier's short code  

• Text pattern: the field is used in case a short code is shared by several 
carriers, each having their own text code; specify the text code in this field   

Fields marked with an asterisk (*) are required. When through with defining the 

parameters, click  to save the record or  to discard the settings. 

Click  to remove a record (available in the Edit menu). 

9.4.2 E212/E164 Reference Book Editor 

This page enables the user to review, create and edit entries in the E212/E164 
reference book. The page is divided into four panels. The upper left panel is a 

table of registered E212 codes. 



 
 

  

 

 
Fig. 176 E212 codes 

Use text masks under the column headers to filter the records in the table. Use 

the  button in the upper left corner to clear the filter.  
• ID: internal identification number 

• MCC MNC: Mobile Country Codes/Mobile Network Codes 
• Net: name of the mobile network the E212 code belongs to 

• Country: name of the country the E212 code belongs to 

• Country code: code of the country in E164 format (optional) 
• Start date/End date: period of the record validity (normally default values 

are used to set up an indefinite period) 
• LOT: level of trust index (from 0 to 100). This parameter defines the level 

of trust in the source of information placed into the E212/E164 reference 
book. For example, Home Location Register always gives authentic 

information about E164/MCCMNC code matching, while some vendor's price 
list could be less reliable. NOTE: Several records for the same MCCMNC and 

differing LOT indices can exist in the table; only the record with the highest 
LOT will be used for billing and routing. However, it is recommended to 

timely verify the information and delete irrelevant records with the same 
MCCMNC to avoid confusion    

Displayed codes can also be filtered according to their validity by setting a date 
and time in the Active at tool bar: 

 
Fig. 177 The “Active at” tool bar 

The Add and Edit menus in the upper right corner of the page allow editing 

records and creating new ones. To activate the Edit menu, click on the record in 



 
 

  

 

the table. Enter the required parameters. Fields marked with an asterisk (*) are 

required. 

 
Fig. 178 Add code menu 

The bottom left panel shows a table of E164 codes matching the E212 codes. A 

single E164 code may match only one E212 code, while a single Е212 code may 
match multiple Е164 prefixes.  

 
Fig. 179 E164 codes 

Click on the record in the top table of E212 codes. The matching E164 code will 
appear in the bottom table. The table contains the following information: 

• ID: internal identification number 
• MCC MNC: Mobile Country Codes/Mobile Network Codes 

• Dial code: dial code in E164 format. NOTE: It is essential that all records 

contain a dial code. Records without a dial code will not be used for routing 
or billing   

• LOT: level of trust index (from 0 to 100). This parameter defines the level 
of trust in the source of information placed into the E212/E164 reference 

book. For example, Home Location Register always gives authentic 
information about E164/MCCMNC code matching, while some vendor's price 

list could be less reliable  
• Start date/End date: period of the record validity (normally default values 

are used to set up an indefinite period) 
The Add and Edit menus in the bottom right corner allow editing this code or 

adding a new one. 



 
 

  

 

 
Fig. 180 Add E165 code menu 

When through with defining the parameters, click  to confirm or  to 

discard the settings. Click  to remove a record (available in the Edit menu). 

9.4.3 E212/E164 Reference Book Import 

The System supports import of the E212/E164 data from external sources as a 

CSV file. The file must contain the following columns: 
• E212 (or MCC and MNC separately) 

• E164 
• Net 

The E212/E164 Reference Book Import page consists of two panels. The left 
panel is a preview table of the CSV file; the right panel is the upload menu.  

 
Fig. 181 Upload menu 

Use the button to select the file on the local PC and click . 

Fill the appropriate parameters in the upload menu:  

• Active sheet: select the spreadsheet of the uploaded file that will be 
imported  

• Start row: define the first row of the reference book data, so that the 
System ignores everything that is above the rate table in the file. Check fix 



 
 

  

 

row to prevent the Start row value from changing when you navigate 

between rows in the preview  
• Import type: contains the following options:  

- Replace all matching entries in the database by the imported ones 
- Close all existing entries in the database and make the imported ones 

effective as of the same time. The date for closing the entries is specified 
in the Close date parameter below. NOTE: this task is normally performed 

by the Alaris support team 
- Complex reference book update: the parameter serves for updating the 

reference book as follows:  
o Close a dial code of a specific MCCMNC: upload a file containing 

the MCCMNC whose dial code(s) must be closed  
o Add a new dial code: upload a file containing the MCCMNC and 

the new dial code 
o Close the records for a specific dial code: upload a file 

containing the dial code (the MCCMNC field is empty) 

o Close an existing MCCMNC record and open a new one: upload 
a file containing the MCCMNC, country name and network name  

o Add a new dial code to the reference book: upload a file 
containing the MCCMNC, country name, network name and dial code 

All these data can be imported as a single file or in separate files. The 
date the updates come into effect is specified in the Effective date 

parameter.  
- Dry run: check the flag to view the updates without applying them to 

the database (they will not be submitted even after clicking the  
button) 

 
Fig. 182 CSV file preview  

In the CSV file preview, set the appropriate column names by clicking on the 

headers. Click  to start import. To discard the settings, click . 

To cancel, click . 

If any errors are found, they are displayed in the page that appears after clicking 

the  button.  



 
 

  

 

 
Fig. 183 List of errors 

The bottom section contains a preview of records to be updated. Click  to 
submit the updates to the Database. Click  to return to the previous page.    

9.5  Routing  

The SMS\Routing section serves to manage the way messages are routed by the 
switch.  

9.5.1 Routing procedure overview 

For every message that hits the switch, it immediately sends a request to the 

routing module over a proprietary protocol. The most important information in 
the request is the internal ID of the client channel on the switch and the 

addressed B-number. The System performs client authentication based on the 
client channel GUID provided by the switch and (optionally) the “service type” 

parameter specified in the SMS, identifies the net name for the E164 B-number, 
and collects the E212 code associated with that net name in the Reference books 

or in an external HLR service. 

As soon as E212 code matching the destination network is obtained, the System 
tries to find the respective rate(s) in the client product. Then it makes up a list of 

vendor rates available for the given MCCMNC (or MCC) code.  
As soon as the list of vendor rates in the format “one rate per vendor product” is 

created, the System checks for any restrictions related to any of the respective 
vendor accounts and filters the vendor rate list accordingly. Possible restrictions 

are: no SMS POIs created for the vendor product, or the outgoing credit for the 
vendor is exceeded, therefore the vendor cannot be used for routing.  

On the final stage of routing the System goes through the list of routing rules 
that can be applied to the given customer and MCCMNC. If such rules are found, 

it picks the vendor routes from the list (for more details on the vendor selection 

please refer to SMS\Routing\Routing types and Routing rules page). Then the 

System returns the ordered sequence of the selected routes as vendor channel 
GUIDs back to the switch. Maximum number of routes per SMS is set by the 

Vendors to send parameter in Administration\System settings\SMS module. The 
switch checks if it has active binds of correct types for the provided GUIDs. If 

yes, message termination attempts are performed to the vendors in the order 
they were returned by the System. Rerouting to the next vendor is made after 

the expiration of timeout for the previous route (default timeout value is 30 
seconds) or (for SMPP) upon receipt of submit_sm_resp message with any value 

in the cause field except 0х00 (for SMPP). For HTTP, rerouting is made upon the 
receipt of a valid response with the status other than 200 OK or no response.   



 
 

  

 

9.5.2 Routing rules 

Routing logic is defined by means of routing rules. Each rule is an instruction 
from the user to the System - which vendors and networks/E212 codes to use for 

terminating traffic from a specific set of client products. By default, each rule 
affects all client products and all networks/E212 codes, unless specified 

otherwise. Vendor selection is done by means of setting up choices: in general 
choice #1 will be the first route for the switch to try, choice #2 will be the second 

option (in case the first route fails) etc. 

9.5.3 Routing types 

In terms of vendor list creation in a rule, the following routing types exist in the 
System (they are just for explanation purposes and are not directly reflected in 

any System parameters): 
• Static routing: the routing choice contains one or several manually selected 

vendor products (if more than one vendor product is present in one choice, 
percent-based load sharing must be set up), so that the routing is only 

possible between these vendor products 

• Dynamic routing: instead of a static product list, a formula is provided in 
the routing choice. The formula is resolved as a numeric value. When the 

routing rule is triggered, the System forms a list of available vendors and 
uses the formula to calculate the routing weight for each of them. The 

bigger the resulting weight value is, the higher the vendor position in the 
resulting route list – so the vendor with the biggest weight will be used as 

route #1. All vendors with negative or zero weights are disregarded. In 
case two or more vendors have equal weight, the System introduces a 

small random value to arbitrarily distribute the traffic between them. If 
necessary, the initial list of vendors can be trimmed by applying a condition 

– a logical expression that is resolved as True or False. If it is False for a 
vendor product, the product is disregarded. Conditions can contain the 

same System parameters and operators as formulas. The key difference is 
that the result of the formula must be a number, while the result of the 

condition is a Boolean (True/False) value. NOTE: If the Condition field is 

empty, the System applies the condition MRG>=0 
• Combined routing: it is possible to set up a formula in the routing choice, 

but at the same time make a list of manually selected vendor products to 
apply that formula to. In this case the routing will be dynamic (as it will be 

based on a formula, so the final sequence of vendors for each SMS may be 
different if the formula parameters change) and at the same time static (as 

the routing will be done among manually defined list of vendor products 
only) 

It is also possible to use a more complex type of combined routing: within the 
same routing choice you can set up a static product and a formula (optionally – 

with a limited set of vendor products). Then configure load sharing between two 
options – so that a certain part of the affected traffic is statically routed to the 

selected vendor product, while the other part of the traffic is dynamically 
distributed according to the formula. 



 
 

  

 

9.5.4 Routing rules page 

The SMS\Routing\Routing rules page serves to review, create and edit routing 
rules. 

 
Fig. 184 Routing rules 

Use text masks or drop-down lists under the column headers to filter the records 

in the table. Use the  button in the upper left corner to clear the configured 
filter.  

The Add and Edit menus in the upper right corner of the page allow editing 
existing routes and creating new ones. To activate the Edit menu, click on the 

record in the table. Enter the required parameters in the corresponding fields. 
Fields marked with an asterisk (*) are required. 

The following parameters are available for configuration in the Add menu: 
• Description: arbitrary text description of the rule. It is recommended to use 

easy-to-understand descriptions that give an immediate idea about the 
nature of the rule (e.g. Russia mobile for Client X) 

• Rule type: type of the rule from the standpoint of its expected general 

effect. Possible values: 
- Regular routing: standard rules providing vendors for routing 

- Block: route-blocking rules 
- Test: rules aimed at distributing a small predefined portion of traffic 

going through the System among many or all active vendors in the 
System in order to keep their stats up-to-date. The statistics is calculated 

based on ASR, DLR(s) and delivery delay. The stats calculation period is 
configured by the parameters EMA frame, EMA stats delay and EMA valid 

period in Administration\System settings\SMS   
• Context: user-defined group the given rule is assigned to. The essence of 

contexts is explained in the SMS\Routing\Use of contexts 
• Start date: date and time when the rule becomes effective 

• End date: date/time when the rule goes out of effect 
• Is active: the flag turns the rule on/off. Inactive rules are disregarded by 

the System 
• Priority: numeric value defining the rule priority in the range from one to 

100. Bigger values mean higher priority. Two or more rules may have the 
same priority; in this case the final route list will be created after sorting 

the vendors from all rules with the same priority by their weight. The 
weight can be viewed in the SMS\Routing\Simulation page  



 
 

  

 

 
Fig. 185 Add routing rule menu 

NOTE: If there several rules have the same priority, static choices will always be 
on top of the resulting route list even if some/all of them are not choices #1 in 

their rules. This is done because the System is unable to decide how to otherwise 
combine static and dynamic vendors from several rules (static vendors cannot be 

sorted by weight, as they have no weight assigned). To avoid ambiguity, it is not 

recommended to create two rules with the same priority.  



 
 

  

 

• Client product types: types of client products whose traffic the rule will 

route. Limiting the list of affected client products by type instead of the 
exact product list is more convenient when it comes to separating the 

routing for large customer groups – for more detail refer to 
SMS\Routing\Use of contexts 

• Client products: list of client products the rule will affect. Can be used for a 
rule specific for one client or a small group of clients (i.e. where using the 

Client product types parameter will not help). Can be inclusive or exclusive 
• Vendor product types: types of the vendor products that will be allowed to 

take part in route selection. Can be handy when the user, for example, 
wants to limit the possible routing options to vendors whose products are 

called Premium and Platinum 

 
Fig. 186 Add routing rule menu, continued 

• MCC MNC: E212 codes the rule will be effective for (can be inclusive or 
exclusive) 

• Caller ID tags: tags used for routing by A-number. Caller ID tags are 
configured in Reference books\Caller ID tags. Can be inclusive or exclusive. 

NOTE: Routing by A-number may come handy in blocking undesirable 
traffic, on-net routing etc.   

• Content pattern: keywords and keyword patterns, for example .*discount*. 
The field comes handy in creating an SMS firewall and blocking spam 

messages. NOTE: The System translates the text of SMS messages to UTF-

8, therefore it is recommended to use only symbols compatible with the 
UTF-8 encoding   

• ANI pattern: mask that configures a group of A-numbers. For example, for 
all short codes following the pattern 205XXX and 215XXX use the mask 

(205|215)[0-9]{3} 
• DNIS pattern: mask that configures a group of B-numbers. For example, 

for 10-digit B-numbers use the mask [0-9]{10} 
• Choice list: list of vendor selection options. One or several choices per rule 

can be created; each can contain one or several routing options. Click the 
 button to open the Add new choice menu. 



 
 

  

 

 
Fig. 187 Add new choice menu 

Choice parameters: 

• Condition: logical expression based on System metrics that resolves as 
True or False for every involved vendor product, so that the product is or is 

not considered in the route selection in the current rule. NOTE: This field 
helps reject bad vendors. If the field is empty, the System checks for 

negative margin and rejects vendors that offer rates higher than client 

rates  

Click the  button to open the drop-down list of condition parameters. 



 
 

  

 

 
Fig. 188 Condition parameters 

The following System metrics are available as condition parameters (can be 
selected from the list or typed in manually): 

• CLAccBal: client account balance in the System currency 
• CLRate: client rate value in the System currency 

• CLPoiASR: client POI ASR 

• CLPoiDLR: client POI DLR 
• CLPoiADD: client POI average delivery delay in minutes 

• VAccBal: vendor account balance 
• VRate: vendor rate value in System currency 

• VPoiASR: vendor POI ASR 
• VPoiDLR: vendor POI DLR  

• CLPoiADD: vendor POI average delivery delay in minutes 
• aniTon: ANI type of number  

• aniNpi: ANI numbering plan indicator  
• dnisTon: DNIS type of number  

• dnisNpi: DNIS numbering plan indicator 
• CurTime: current time in seconds starting from 01.01.1970 (UNIX time) 

• RND: random value from 0 and 1  
• MRG: margin in the System currency 

• CER: client effective rate  

• VER: vendor effective rate 



 
 

  

 

Additionally, routing features can be used as conditions. Routing features and the 

examples of their use are detailed in SMS\Routing\Routing features.  

Click the  button to check if the logical expression is correct. 

 
Fig. 189 Add product (static options) 

• Static options (available for each vendor product added by the  

button): 
- Carrier: select the vendor name from the drop-down list 

- Product: select the vendor product name from the drop-down list 
- Share: share of traffic to the given vendor product out of the total scope 

of traffic affected by the rule (in case there are two or more products – or 
products and formulas – within one choice). Allows balancing the load 

between several vendors. Click the  button to exclude the 
product from the vendor selection 



 
 

  

 

 
Fig. 190 Add formula (dynamic options) 

• Dynamic options (available for each formula added by the  button): 

- Vendor products: optional list of vendor products to apply the routing 
formula to (no other vendor products will be considered in this case). 

Empty by default, which means that all vendors with valid rates for the 
E212 the SMS is going to will take part in the routing process. Click the 

 button to open the menu that allows adding/excluding vendor 
products 

 
Fig. 191 Edit incl/excl list 



 
 

  

 

Vendor products can be filtered by carrier or product name in the left part of the 

menu. Double-click on the product to add it to the list. Click the  button to 
remove the product from the list. When through with creating the list, click 

 to confirm the settings. The list of selected products will appear in 

the Vendor products field 

• Formula: routing formula - a Python expression that may contain any of the 
supported System parameters (e.g. margin, ASR etc.), arbitrary numeric 

factors and mathematical, logical or conditional operators supported in 
Python. For every vendor product involved in routing, the formula resolves 

as a number used as the weight of the respective vendor product. Click the 

 button to check if the Python expression is correct. The formula 

parameters are identical to those in the Condition field detailed above (see 

Fig. 188) 

• Templates: drop-down list of pre-set formula templates. Use  and  

buttons to manage the templates 

• Test share,%: share of traffic passing through the rule that needs to be 
divided between all vendors present in the Vendor products list (if any) in 

order to keep their stats up-to-date 
• Share,%: share of traffic routed by the formula out of the total scope of 

traffic affected by the rule 
• Max routes: maximum number of routes to be returned by the routing 

choice with the formula. This parameter limits the number of vendor POIs  

• Next: this parameter defines whether the routing should be stopped after 
the current rule (Huntstop), continued in the current context (Continue 

search within same context) or switched over to another context (Switch to 
context). See SMS\Routing\Use of contexts for more detail. 

• Probability, %: the share of SMS messages processed by the test rule 
(applicable only for rules with the value Test in the Rule type parameter) 

• Rule comments: arbitrary notes 

When through with defining the parameters, click  to save the routing rule 

or  to discard the settings. Click  to create a similar routing rule and 

 to remove the rule (available in the Edit menu). 

9.5.5 Use of contexts 

A context is a user-defined group of routing rules. Each rule is assigned to a 
context. There may be as many contexts in the System as the user needs. The 
only context that must be there at all times is DEFAULT – that is where routing of 

every SMS always starts.  

Switching the route search to another context is possible by setting the Next 
parameter in one of the rules in the current context to the Switch to context 

value supplemented with the name of the target context (it is not necessary to 
set up any routing choices in such rules). If that rule is triggered, the System will 

switch to the selected context for further routing. There are no other ways to 
make the System change the current context – if it has checked all rules in the 

current context and has not come across any context-switching rules, the routing 
procedure will end. 



 
 

  

 

There are two typical ways to use contexts in routing: 

• Contexts are created for different types of clients, based on client product 
types (e.g. Premium or Wholesale). To switch the routing to the right 

context for all clients with a particular product type(s), respective context-
switching rules must be created in the DEFAULT context   

• Contexts are created for individual clients when it is necessary to stipulate 

one or several per-customer exceptions in the routing setup. In this setup 
each individual context needs to contain a context-changing rule with the 

lowest priority so that this rule will be the last to be considered. The 
System will be switching the routing to a context common for all customers 

– therefore that new context must contain rules effective for all clients 

To create a context, open the Add menu of the Routing rules page. Unfold the 
Context drop-down list. In the edit field at the bottom of the list type the context 

name and click . Fill other parameters of the rule as appropriate and click 

 to save the changes.  

 
Fig. 192 Adding a new context 

To remove a context, delete all rules in this context.  

9.5.6 Routing configuration algorithm  

Suppose you need to configure routing for two types of SLAs – wholesale and 

premium. Create client products of two types: Premium and Wholesale. Products 
are created in the Carriers\Products page.  

Two routing setup procedures are possible: 

Procedure 1 (recommended). 
1. Create two contexts: wholesale and premium (refer to SMS\Routing\Use of 

contexts for instructions) 
2. Create rules for wholesale clients, with the value wholesale in the Context 

field. Create rules for premium clients, with the value premium in the 
Context field. NOTE: Leave the Client product types field blank as the 

product types are already defined by the context  
3. Create two “context-switching rules” so that the System can switch to the 

premium context for premium routes and wholesale context for wholesale 
routes. For these “context-switching rules” configure the following 

parameters: 
- in the Context field select DEFAULT 

- in the Priority field enter a high value, for example, 95  
- in the Client product types field select appropriate values (for example, 

those relating to retail/Gold etc. SLA for the premium routes and relating 

to LCR, standard etc. SLA for wholesale routes) 
- in the Vendor product types field select appropriate values 



 
 

  

 

- in the Client product types and MCC MNC fields select All  

- leave the Choice list must be left blank 
- in the Next field select Switch to context  

- in the Next context field select wholesale for wholesale routes and 
premium for premium routes.  

An example of a context-switching rule is illustrated in the figure below. 
 

 
Fig. 193 “Context-switching rule” settings 



 
 

  

 

Procedure 2. 

1. Create the routing rules as necessary. In the Context field of all the rules 
select DEFAULT. 

2. In the Client product types list select Premium for premium clients and 
Wholesale for wholesale clients. 

NOTE: In this case the System will have to process all rules of the DEFAULT 
context which adds extra load on the System. Besides, administration of the 

numerous rules may be difficult. It is therefore recommended to use 
Procedure 1 in routing rule creation.    

9.5.7 Routing setup example  

Suppose Client A has 3 products: CLI, Non-CLI, Premium. The following routing 

setup is required: 
 

• Premium traffic to Spain from Client A needs to be routed to special 
vendors (not like all other Premium clients), as well as its CLI traffic to TIM 

Brazil. 

• No traffic to MTS Russia for client A is allowed.  
• No traffic to O2 UK is allowed from Client A - Premium.  

• For other countries general routing for all clients of the same type 
(Premium, CLI, Non-CLI) needs to work for that client. 

 
Context DEFAULT 

 
Rule 1 

Name = Switch to CLI 
Rule type = Regular routing 

Priority = 90 
Client product types = CLI (the rule will only work for clients with products 

named CLI, irrespective of the client name) 
Client products = All 

MCCMNCs = All 

Choices = No 
Next = Switch to context, Next context = CLI (switching the route search to the 

context CLI) 
 

Rule 2 
Name = Switch to Non-CLI 

Rule type = Regular routing 
Priority = 90 

Client product types = Non-CLI 
Client products = All 

MCCMNCs = All 
Choices = No 

Next = Switch to context, Next context = Non-CLI 
 

Rule 3 

Name = Switch to Premium 



 
 

  

 

Rule type = Regular routing 

Priority = 90 
Client product types = Premium 

Client products = All 
MCCMNCs = All 

Choices = No 
Next = Switch to context, Next context = Premium 

 
Rule 4 

Name = Block MTS Russia - Client A 
Rule type = Block 

Priority = 20 (basic priority of Block rules is always higher than that of Regular 
routing rules, so the Priority field doesn't have any real impact in this case) 

Client product types = All 
Client products = Client A Premium, Client A CLI, Client A Non-CLI 

MCCMNCs = 250001 

Vendor products = All 
 

Context PREMIUM 
 

Rule 4 
Name = Spain - Client A 

Rule type = Regular routing 
Priority = 90 

Client product types = All (you don't need to set Premium here, as this has 
already been checked in the DEFAULT context and no other client products except 

Premium are allowed in this context anyway) 
Client products = Client A Premium 

MCCMNCs = 214% (please note the '%' sign after the MCCMNC - it makes the 
rule valid for any network within the given MCC) 

Choices = Vendor 1, Vendor 2, Vendor 3 

Next = Huntstop (this is to stop routing for Client A on this rule, so that vendors 
for Spain from Rule 5 won't be added to the routing results - it is up to you 

whether or not this needs to be done in each particular case) 
 

Rule 5 
Name = Spain - General 

Rule type = Regular routing 
Priority = 80 (this rule has a lower priority than Rule 4, therefore for Client A 

Rule 4 will be triggered first) 
Client product types = All 

Client products = All 
MCCMNCs = 214% 

Choices = Vendor 4, Vendor 5, Vendor 6 
 

Rule 6 

Name = Other countries - General 



 
 

  

 

Rule type = Regular routing 

Priority = 80 
Client product types = All 

Client products = All 
MCCMNCs = All 

Choice = MRG, Max routes = 3 (with this formula traffic will be routed by margin, 
and 3 most profitable vendors will be selected as routing options) 

 
Rule 7 

Name = Block O2 UK - Client A Premium 
Rule type = Block 

Priority = 20  
Client product types = All 

Client products = Client A Premium 
MCCMNCs = 234010, 234011 

Vendor products = All 

 
 

Context CLI 
 

Rule 7 
Name = Special Route to TIM Brazil for Client A 

Rule type = Regular routing 
Priority = 90 

Client product types = All 
Client products = Client A CLI 

MCCMNCs = 724002, 724003, 724004, 724008 
Choices = Vendor 10, Vendor 11, Vendor 12 

 
Rule 8 

Name = General Routing to TIM Brazil 

Rule type = Regular routing 
Priority = 80 

Client product types = All 
Client products = All 

MCCMNCs = 724002, 724003, 724004, 724008 
Choices = Vendor 13, Vendor 14, Vendor 15 

 
Rule 9 

Name = General Routing to other countries 
Rule type = Regular routing 

Priority = 80 
Client product types = All 

Client products = All 
MCCMNCs = All 

Choice = MRG, Vendor product list = Vendor 16, Vendor 17, Vendor 18 (the LCR 

formula will only be applied to the short list of selected vendors) 



 
 

  

 

 

Context NON-CLI 
 

Rule 10 
Name = General Routing to Spain 

Rule type = Regular routing 
Priority = 80 

Client product types = All 
Client products = All 

MCCMNCs = 214% 
Choices = Vendor 19, Vendor 20, Vendor 21 

 
Rule 11 

Name = General Routing to Brazil 
Rule type = Regular routing 

Priority = 80 

Client product types = All 
Client products = All 

MCCMNCs = 724% 
Choices = Vendor 22, Vendor 23, Vendor 24 

9.5.8 Simulation 

The Simulation page consists of two tab sheets – Simulation and Send SMS. 

The Simulation page allows testing of the SMS routing logic by emulating a 
routing request from the switch. The Send SMS page serves to test if actual 

messages are received by the vendor.  
The Simulation page is divided in three panels. The upper left panel contains the 

Simulation menu shown below.  

 
Fig. 194 Simulation menu 

The menu allows configuring the following parameters: 

• Product: select the client product from the drop-down list 
• SMS POI: select the POI from the drop-down list 



 
 

  

 

• Sender ID: this parameter is used to test routing by A-number (configured 

in SMS\Routing\Routing rules by the Caller ID and ANI pattern parameters. 
Specify a caller ID tag value or an ANI pattern  

• Dest. number: target number  
• Time: set date and time in the calendar or select the Current time checkbox 

• Message: text of the SMS 
When through with defining the parameters, click  to start SMS 

simulation.  
Results are displayed in the table to the right from the menu. 

  
Fig. 195 Simulation table 

The table displays the following parameters: 
• Job created: date and time of the task creation 

• Product: name of the product selected in the Simulation menu 
• SMS channel: name of the SMS channel  

• IP: IP address of the SMS channel used for simulation 
• Service type: service type of the POI channel used for simulation 

• GUID: identifier of the POI channel used for simulation 

• Sender ID: A-number selected in the Simulation menu 
• Destination number: B-number selected in the Simulation menu 

• Time: date and time of the SMS selected in the Simulation menu 
• Details: contains a link to the simulation log 

(SMS\Routing\Simulation\Simulation log). The link to each simulation log 
can be shared and opened from the outside. The log gives the output 

describing different steps of the routing procedure 

• User: the name of the user that created the simulation task 

Click on a record in the table to view the simulation results displayed at the 
bottom of the page. The results are displayed in a table of vendor routes, listed 

as they were used for routing. If the route is dynamic, it is displayed in black. If 
it is static, it is greyed out. The upper (zero) row shows the details of the client 

route on behalf of which the simulation is performed. 



 
 

  

 

 
Fig. 196 Simulation details 

The table displays the following parameters: 

• Context: context of the routing rule. Several vendors can be selected for 
routing according to different rules 

• Weight: weight calculated for the selection (for dynamic routes only) 
• Carrier: in the upper row - name of the client used for simulation, in all the 

other rows – names of the selected vendors 
• Product: in the upper row - client product type used for simulation, in all 

the other rows – types of the selected vendor products 
• GUID: identifier of the selected vendor‟s POI 

• Service type: service type of the selected vendor‟s POI 
• Vend. caller ID: vendor's caller ID 

• Dest number: target number used for simulation 
• e212: MCCMNC of the rate selected for a vendor in routing 

• ASR: answer seizure ratio of the product and MCCMNC 
• DLR: delivery rate  

• Count: number of sent messages 

• Rate: in the upper row - rate from the client‟s side, in the remaining rows – 
termination rates from vendors  

• Margin: margin for the route 
• Rule ID: link to the used routing rule (click to open the rule for editing) 

• DLR: delivery rate of the simulation  
9.5.8.1 Simulation log 

The simulation log is used for troubleshooting purposes. It comes instrumental if 
something goes wrong during the simulation process – for example, unexpected 

routes or no routes at all are found. To view the log for a particular simulation 
task, click on the view log link of the appropriate record in the tasks table 

(Details column).  

 
Fig. 197 View log link 

The log contains the following sections:  
• initial data: simulation input parameters 



 
 

  

 

• looking for client: client identification 

• looking for client rates 
• looking for vendor rates 

• looking for routing rules 

 
Fig. 198 Simulation log 

Each of the log sections is explained in the figures below.  

 
Fig. 199 Initial data  

 



 
 

  

 

 
Fig. 200 Looking for client 

NOTE: the channel name, POI, product, account and carrier can be looked up by 
their respective IDs in the Carriers section.  

 
Fig. 201 Looking for client rates 



 
 

  

 

 
Fig. 202 Looking for vendor rates 

 
Fig. 203 Vendor rate search results 



 
 

  

 

 
Fig. 204 Checking for blocked rates; vendor rates list 

 
Fig. 205 Searching POI list 

 
Fig. 206 List of vendor SMSC  



 
 

  

 

 
Fig. 207 Looking for routing rules 

NOTE: The rules with the BLOCK type are processed first, irrespective of their 
priority; this is why after the context was switched to WHOLESALE in the figure 

above, the rule <Hen blocking> with the priority 90 was handled earlier than the 
rules with higher priorities such as <ABISON TEST> or <Test> (both having 

priority 99). 

 
Fig. 208 One of selected routing rules 

 



 
 

  

 

 
Fig. 209 Sumary of added routing rules 

 
Fig. 210 Final routing table 

9.5.8.2 Send SMS 

The Send SMS page allows configuring and sending test messages on behalf of a 
client. Clients whose settings are used are not charged for test messages, but the 

System applies the routing logic the way it would do for an SMS received from 

that customer. NOTE: The test messages will be originated from and paid for by 
the System owner.  

The menu allows configuration of the following parameters: 
• Product: client‟s product 

• SMS POI: client‟s POI for the test message 
• Sender ID: A-number  

• Dest. number: B-number 
• Message: text of the test message  

• Long message sending: specify how the System should send messages 
exceeding the standard length 



 
 

  

 

 
Fig. 211 Send SMS menu 

When through with defining the parameters, click  to send a message or 
 to discard the settings. 

The results will be displayed in the right hand panel containing the following 
details:  

• Status: true (message delivered) or false (message not delivered) 

• Output: transaction_id if the message is delivered or error description if an 
error occurred 

9.5.9 Routing features 

The SMS/Routing/Routing features page allows assigning preconfigured 

properties to routes. The assigned properties will be used as conditions in setting 
up routing rules. 

The page consists of two panels. The left panel contains the Classifier and 
Features tab sheets; the right panel shows the Add and Edit menus.  

 
Fig. 212 Classifier tab sheet 

The Classifier tab sheet is a table of products and features assigned to them. It 
contains the following columns:  

• ID: the record ID number 
• Product 



 
 

  

 

• MCCMNC 

• Feature code: the feature name, description and possible values as 
configured in the Features tab sheet  

• Value: the feature value  

 
Fig. 213 Add menu 

The Add and Edit menus in the upper right corner of the page allow editing table 

records and creating new ones. To activate the Edit menu, click on the record in 
the table. Enter the required parameters in the corresponding fields. Fields 

marked with an asterisk (*) are required. When through with defining the 

parameters, click  to save the entry or  to discard the settings.  

 
Fig. 214 Features tab sheet 

The Features tab sheet contains a list of available features and the Add and Edit 
menus for creating new entries or editing existing ones.  

The following default features exist in the System: 

• MNP (Mobile number portability support): the route supports mobile 
number portability. This feature allows configuring routing rules so as to 

save money on HLR requests  
• Long MSG (Long Message Support): the route supports messages 

exceeding standard length. The feature can be used to configure routing to 
partners that process long messages correctly     

• LocalTime (Local Timestamp) 
• OrigNotKept (Originator Overwritten): describes routes where the A-

number may be changed during message transfer  



 
 

  

 

• FalseDLR (False Delivery): describes routes where messages may be 

terminated with fake delivery reports 
• DLVNotif (Delivery Notifications To Handset Support) 

• Bin (Binary): the route supports binary (rich-content) SMS 
• MSGLength (Length Support) 

• AvailNet (Available Network) 
• PreRegOrig (Pre-Registration Originator)   

 
Fig. 215 Add menu 

The Add menu contains the following parameters:  
• Feature code: name of the feature  

• Description: description that explains the feature  
• Value pattern: possible values (|-separated)  

To edit a record, select it in the table. NOTE: Default features cannot be edited. 

Click  to save the entry or  to discard the settings. 

9.5.9.1 How to use routing features in routing 

Suppose vendor X sends false DLR reports to MCCMNC 250001 and must 

therefore be excluded from routing. Proceed as follows:  

1. In the SMS/Routing/Routing features page open the Classifier tab sheet of 
and create a new record with the the following parameters:  

- Product: select the appropriate product of vendor X 
- MCCMNC: specify 250001 

- Feature code: select FalseDLR  
- Value: specify Yes 

2. Open the SMS\Routing\Routing rules page and create a new rule. In the 
Condition field of the Add menu specify FakeDLR == Yes. The System will 

therefore reject all vendors that have the FakeDLR value equal to Yes.  

9.5.10 Routing statistics 

The SMS/Routing/Routing statistics page is used for supplying initial quality of 
service (QoS) statistics for new vendors. When a new vendor is added, the 

System knows nothing about its quality of service, and therefore cannot use it for 
quality-based routing. The System owner can enter initial data about the vendor‟s 

quality in the Routing statistics page.  



 
 

  

 

 
Fig. 216 Statistics table 

The page contains two panels. The left panel is the statistics table, the right 

panel contains the Add and Edit menus.  

 
Fig. Add menu 

To add a new record to the table, open the Add menu and complete the following 
fields:  

• Carrier: the partner‟s name 
• Direction 

• Product 
• POI 

• Service type 
• MCCMNC 

• ASR rate: a decimal value between 0 and 1 

• DLR rate: a decimal value between 0 and 1 
• DLR delay: DLR delivery delay in minutes 

Click  to save the entry or  to discard the settings. Once the record 
appears in the table, the new vendor can be used in configuring routing rules. 

NOTE: Once the real-life statistics is collected, the record becomes irrelevant.  



 
 

  

 

9.5.11 Translation rules  

The SMS\Routing\Translation rules page serves to configure regular expressions 
for transforming various parameters of an SMS as it is transferred from one 

carrier to another. The page contains a table of translation rules and the Add and 
Edit menus that allow adding and editing records.  

 

 
Fig. 217 Translation rules table 

 
Fig. 218 Add menu 

The Add menu contains the following fields:  
• Entity: the SMS parameter to be transformed. Possible values include:  

- Sender ID: select this parameter to transform the sender ID from 
numeric to alpha values or vice versa. NOTE: For correct translation, two 

rules must be created: one with the Sender ID selected as the Entity, the 

other with the Sender TON.  
- Destination number: the parameter is used when a partner sends or 

wants traffic in a non-E164 numbering format 
- Sender TON: a numeric value denoting the sender's type of number 

(Unknown (0), International (1), National (2), Network specific (3), 
Subscriber number (4), Alphanumeric (5), Abbreviated (6)). Typically, the 

parameter is used when the Sender ID needs to be transformed from 
numeric to alpha values or vice versa. NOTE: For correct translation, two 

rules must be created: one with the Sender ID selected as the Entity, the 
other with the Sender TON.  

- Sender NPI: a numeric value denoting the Sender's numbering plan ID 
(Unknown (0), ISDN/telephone numbering plan (E163/E164)(1), Data 



 
 

  

 

numbering plan (X.121)(2), Telex numbering plan (F.69)(4), Land mobile 

(E.212)(6), National numbering plan (8), Private numbering plan (9), 
ERMES numbering plan (ETSI DE/PS 3 01-3)(10), Internet (IP)(13), WAP 

client ID (18))  
- Destination TON, Destination NPI: the parameters are similar to Sender 

ID and Sender NPI. They are normally used for translation between a 
national and international number plans  

- Registered delivery: use this parameter to change the value of the 
registered_delivery flag of the submit_sm packet. NOTE: This parameter is 

used when for some reason the client fails to provide DLR reports. Create 
a rule translating the flag value from 0 to 1 to request DLR reports from 

the vendor  
- Flash message: this flag allows transforming regular messages to flash 

sms and vice versa    
• Start date, End date: the period during which the rule is valid 

• Priority: serves to set the priority for several rules with overlapping 

parameters. For example, suppose rule No1 changes registered_delivery for 
all messages from 0 to 1, while rule No2 changes registered_delivery for 

messages in Greece to 0. In this case it is reasonable to set a higher 
priority for Rule No2.  

• Client product, Vendor product 
• MCC 

• MNC 
• ANI pattern: sender ID pattern (regular expressions are supported) 

• DNIS pattern: B-number pattern (regular expressions are supported) 
• Translation: the regexp-based rule 

Below are some examples of regular expressions and translation rules.  
 

ANI pattern: 
[a-zA-Z0-9_]* - alphanumeric  

[0-9]* - numeric 

340[0-9]* - numeric beginning with 340 
 

DNIS pattern: 
[0-9]{10,12} – numeric between 10 and 12 digits 

34[0-9]{10} – prefix 34 + 10 digits 
  

Example of translation (for Sender ID): 
ANI pattern: 

([0-9]{4}).* - any numeric number, the first 4 digits of which are saved into 
group 1 

Translation: 
\g<1>10500 - use group 1 from the source ANI and add 10500 

 
Fields marked with an asterisk (*) are required. When through with defining the 

parameters, click  to confirm or  to discard the settings. Click  
to delete the selected record. 



 
 

  

 

9.6 Test System 

The SMS\Test system page serves to test the quality of SMS delivery. The Test 
system provides an API for the platforms TestMySMS and remote365.  

The Test system page contains three panels:  
 Test destinations: destinations for testing  

 Task settings: testing task parameters 
 Test tasks: test results   

9.6.1 Test destinations 

The Test destinations panel contains the Test platform drop-down list that allows 
selection of the external test platform (TestMySMS or remote365). It also 

displays the Test destinations table with the following columns:  
 Vendor  

 Product  
 POI  

 Country 
 Net:  network name 

 MCCMNC: MCC/MNC code 
 Rate, USD: the minimum and maximum rate 

 Rate actual at: the date on which the rate is actual  

 
Fig. 219 Test destinations 

NOTE: Some destinations may not be supported by the testing platforms; such 
records are greyed out. 

Use text masks or drop-down lists under the column headers to filter the records 
in the table. 

9.6.2 Task settings 

The Task settings panel serves to create a new test task. It has the following 

parameters:  
 Test platform: the system selected in the Test destinations panel 

 Balance: the account balance of the test platform (only available for 

TestMySMS) 

http://telintel.com/en/test-sms/
https://remote365.net/


 
 

  

 

 Start date: the start date and time for the test 

 Sender: the sender ID 
 Message template: the message template (configurable in the test 

platform)  
 Message text: text of the test message (for the TestMySms service it is 

configured in the service interface) 

 
Fig. 220 Task settings 

9.6.3 Test tasks 

The Test tasks panel is a table of submitted test tasks. It contains the following 

columns:  
 Task ID 

 Test platform (values are TestMySMS and remote365)  
 Status: the task status. Possible values include:    

o scheduled – task with a future date and time 
o in progress – task in progress 

o postponed – indicates a pause between message send attempts 
o completed – the task is completed (the message was sent; it may be 

delivered correctly or with errors, or not delivered, which is shown in 
the Delivery status and Status details columns)  

o failed – the task was not completed successfully  
o canceled – the task was canceled by the user 

 Scheduled to: the task date  
 Vendor 
 Product 
 POI 
 Country 
 Net 
 Result: task result. Valid values include:  

o OK – the task is completed successfully 
o FAIL – the task failed 



 
 

  

 

 Test ref ID: the task ID  

 Send date: the message send date 
 Delivery status: SMS delivery status. Valid values include:  

o OK – the message is delivered 
o FAIL – the message is not delivered 

 Delay: message delay 
 Sent text:  the text sent by the Test system 

 Received text: the text received by the recipient 
 Text diff: the difference between the sent and received text 

 Sent sender: the sender ID sent by the Test system 
 Received sender: the sender ID received by the recipient 

 Template name: the template selected in the Task settings panel 
 Target number: the destination number 

 Status details: the information on the task status. Possible values include: 
o unexpected status failed – a conflict between the test statuses 

received from the vendor and the test platform (the vendor sent the 

delivered status, whereas the platform sent the failed status) 
o task completed, test successful – the message was delivered with no 

modifications in the sender's ID or message text 
o task completed, test unsuccessful – the message was delivered with 

some modifications in the sender's ID or message text 
o allowed number of attempts exceeded – the message was not 

delivered as the allowed number of attempts was exceeded (the 
number of attempts is configured in Administration\System 

Settings\SMS Test (the parameter SMS test max attempts count) 
o canceled by user – the message was not delivered as the task was 

canceled by the user   

9.6.4 Using TestMySMS to test SMS delivery 

In order to test SMS delivery using the TestMySMS service, proceed as follows: 
1. Add a new carrier (see Carriers for more detail)  

a. In the Carriers page, check Inbound traffic allowed 

b. Configure pages Users, Accounts, Agreements, Products, Voice POI as 
appropriate 

c. In the SMS channels page, specify the following: 
 Carrier:  provide a carrier's name  

 Partner direction: select Client 
 Channel bind type: select Auto 

 Channel name: provide an arbitrary name 
 Host name: supply the IP address 209.208.212.224 

 Login and Password: make up values that will be used by the 
TestMySMS service to access the Alaris SMS Platform.  

 Leave the remaining fields blank or fill them with arbitrary 
values and click Submit  



 
 

  

 

 
Fig. 221 Add SMS channel menu 

2. Create an SMS POI for the channel. Go to the SMS POI page, select the 

carrier, product, active dates and SMS channel. Leave the Service type field 
blank  

 
Fig. 222 Adding the SMS POI 

3. Register an account with the TestMySMS service, create a new vendor and 

configure the channel connection parameters (use the SMS channel values 
configured above)   

4. Go to Administration\System settings\SMS Test and configure the following 

parameters.  
a. TestMySMS URL:  provide the platform URL  

b. TestMySMS password and TestMySMS user name: supply login and 
password used to access the TestMySMS platform 

c. TestMySMS vendor: enter the name of the vendor as specified in the 
TestMySMS platform 

5. Go to the Test system page (SMS\Test system) and create a new test task.   
a. In the Test destinations section: 

 Select TestMySMS 
 Select the appropriate destination 

b. In the Task settings section, configure the following:  
 Start date – specify the start date and time for the test 



 
 

  

 

 Sender – supply the sender's phone number 

 Message template - select the message template created in the 
TestMySMS platform  

 
Fig. 223 Task settings 

c. Click Add. The task will appear in the Test tasks panel  

 
Fig. 224 Test results 

9.6.5 Using remote365 to test SMS delivery 

To test SMS delivery using the remote365 platform, proceed as follows:  

1. Create an account at the remote365 platform  
2. Add a new carrier as detailed in Carriers. Configure appropriate parameters 

except for those on the SMS channel page (see SMS\Test system\Using 

TestMySMS to test SMS delivery for parameter values)  



 
 

  

 

3. Go to Administration\System settings\SMS Test and configure the following 

parameters (supplied by the Remote365 service).  
a. Remote365 SMS send URL 

b. Remote365 control URL 
c. Remote365 password 

d. Remote365 user name 
4. Contact the Alaris technical support team to install a specialized add-on 

module and complete service configuration  

10. Partner portal 

10.1 Overview 

Partner portal is the System's web interface intended for partner carriers of the 

System owner. Based on their rights, partner carriers can view their statistics and 
create and edit SMS POIs. 

The user accounts and access rights for the Partner portal are configured by the 
System owner in Carriers\Users. User rights are configured in the Roles section of 

the Add menu (Roles >> Partner portal).  

 
Fig. 225 Roles (Add menu, Carriers\Users) 

Once the user account is created, the user will receive a link to the partner portal 

and password.   



 
 

  

 

 
Fig. 226 Portal front page 

The portal front page contains the following sections and controls:  

• Menu: shows the following items (displayed depending on the user 
permissions): Info, User profile, Invoices, Payments, SMS Stats, SMS 

Rates, SMS POIs and EDRs 
• User profile: contains two tab sheets: Contacts and Company details.  

- The Contacts tab sheet shows information about the carrier's users: 

Position, First name, Last name, Phone, Email address for sending 
notifications and Notifications checkboxes (Send rate changes, Send 

invoices, Send alarms) 
- The Company details tab sheet shows the company's name, region and 

address 



 
 

  

 

 
Fig. 227 Account details and Balance sections 

• Account details section at the top right corner of the page shows the 
account summary.  

• Balance section: displays the account balance in the carrier's and System 
currencies. Point the cursor to the amount to view the billing period and 

latest balance update date. Click  to update the balance. Click  to top 

up the balance. Enter the amount in the edit box and click  to use Paypal 

or  to use Authorize.net. NOTE: Prior to using this function, an account 

must be registered at Paypal and authorize.net respectively and configured 

in Administration\System settings\Partner portal  

• The top right corner of the page contains the  button and the 

session expiry timer . A minute before the session expires, the user is 

offered to renew the session or log out. The default session time is 10 
minutes. Click on the timer to renew the session at any time  

Pages containing tables have the  button that serves to update the 

page, and the  button that serves to import the table to an xls file.  

10.2 Invoices 

The Invoices page contains a list of the carrier's invoices.  



 
 

  

 

 
Fig. 228 Invoices 

Click on the value in the Reference code column to open the invoice cover sheet 

(in pdf format). Click on the xls link in the Amount column to view the traffic 
details file (in xls format).  

10.3 Payments 

The Payments page contains a list of the carrier's payments.  

 
Fig. 229 Payments 

10.4 SMS Stats 

The SMS Stats page contains the carrier's statistics of SMS transfer. 

  

 
Fig. 230 SMS usage statistics  



 
 

  

 

To view the statistics, select the product in the drop-down list and specify the 

period in the edit fields. Click  for a chart view.  

 
Fig. 231 SMS usage statistics chart view 

10.5 SMS rates 

The SMS rates page contains a table of the carrier's active rates. To view the 
statistics, select the product in the drop-down list and specify the date in the 

Active at field. 



 
 

  

 

 
Fig. 232 Current SMS rates 

10.6 SMS POIs 

The SMS POIs page contains two tab sheets: List of SMS POIs and Add new SMS 
POI (displayed if the user has the rights to create/edit SMS POIs; the rights are 

configured in Carriers/Users, Add menu, Roles >> SMS >> SMS POI edit) 

 
Fig. 233 SMS POIs 

To add a new SMS POI, open the Add new SMS POI, select the product and enter 

the IP address.  



 
 

  

 

 
Fig. 234 Add new SMS POI 

10.7 EDRs 

The EDRs page serves to download EDRs for a specified period.  

 
Fig. 235 Download EDRs 

Select the product, specify the dates and click . Once the file is 
downloaded, the download link will be sent to the user's email address (as 

configured in Carriers/Users).  



 
 

  

 

 

11. Appendix 1. HTTP API  

11.1 Overview 

This section provides the HTTP API description for integration of external systems 

with Alaris SMS platform. 
HTTP API enables SMS submission and SMS delivery status requests. 

Authentication information (login/password) for connecting to Alaris SMS 

platform must be requested from the owner of Alaris SMS platform for each new 
interconnection. Credentials must be sent with each API request otherwise the 

user will be rejected as non-authorized. 
Requests can be sent either with the GET or POST method to URL provided by 

the System owner in the format: http(s)://<IP_address>:<port>/api? (e.g. 
https://1.1.1.1:8443/api? or http://1.1.1.1:443/api?) 

11.2 SMS submission. 

Request format: 
 

https://1.1.1.1:8443/api?username=<username>&password=<password>&ani=
<ani>&dnis=<dnis>&message=<message>&command=submit&serviceType=<s

erviceType>&longMessageMode=<longMessageMode> 
 

http://1.1.1.1:443/api?username=<username>&password=<password>&ani=<
ani>&dnis=<dnis>&message=<message>&command=submit&serviceType=<se

rviceType>&longMessageMode=<longMessageMode> 
 

Parameters: 

 
username: Login 
password: Password 

ani : Caller ID. Technical limitation - alpha-numeric up to 32 
symbols. Additional limitations can be caused by 

destination route peculiarities.  
dnis: Destination number. Must be sent in international E.164 

format (up to 15 digits allowed). 
message: Message text. 

command: Request type. Must be set to “submit” value. 

serviceType: Service type, provided by the system owner for the 
registered interconnection. Can be blank. 

https://1.1.1.1:8443/api?username=%3cusername%3e&password=%3cpassword%3e&ani=%3cani%3e&dnis=%3cdnis%3e&message=%3cmessage%3e&command=submit&serviceType=%3cserviceType%3e&longMessageMode=%3clongMessageMode
https://1.1.1.1:8443/api?username=%3cusername%3e&password=%3cpassword%3e&ani=%3cani%3e&dnis=%3cdnis%3e&message=%3cmessage%3e&command=submit&serviceType=%3cserviceType%3e&longMessageMode=%3clongMessageMode
https://1.1.1.1:8443/api?username=%3cusername%3e&password=%3cpassword%3e&ani=%3cani%3e&dnis=%3cdnis%3e&message=%3cmessage%3e&command=submit&serviceType=%3cserviceType%3e&longMessageMode=%3clongMessageMode
http://1.1.1.1:443/api?username=%3cusername%3e&password=%3cpassword%3e&ani=%3cani%3e&dnis=%3cdnis%3e&message=%3cmessage%3e&command=submit&serviceType=%3cserviceType%3e&longMessageMode=%3clongMessageMode
http://1.1.1.1:443/api?username=%3cusername%3e&password=%3cpassword%3e&ani=%3cani%3e&dnis=%3cdnis%3e&message=%3cmessage%3e&command=submit&serviceType=%3cserviceType%3e&longMessageMode=%3clongMessageMode
http://1.1.1.1:443/api?username=%3cusername%3e&password=%3cpassword%3e&ani=%3cani%3e&dnis=%3cdnis%3e&message=%3cmessage%3e&command=submit&serviceType=%3cserviceType%3e&longMessageMode=%3clongMessageMode


 
 

  

 

longMessageMode: Type of long message processing. The following values 

allowed: 
1 Cut (trim message text to 140 bytes) - shortens the 

message leaving only first 140 bytes to be sent. 
2 Split and 3 Split SAR - split the message according to 

the logics described below. The difference between them 
is in the header to be used, for Split it is UDH header, for 

Split SAR it is SAR accordingly. 
4 Payload - message_payload field is used for sending the 

message text 
 

The splitting (options 2/3) depends on the coding: 
 

- dataCoding = 0: one message can contain up to 160 
symbols, if more – segment count = message length / 

152 

- dataCoding from 1 to 7: one message can contain up to 
140 symbols, if more – segment count = message length 

/ 134 
- dataCoding = 8: one message can contain up to 70 

symbols (140 bytes), if more – segment count = message 
length / 67 (134 bytes) 

 
All parameters except of longMessageMode are obligatory, the default value for 

longMessageMode is 1 (Cut). 
 

Response format 
In case of successful processing, the status in the header of the HTTP response is 

200 OK. Response body contains the message_id. 
Sample of a response in JSON format: 

 

HTTP/1.1 200 OK 
Content-Type: text/html; charset=UTF-8 
 
{"message_id":"alss-a1b2c3d4-e5f67890"} 

In case of rejected sms (no compatible routes found or authentication data is 

incorrect), the HTTP response status is - 400  Bad Request. The response body 
contains a string describing the reason for rejection, for example NO ROUTES or 

Unknown username. 
 

HTTP/1.1 400  Bad Request 
Content-Type: text/html; charset=UTF-8 
 
Unknown username 

 



 
 

  

 

In case an incorrect password is provided, the HTTP status is 401 Unauthorized. 

The response body contains the string describing the reason for rejection. 

HTTP/1.1 401 Unauthorized 
Content-Type: text/html; charset=UTF-8 
 
Incorrect password 

 


